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Form No. 008-42104-00

WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for war-
ranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspec-
tion of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such prod-
ucts. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials.
Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our
entire liability in respect to such products, except as an authorized person of MICROMERITICS may other-
wise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects.
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manu-
factures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.

4356 Communications Drive         Norcross, GA 30093-2901   Fax (770) 662-3696

Domestic Sales - (770) 662-3636                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
Rev. 12/95



 



Saturn DigiSizer II 5205 Confirm Table of Contents 
TABLE OF CONTENTS

1. GENERAL INFORMATION

Organization of the Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
Safety Awareness . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4

Equipment Description. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5
Saturn DigiSizer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5
Liquid Sample Handler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
MasterTech 052 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7
Windows Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-8

Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-9

2. USER INTERFACE

Controls, Indicators, and Connectors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
Saturn DigiSizer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1

Front Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
Side Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Rear Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2

Liquid Sample Handler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4
Front Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4
Side Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4
Rear Panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5

MasterTech 052 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6
Front Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6
Rear Panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8

Turning On and Off the System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
Turning On the System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
Turning Off the System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
Preparing the System for Idle Periods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-10

Using the Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-11
Logging In  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-11
Shortcut Menus  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-11
Shortcut Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12
Dialog Boxes and Subdialog Boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-13
Selecting Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-15
Selecting Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-17

Menu Structure. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-18
Main Menu Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-18

Windows Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-19
Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-19
Online Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-20

Using Bookmarks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-20
Using the Table of Contents, Index, and other Links. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-22
 520-42812-01 (Rev G) - Nov 2018                                          i 



Table of Contents Saturn DigiSizer II 5205 Confirm
Table of Contents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-22
Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-23
Cross References. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-23

Using the Find Command . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-24
Printing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-25

3. OPERATIONAL PROCEDURES

Creating File Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1
Creating Parameter Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4

Analysis Conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
Material Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
Report Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9

Creating a Sample File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11
Analyst  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11
Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13

Performing a Rinse Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
DigiSizer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
MasterTech . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-16
MasterTech then DigiSizer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-17

Performing a Background Measurement  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-18
Changing Analysis Liquids. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-20
Preparing a Sample For Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22
Performing an Analysis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22

Sample Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22
QuickStart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-25
MasterTech Automatic . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-27
MasterTech Schedule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-29

Printing File Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-31
Sample Files and Sample Templates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-31
Parameter Files and Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-33

Listing File Statistics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-34
Sample Files and Sample Templates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-34
Parameter Files and Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-36

Importing Sample and Parameter Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-37
Exporting a Sample Information File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-38
Generating Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-39

Tabular/Graphical Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-39
Background Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-41
Statistical Process Control Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-42

Specifying SPC Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-42
Generating a Regression Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-44
Generating a Control Chart Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-45

Generating a PSD History Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-47
Generating Overlays . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-48

Multiple-Graph Overlay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-48
Multiple-Sample Overlay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-49
Multiple-Test Overlay. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-51
ii                                                                                                                                                                     520-42812-01 (Rev G) - Nov 2018



Saturn DigiSizer II 5205 Confirm Table of Contents 
4. FILE MENU

Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-1
New  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3

Sample Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4
Analyst . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4
Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-8

Analysis Conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-11
Material Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-16
Report Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-21

Combined Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-26
Tabular Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-27
Graphical Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-29
Background Graph . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-31
Goodness of Fit Graph . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-32
Rosin Rammler. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-32
Log Probability Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-33
Summary Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-33
Sample Log Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-35

Entered Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-36
Open . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-38

Sample Information File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-38
Analyst . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-39
Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-40

Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-41
Parameter Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-42

Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-43
Save As. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-43
Save As Template  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-45
Save All . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-45
Close. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-45
Close All. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-46
Print  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-47

Sample Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-47
Sample Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-48
Parameter Files and Parameter Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-49

List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-50
Import. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-51
Export. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-52
Log In . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-53
Log Out  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-53
Exit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-54

5. UNIT MENU

Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-1
Sample Analysis. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-4
QuickStart  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-10
MasterTech Automatic. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-15
MasterTech Schedule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-18
 520-42812-01 (Rev G) - Nov 2018                                          iii 



Table of Contents Saturn DigiSizer II 5205 Confirm
Background. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-22
Load from MasterTech . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-25
Rinse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-26

DigiSizer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-26
MasterTech . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-28
MasterTech Then DigiSizer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-29

Drain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-31
Initialize MasterTech  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-31
Enable Manual Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-32
Show Instrument Schematic . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-40
Show Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-41
Show Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-41
Show Instrument Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-42
Unit Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-44
Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-46
Service Test  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-46

6. REPORTS MENU

Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-1
Start Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-2
Close Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-4
Open Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-4
Background. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-5
SPC Report Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-6
Regression Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-9
Control Chart  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-13
PSD History  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-17
Printed Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-19

Header . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-19
Onscreen Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-20

Tool Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-20
Shortcut Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-23
Zoom Feature  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-27
Axis Cross Hair. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-28

Report Examples. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-28
Combined Report  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-29
Particle Size Table  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-30
Volume Percent Table  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-31
Cumulative Volume Percent vs. Particle Diameter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-32
Incremental Volume Percent vs. Particle Diameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-33
Difference from Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-34
Out of Specification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-35
Background Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-36
Goodness of Fit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-37
Summary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-38
iv                                                                                                                                                                     520-42812-01 (Rev G) - Nov 2018



Saturn DigiSizer II 5205 Confirm Table of Contents 
7. OPTIONS MENU

Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-1
Add Archive Location . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-3
Edit Labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-4
Update File List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-5
Data Presentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-6
Service Test Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-7

8. TROUBLESHOOTING AND MAINTENANCE

Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-1
Cleaning the Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-4
Cleaning the Optics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-4

Sample Cell and Detector Lens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-4
Collimator Lens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-7

Cleaning the Sample Reservoir . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-8
Replacing the Tubing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-9

Liquid Sample Handler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-9
Replacing the Air Filter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-10
Replacing Fuses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-11

9. ORDERING INFORMATION

A. ERROR MESSAGES

Numbered Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
2200 Series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
2300 Series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2
2400 Series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-5
2500 Series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-12
4200 Series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-16
6000 Series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-20

Unnumbered Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-35
Liquid Sample Handler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-35
Laser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-35
Rotation Arm . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-36
Charge-Coupled Device (CCD) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-37

B. SAMPLE DISPERSION AND CONCENTRATION

Sample Dispersion  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-1
Sample Concentration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-3

Small Particles and Multiple Scattering  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-4
Medium Size Particles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-4
Large Particles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-4
 520-42812-01 (Rev G) - Nov 2018                                          v 



Table of Contents Saturn DigiSizer II 5205 Confirm
C. CHEMICAL AIDS FOR PARTICLE DISPERSION

D. LIQUID DENSITY AND VISCOSITY DATA

E. SOURCES OF DISPERSING AIDS

F. DATA REDUCTION

Scattering Model Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1
Mie and Fraunhofer Calculations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1
Volume Normalization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1
Polarization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1
Size Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1
Size Subclasses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-2
Angle Subclasses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-2
Scattering Vector  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-2

Deconvolution. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-3
Angle Classes and Size Classes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-3
Regularization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-4
Modifications to NNLS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-4

Maximum Number of Iterations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-4
Check for Repeats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-4
Dual Vector  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-5
Nonnegative Tolerance Parameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-5
Weighted Residual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-5

Input Quantities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-7
Standard Particle Size Classes and Standard Size Parameter Classes  . . . . . . . . . . . . . . . . . F-7
High/Low Diameter and Average Diameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-8
Standard Sieve Sizes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-9
Graph Particle Size Intervals  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-10
Interpolation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-10
Merged Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-10

Fundamental Quantities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-11
Distribution Type (Volume, Area, Length, Number) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-11
Particle Size (Diameter/Radius) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-12
Cumulative Coarser/Finer, Retained/Passed. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-13
Frequency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-14
User-Entered Percentile Size  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-14
User-Entered Size Percent  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-14
Peak Report Quantities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-14

Size Statistics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-16
Standard Deviation of Quantity for N Tests . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-16
Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-16
Median  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-16
Arithmetic Calculations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-17
Geometric Calculations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-18
vi                                                                                                                                                                     520-42812-01 (Rev G) - Nov 2018



Saturn DigiSizer II 5205 Confirm Table of Contents 
Material Formulae . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-19
Relative refractive index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-19
Sample Concentration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-19
Specific Surface Area. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-19

Specification/Reference Quantities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-20
Out of Spec. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-20
Difference from Reference. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-20
Maximum Out of Spec . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-21
Pass/Fail by Specification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-21

SPC Report Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-22
Regression Chart Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-22
Control Chart Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-23

G. FORMAT OF EXPORTED DATA

Particle Size Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . G-1
Intensity Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . G-2

H. BACKGROUND QUALITY

I. MASTERTECH INSTALLATION

Removing Packing Material from the Unit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-1
Equipment Damage or Loss During Shipment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-1
Equipment Return  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-1

Installing the MasterTech. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-2
Selecting the Voltage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-2
Turning on the MasterTech  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-5
Installing the Ultrasonic Probe. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-6
Installing the Beaker Tray  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-7
Installing Sample Transfer Tubing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-8

MasterTech with Serial Number 500 or Below . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-8
MasterTech with Serial Number 501 or Above . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-9

Connecting to Liquid Sample Handler. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-13
Standard Liquid Sample Handler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-13
Low-Volume Liquid Sample Handler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-15

Connecting Cables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-17
Verifying Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I-17

J.  LIQUID SAMPLE HANDLER INSTALLATION

Disconnecting the Current Liquid Sample Handler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . J-1
Installing the Liquid Sample Handler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . J-2

INDEX
 520-42812-01 (Rev G) - Nov 2018                                          vii 





Saturn DigiSizer II 5205 Confirm Organization of the Manual
1.  GENERAL INFORMATION 

This manual provides a description of the Saturn DigiSizer system, as well as the menu 
options and functions available. This manual covers operations for a Developer and an Ana-
lyst. A Developer has authority to perform all functions provided on the main menu bar. An 
Analyst is restricted to certain operations. 

To help you operate the DigiSizer analyzer more efficiently:

• read Chapter 2, User Interface, before operating the analyzer and its software
• use the step-by-step instructions in Chapter 3 when performing common operations

Organization of the Manual

The Saturn DigiSizer operator’s manual is divided as follows:

Chapter 1 General Information

Provides a general description of the Saturn DigiSizer system, its 
features, and specifications. 

Chapter 2 USER INTERFACE

Provides basic instrument and software interface. 

Chapter 3 OPERATIONAL PROCEDURES

Provides step-by-step procedures for the operations performed with the 
Saturn DigiSizer.

Chapter 4 FILE MENU

Provides a description of the commands available from the File menu.

Chapter 5 UNIT MENU

Provides a description of the commands available from the Unit menu.

Chapter 6 REPORTS MENU

Provides a description of the commands available from the Reports 
menu.
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Chapter 7 OPTIONS MENU

Provides a description of the commands available from the Options 
menu.

Chapter 8 TROUBLESHOOTING AND MAINTENANCE

Provides user maintenance and service information.

Chapter 9 ORDERING INFORMATION

Provides ordering information for the Saturn DigiSizer system 
components.

Appendix A ERROR MESSAGES

Lists the error messages displayed by the Saturn DigiSizer analysis 
program; includes a cause and action for each.

Appendix B SAMPLE DISPERSION AND CONCENTRATION

Provides methods for dispersing samples and adjusting sample 
concentration.

Appendix C CHEMICAL AIDS FOR PARTICLE DISPERSION

Provides a list of dispersants and their active ingredients.

Appendix D LIQUID DENSITY AND VISCOSITY DATA

Provides density and viscosity data for common dispersants.

Appendix E SOURCES OF DISPERSING AIDS

Provides a list of suppliers for common dispersants.

Appendix F DATA REDUCTION

Contains the calculations used for producing reports.

Appendix G FORMAT OF EXPORTED DATA

Contains the format and a description of exported data.
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Conventions

This manual uses the icons shown below to identify notes of importance, cautions, and 
warnings.

Appendix H BACKGROUND QUALITY

Provides criteria for obtaining and determining an acceptable 
background.

Appendix I MASTERTECH INSTALLATION

Provides instructions for installing the MasterTech autosampler.

Appendix J LIQUID SAMPLE HANDLER INSTALLATION

Provides instructions for uninstalling and installing a liquid sample 
handler.

Index INDEX

Provides quick access to a subject matter.

Notes contain important information pertinent to the subject matter.

Warnings contain information that help you prevent actions that may cause personal 
injury.

Cautions contain information that help you prevent actions that may damage the 
analyzer.
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Safety Awareness

Safety precautions and warnings are inserted throughout this manual in appropriate sections. It 
is important that you read and observe these precautions and warnings in order to prevent per-
sonal injury and/or damage to the instrument.

The Saturn DigiSizer uses a laser beam in its analysis process. Direct exposure to a laser beam 
can be hazardous. Therefore, for your protection, the Saturn DigiSizer contains an interlock 
safety device which disables laser operation if the analysis compartment is opened during an 
analysis. Do not, under any circumstances, attempt to override this safety interlock. Doing so 
may allow exposure to the laser beam at an intensity of up to 7 mW at 658 nm.

The Saturn DigiSizer is completely safe to operate. There is no danger of exposure to the laser 
beam when the Saturn DigiSizer is operated as directed in the operator’s manual, and all cau-
tions and warnings are observed.

Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous laser light exposure.
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Equipment Description

Saturn DigiSizer

The Saturn DigiSizer System consists of up to two particle size analyzers, each with a liquid 
sample handler, and one multifunction personal computer. You can also install up to two Mas-
terTech 052 Autosamplers allowing automatic analysis of up to 18 samples each.

The Saturn DigiSizer uses a laser in conjunction with a CCD (charge-coupled device) contain-
ing over three million detector elements to measure particle size. These detectors are placed so 
that they can measure the intensity of light scattered by the particles at various angles. Light is 
scattered by particles in a pattern dependent on their size, shape, refractive index, and wave 
length of incident light. Based on the Mie theory, the particle size distribution is calculated 
from the angle distribution of the scattered light intensity collected by the detectors. 

Both organic and inorganic particles can be analyzed and measured over a range of 0.06 to 
2100 micrometers. The Saturn DigiSizer includes a complete system for circulating the dis-
persing liquid/sample mixture through the cell and reservoir, as well as to an external waste 
container.
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Liquid Sample Handler

The Saturn DigiSizer requires the use of a sample handler (shown with the DigiSizer in the 
previous illustration) to transfer the sample to the analyzer for analysis. The sample handler 
also allows for connection of an ultrasonic probe to assist in sample dispersion.

The sample handler enables automatic sample handling. All you have to do is define analysis 
conditions (in the sample file), add the sample to the reservoir (containing the dispersing liq-
uid), and start the analysis. Your sample will be automatically monitored and diluted when 
necessary; and your system rinsed after each analysis (when specified in the sample file).

The Liquid Sample Handler is available in two configurations: 

• Standard unit: includes a reservoir that holds 500 to 600 mL of dispersed sample. This 
model is best suited for samples containing coarse particles, or for those of high density. 

• Low-Volume unit: includes a reservoir that holds 100 to 120 mL of dispersed sample. 
This model is best suited for analyses where the sample quantity or dispersion liquid is 
limited, or where the dispersion liquid may be hazardous or difficult to dispose of. 
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MasterTech 052

The MasterTech 052 is an automatic sampling device that operates in conjunction with the 
Saturn DigiSizer. The MasterTech allows you to queue as many as 18 predispersed samples to 
run consecutively and unattended. It allows samples to be redispersed either by stirring only or 
by stirring and disruption with an ultrasonic probe. 

During operation, the beaker tray is loaded with beakers containing predispersed sample. 
When the Saturn DigiSizer is ready for a sample, the tray rotates until in the correct position 
for transfer. The sample is stirred for a user-specified length of time just before transfer to the 
Saturn DigiSizer for analysis. The ultrasonic probe can be activated to assist in redispersion if 
needed.

After redispersion, the sample is transferred to the reservoir of the analyzer. Then a small 
amount of analysis fluid is back-flushed to the MasterTech to rinse the stirrer, probe, and tub-
ing. After rinsing is complete, the MasterTech prepares itself for the next sample. The next 
sample can be redispersed while analysis of the current sample is in progress. Analysis pro-
ceeds as if you had filled the reservoir manually with predispersed sample. After analysis of 
the current sample is complete, the contents of the reservoir are discarded to the waste con-
tainer and the Saturn DigiSizer is rinsed. The system is now ready to transfer the next sample 
from the MasterTech.
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Windows Interface

The Saturn DigiSizer Confirm program is designed to operate in a Windows environment and 
contains the security features required to assist you in meeting CFR Part 11 compliance. Its 
intuitive user interface makes operation of the DigiSizer easy and the Windows interface 
allows you to run other applications while an automatic operation is in progress.

Also included is a report system which allows you to manipulate and customize reports. You 
can zoom in on portions of the graphs or shift the axes to examine fine details. Scalable graphs 
can be copied to the clipboard and pasted into other applications. Reports can be customized 
with your choice of fonts and a company logo added to the report header for an impressive 
presentation. Refer to Onscreen Reports, page 6-20 for available options.

To make it easier for you to obtain information, an electronic copy of the operator’s  manual is 
included on the Help menu. This enables you to access the desired information in just a couple 
of mouse clicks.
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Specifications

The Saturn DigiSizer Analysis System has been designed and tested to meet the specifications 
provided in Table 1-1. 

Table 1-1. Saturn DigiSizer Specifications

Characteristic Specification

———— SATURN DIGISIZER SYSTEM ——–—

Laser

Type: Solid-state, Diode

Wavelength: 658 nm

Power output: 6 to 9 mW

Beam type: Parallel

Beam width (in sample): 16 mm
Certified under IEC 825 as a Class 1 laser product

Lens Focal length, 200 mm (fixed)

Detector

Number of elements: 3,407,872

Geometry: Rectangular array with 3328 x 1024 pixels used at 14 
different angles to yield the equivalent of over 47 
million elements

Alignment: Automatic

Sample Circuit

Circulation pump rate: 5 to 19 L/min (Standard sample handler);
2 to 12 L/min (Low-volume sample handler)

Circulation system volume: 590 to 690 mL (Standard sample handler);
100 to 120 mL (Low-volume sample handler)

Materials routinely 
contacting sample:

Borosilicate glass; stainless steel; Tygon® (fuel grade) 
tubing; Titanium; Kel-F (CTFE); epoxy; Ertalyte®;  
Viton® F and Kalrez (Low-volume sample handler only)
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Characteristic Specification

Output

Measurement range: 0.04 to 2500 m Equivalent Spherical Diameter 
(Standard sample handler);
0.06 to 750 m (Low-volume sample handler)

Measurement time: Less than five minutes, sample to sample

Size class range: 40 per decade for four decades

Deconvolution Mie theory and Fraunhofer theory models applied.

Performance

Accuracy: 0.1 to 1 m, 10%
1 to 1000 m, 3%

Resolution: 0.1 to 1 m, not applicable
1 to 10 m, can resolve monosized particles 
    separated by 20% in size
10 to 1000 m, 30% in size

Repeatability: 0.1 to 1 m, 3%
1 to 1000 m, 1% (mean diameter for multiple analyses
    on the same instrument)

Reproducibility: 0.1 to 1 m, 5%
1 to 100 m, 2%
100 to 1000 m, 5% (particle size distribution, 
    instrument to instrument)

Electrical

Voltage
Saturn DigiSizer:
Sample Handler:

100/120, 220/240 VAC
85 to 264 VAC

Frequency: 47 to 63 Hz

Power
Saturn DigiSizer:
Sample Handler:

150 VA
100 VA
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Characteristic Specification

Environment

Temperature: Ambient + 10 to 35 ºC, operating;
-10 to 55 ºC, storing or shipping

Humidity: Up to 90% (non-condensing)

Physical

Saturn DigiSizer: Height: 50 cm (19.7 in.)
Width: 47 cm (18.5 in.)
Depth: 65 cm (25.6 in.)
Weight: 45 kg (99 lbs)

Sample Handler: Height: 50 cm (19.7 in.)
Width: 27.5 cm (10.8 in.)
Depth: 65 cm (25.6 in.)
Weight: 26 kg (57 lbs)

———— COMPUTER ——–—

Minimum requirements: Computer capable of running Windows XP
      Professional or Windows 7 operating system
512 megabytes of main memory
20-gigabytes hard drive
CD-ROM drive
Ethernet port* (capable of communicating with a
      10 base-T or 100-TX card)
1024 x 768 monitor display capability

*An additional Ethernet port is required if the
  computer is to be connected to a network.
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Characteristic Specification

———— MASTERTECH ——–—

Sample Capacity: 18 per tray, continuing indefinitely if tray is replenished

Sample Size: 0.001 to 4 g powder in 60 to 80 mL of liquid

Suspending Liquid: Any liquid compatible with wetted materials (typical 
liquids are water, glycols, mineral oils, alcohols, and 
mineral spirits)

Wetted materials: Stainless steel, Viton, Tygon, silicone rubber,  
polypropylene

Voltage: 100/120, 220/240 VAC  ± 10%

Power: 250 VA

Frequency: 50/60 Hz

Temperature: 10 to 40 ºC, operating; -10 to 500 ºC, storing or shipping

Humidity: 20 to 80% relative (non-condensing)

Physical: Height: 71 cm (28 in.)
Width: 46 cm (18 in.)
Depth: 53 cm (21 in.)
Weight: 18 kg (40 lbs)
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2.  USER INTERFACE

The Saturn DigiSizer Confirm software is accessed by three different levels of users:

• Administrator: installs and maintains software and updates, establishes user accounts 
and rights (the Administrator responsibilities are covered in a separate manual)

• Developer: has access to all functions of the software. The Developer’s primary 
function is to create templates for the Analyst.

• Analyst: Creates sample files from predefined templates; some fields, such as Mass and 
Density, are enabled and can be edited. The Analyst is also allowed to perform other 
tasks as designated throughout this manual. Tasks not allowed are disabled.

This manual is written for the Developer and Analyst levels of the Saturn DigiSizer Confirm 
software. Functions for the Administrator level are covered in the Administrator Utility User’s 
Guide.

Controls, Indicators, and Connectors

This section contains a description of the controls, indicators, and connectors located on the 
front and rear panels of the Saturn DigiSizer, the liquid sample handler, and the MasterTech 
052.

Saturn DigiSizer

Front Panel

Retractable Handle

Power LED
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Side Panel

The side panel of the analyzer contains two plumbing ports; an outlet (upper) and inlet (lower). 
These ports allow connection of the sample transfer tubing from the liquid sample handler to 
the sample cell holder.

Rear Panel 

Power LED Illuminates when the analyzer has been turned on and the 
analysis program loaded. This LED will flash on and off 
until the program is completely loaded and ready for 
operation.

Retractable handle When pressed on the right side, the handle extends outward 
so that you can open the front panel.

Air filter Minimizes the buildup of dust within the analyzer.

Air Filter

RS-232 Connector for Liquid 
Sample Handling Unit

Linear Supply Breaker

Ethernet Connector

Power Connector

On/Off Switch

Voltage Selector Card
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Ethernet connector Allows communication between the computer and the 
DigiSizer analyzer.

Liquid Sample Handling 
Unit RS-232

Allows communication with the liquid sample handler.

ON/OFF switch Turns electrical power on and off to the analyzer. The up ( | ) 
position turns on the analyzer and the down (O) position 
turns off the analyzer.

Linear supply breaker This breaker serves to protect the linear supply that powers 
the detector. If the breaker trips after resetting, turn off the 
analyzer and contact your local Micromeritics service 
representative.

Power connector Supplies electrical power to the analyzer.

Voltage selector card Allows you to specify the proper operating voltage.
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Liquid Sample Handler

The Liquid Sample Handler is available in two configurations: the Standard unit and the Low-
volume unit. The Standard unit is shown for this illustration. The Low-volume unit is similar 
in appearance; the differences are:

• the size of the reservoir
• the inlet port for the rinse tubing is not used

Front Panel

Side Panel

The side panel of the liquid sample handler contains two plumbing ports; an outlet (lower) and 
inlet (upper). These ports allow connection of the sample transfer tubing from the liquid sam-
ple handler to the analyzer.

Reservoir The compartment into which the sample is placed for transfer 
to the DigiSizer analyzer for analysis.

Power indicator Illuminated when liquid sample handler is turned on.

Ports For tubing as indicated above.

Reservoir

Outlet Port for Overflow TubingOutlet Port for Drain Tubing

Power Indicator

Inlet Port for Analysis 
Liquid Tubing

Inlet Port for Rinse 
Liquid Tubing
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Rear Panel

On/Off switch Turns electrical power on and off to the liquid sample 
handler. The left ( | ) position turns on the unit and the right 
(O) position turns off the unit.

Power connector Supplies electrical power to the liquid sample handler.

Controller Allows communication between the ultrasonic probe and the 
liquid sample handler.

Probe Allows you to connect the ultrasonic probe.

RS232 from analyzer Allows communication between the liquid sample handler 
and the analyzer. 

RS232 spare Used for attaching a MasterTech.

Connector (controller) 
for Ultrasonic Probe

Power ConnectorOn/Off Switch

RS232 Spare

RS232 connector for 
Analyzer

Connector for 
Ultrasonic Probe
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MasterTech 052

Front Panel

ULTRASONIC PROBE 
AUTO/ON switch

LEDs on the switch indicate the mode of operation.

The AUTO position places the probe under automatic 
control.

The ON position turns on the probe. Remove the probe from 
its holder and place it in the liquid before turning on the 
probe.

Power Display

Intensity control

Pump Auto/Off Switch

Ultrasonic Probe Auto/On Switch Arm Auto/Load Switch

Discharge tube connector (one on each side)

Never turn the probe on unless the tip is submerged in liquid.

After using the probe, press the switch again to place the 
probe in automatic mode. Then replace it in its holder.

Power Display Displays the power being generated by the ultrasonic probe.

INTENSITY control Turn the control clockwise to increase the intensity of the 
probe, and counterclockwise to decrease the intensity.
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ARM AUTO/LOAD 
switch

The LEDs on the switch indicate the mode of operation.

Do not press the ARM AUTO/LOAD switch while an automatic operation is in
progress.

The AUTO position places the arm under automatic control.

The LOAD position raises the arm when you want to remove 
or load the tray.

This switch does not function unless the Saturn DigiSizer 
software is operating.

The MasterTech will not operate if the arm is in the Load 
position, so be sure to release the LOAD switch when you 
have finished removing or loading the beaker tray.

PUMP AUTO/OFF
switch

The LEDs on the switch indicate the mode of operation.

The AUTO position places the pump under automatic 
control.

The OFF position turns off power to the pump.
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Rear Panel

POWER ON/OFF switch Turns the MasterTech on ( | ) and off (O). 

Power connector Supplies electrical power to the MasterTech.

Voltage selector card Allows you to specify the proper operating voltage.

+5 and +24 VDC 
indicators

Illuminate when appropriate power is present in the 
MasterTech.

RS232 port Allows connection of the communications cable.

DC Breakers Protects internal power supplies.

+5 and +24 VDC indicators

RS232 portPower On/Off switch

Voltage Selector card

Power Connector
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Turning On and Off the System

Turning On the System

Components of the DigiSizer system must be turned on in a certain order so that all installed 
components are detected. Turn on the components in the following order:

1. Computer
2. Ultrasonic probe (if installed)
3. MasterTech 052 Autosampler (if installed). Wait for initialization to complete (rotation 

of the turntable will stop) before turning on the liquid sample handler.
4. Liquid sample handler
5. DigiSizer analyzer

After all components have been turned on, start the analysis program.

Turning Off the System

Turn off the system as follows:

1. Select Close from the System menu or Exit from the File menu.

• If an analysis is in progress, the following message is displayed:

2459- An analyzer is busy. A delay in restarting this application could 
result in loss of data. Continue with program exit?

                         Yes                                   No

If you click Yes, the analysis program will close. However, the analysis and data collec-
tion continue and the reports queued in the Print Manager will print. If, however, a 
power failure occurs and an uninterruptible power supply (UPS) is not attached to the 
analyzer, the data collected after exiting the analysis program are lost.

• If data calculations are in progress, the following message is displayed:

2458- An analyzer is performing a critical operation. Wait a few moments before 
exiting the application.

You cannot exit the analysis program until calculations are complete.

2. Turn off components as follows:

• DigiSizer 
• Liquid sample handler
• MasterTech 052
• Ultrasonic probe
• Computer
520-42812-01 (Rev G) - Nov 2018                                                  2-9 



Turning On and Off the System Saturn DigiSizer II 5205 Confirm
Preparing the System for Idle Periods

When the DigiSizer is not being used for analyses, it should be left with liquid in the reservoir 
so that the plumbing system remains primed. Perform the following steps to prepare the Digi-
Sizer for idle periods of up to 7 days:

1. Fill the reservoir to the primed level with clean analysis (or rinse) liquid.

2. Select Unit [n] > Enable manual control (select Unit [n] > Show instrument schematic 
if the schematic is not displayed).

3. Select the circulating pump; right-click and choose Set speed.

4. Enter 600; click OK.

5. Exit the analysis program; DO NOT turn off the analyzer or liquid sample handler.

If the DigiSizer is to remain idle for a period of more than 7 days.

1. Select  Unit [n] > Drain to drain all liquid from the system. This also moves the rotation 
arm out of the way so that the sample cell is easily accessed.

2. Remove the sample cell (refer to Cleaning the Optics, page 8-4 for removal instructions).

3. Using a lens paper, dry the sample cell completely and place it inside its container. If the 
container is unavailable, wrap the cell with a lens paper and store it in a secure location. 

4. Exit the analysis program and turn off all components as outlined in Turning Off the 
System, page 2-9.

5. Be sure to clean the sample cell before reinstalling. When turning components back on, 
refer to Turning On the System, page 2-9 for the proper order.
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Using the Software

The Saturn DigiSizer confirm program operates in the Windows environment and requires 
familiarity with standard Windows operations such as using the mouse, menus, and dialog 
boxes. While this manual provides brief instructions for such standard operations, you may 
have to refer to your Windows documentation or to its online help system to clarify functions 
which are specific to Windows.

Logging In

Each user — Administrator, Developer, or Analyst — is required to enter a user name and 
password when opening the application. Initially, the Administrator establishes passwords for 
the Developer and Analyst(s) when the software is installed. These passwords are temporary 
and are used for initial log-in; at that time, each user is prompted to specify a password that 
only he/she knows.

Your password must consist of at least six characters and will expire after a specified time 
(designated by the Administrator). You will be locked out of the application if you fail to enter 
the correct password after three (default) tries. This number can be changed by your Adminis-
trator. The Administrator is also required to unlock the application in the event it becomes 
locked after failure to enter the correct password.

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are avail-
able for certain components on the instrument schematic when in manual mode, and for 
onscreen graphs and tabular reports. These menus are accessed by selecting the item for which 
you want to display its menu and clicking the right mouse button. For example, right-click in a 
column of an onscreen report and the following menu is displayed.
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Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut-key combinations (if 
assigned) are listed to the right of the menu item. Instead of opening the menu and choosing 
the command, simply press the key combination. For example, to open a sample information 
file, press F2; the Open Sample Information dialog is displayed. You can also use shortcut 
keys to access a menu or any function that contains an underlined letter by pressing Alt plus 
the underlined letter. For example, to access the File menu, press Alt, then F.

Table 2-1 lists the shortcut key(s) for operating the Saturn DigiSizer program. 

Table 2-1. Shortcut Keys

Select... To...

F1 Access an electronic copy of the operator’s manual in PDF format

F2 Open a sample information file (main menu bar)

Clear the field of existing date (Select Dates dialog)

F3 Open an analysis conditions file (main menu bar)

Insert the current date (Select Dates dialog)

F4 Open a material properties file (main menu bar) 

Display a calendar from which to choose a date (Select Dates dialog)

F5 Open a report options file

F6 Tile windows

F7 Cascade windows

F8 Start a report

F9 Closes all open report windows

Alt + F4 Exit the analysis program

Shift + F2 List sample information files

Shift + F3 List analysis conditions files

Shift + F4 List material properties files

Shift + F5 List report options files

Shift + F9 Access shortcut menu of (1) selected component on instrument 
schematic, or (2) onscreen reports
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Dialog Boxes and Subdialog Boxes

Dialog boxes are displayed when an item followed by an ellipsis (...) is selected. Subdialog 
boxes are displayed when certain push buttons are selected. Both types of boxes may contain 
one or more of the items listed below.

Data entry field A data entry field is used to enter text; either numeric 
(numbers only) or alphanumeric (numbers, letters, or 
printable characters). 

Information Bar Some dialog boxes contain information pertinent to the 
selected field in an information bar across the bottom of the 
dialog. For example, a range is shown for fields in which 
numeric entries are required.

Push Button A push button is used to display a subdialog box in which to 
enter additional information about the subject matter, or to 
invoke an action.

Radio Button Radio buttons are contained within a group box and are used 
to make choices. Only one radio button can be selected.

Radio Button
Filled circle indi-
cates choice.

Push button
Displays a 
subdialog box.

Check box
Selected items contain a check mark.

Data Entry fields

Push button
Causes an action.

Information Bar
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The following push buttons are common to the DigiSizer analysis program and appear on 
many of the dialogs:

Check Boxes Check boxes are used to select options. You can select as 
many options as desired. 

Drop-down List A drop-down list contains a list of options and is indicated by 
a down arrow to the right of the field. If there are more items 
than can fit in the box, a scroll bar is provided for navigating 
through the list.

List box A list box also displays options, but allows you to select as 
many as you wish. To select an item in a list box: move the 
mouse pointer to the desired selection and double-click. 
Alternatively, you may highlight the desired item and press 
the Spacebar. An item is selected when it is preceded with a 
check mark (). 

Browse Displays a dialog box allowing you to select a file for the 
subject matter.

Cancel Closes the open dialog, discarding any information you may 
have entered and/or cancels the current operation.

Next Advances you to the next screen. This push button is disabled 
if this is the last screen of a series.

OK Closes the open dialog, saving any entries you may have 
made.

Prev Returns to the previous screen. This push button is disabled if 
this is the first screen of a series.

Indicates an item
is selected.
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Selecting Files

Sample information is stored in files and saved under file descriptions. Certain dialog boxes 
contain a Files window, which displays a list of files available for that particular operation. For 
example, the Open Sample Information File dialog:

The files displayed in the window are those contained in the selected directories and having 
the status shown in the Status field. To select a file, simply double-click on the desired file in 
the Files window

You can limit the list of files displayed in the Files list window by choosing one or more of the 
following:

Replace Allows you to copy file values from an existing file into the 
current one. This allows you to edit the values in the new file 
without changing the ones in the original file.

Resume Resumes a suspended operation.

Suspend Suspends the current operation. The push button changes to 
Resume.
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• Enter a range of dates. Select Date Range; the Select Dates dialog is displayed.

Select Show Date Range to enable the From and To fields and enter a beginning and 
ending date. Or, you can double-click in each field to display a calendar to select a date. 
The range of dates remains the default until you change the dates or select Show All 
Dates.

For convenience, the following shortcut keys are available when the Select Dates dialog 
is displayed:

• Select a file status from the Status drop-down list. Table 2-2 describes each file status.

Table 2-2. File Status and Description

F2 Clears the field
F3 Inserts the current date
F4 Displays a calendar from which to select a date

You may change the date format by using the Regional Settings function on the 
windows control Panel.

Status Description

All All sample information files in the specified directory and within 
the specified range of dates.

Analyzing Sample information files that are currently being used in an 
analysis.

Complete status information files that have had at least one test performed. 
Eight tests can be performed with each file.

Entered Sample information files that contain manually entered data.

No analysis Sample information files that have not been used in an analysis.
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Selecting Reports

Reports are selected from the Report Options dialog, or any dialog containing a Selected 
Reports list. Simply select (highlight) the report and then double-click, or press the 
Spacebar. A report is selected when it is preceded with a check mark (). Reports are dese-
lected in the same manner.

Indicates report 
is selected.
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Menu Structure

Main Menu Bar

All functions for the Saturn DigiSizer are accessed from the main menu bar. Brief descriptions 
are provided below; refer to the chapter given in parentheses for a detailed description of the 
commands contained on that menu.

File Allows you to manage sample and parameter files. 
(Chapter 4, FILE MENU)

Unit [n] Enables you to perform analyses and other instrument 
operations. (Chapter 5, UNIT MENU) 

Reports Enables you to generate and close reports. (Chapter 6, 
REPORTS MENU)

Options Allows you to edit sample defaults, select data presentation 
formats, and manage models. (Chapter 7, OPTIONS 
MENU)

Windows Enables you to arrange the windows and icons on your 
screen. It also displays the names of all open windows.
(this chapter, page 2-19)

Help Provides access to an electronic copy of the operator’s 
manual. (this chapter, page 2-19)
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Windows Menu

The Windows menu also displays all open files; the active window is preceded with a check 
mark ().

Help Menu

Indicates active 
window

Tile Resizes all open windows and arranges them side by side so 
that the contents of all open windows are visible.

Cascade Resizes all open windows and arranges them in a stacked 
fashion. The active window is positioned on top of the stack. 
Each window’s title remains visible, making it easy to select 
other windows.

Arrange icons Arranges all minimized icons in an orderly manner.

Operator’s Manual Provides a copy of the DigiSizer operator’s manual in 
Adobe® PDF format.

About  DigiSizer Displays information about the Saturn DigiSizer analysis 
program.
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Online Manual

For your convenience, the Operator’s Manual is available online. You can access the manual 
by selecting Help, then Operator’s Manual from the analysis program main menu. The man-
ual appears in an Adobe® Acrobat® Reader®.

Following are some tips to help you quickly locate the information you need in the manual. 
Refer to the Adobe Acrobat Help system (click the Help button on the Acrobat menu) for 
more information on the Acrobat features you can use while viewing the manual.

Using Bookmarks

Click the Bookmarks tab to list and access the topics included in the manual.

You can use the  +  and    buttons next to topics as they are used in Windows Explorer to 
expand or collapse the topic list.

Navigation Pane Topic Pane

Bookmarks

Topics
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To display a topic, click the topic name in the Bookmarks section. The related information 
appears in the topic pane of the window as shown in the following example.

 

 

Click bookmark
to display topic.
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Using the Table of Contents, Index, and other Links

Links provide direct access to selected information. All links appear in blue type. Links are 
contained in:

• the table of contents
• index entries
• cross-references within the manual 

Table of Contents

To display the table of contents, click Table of Contents in the Bookmarks section. When the 
table of contents is displayed, you can click an entry to display its associated page. For exam-
ple, clicking Using the Software in the table of contents, displays the page containing 
information about the software.

 

Click topic name in 
table of contents to 
display topic.
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Index

To use the index in the online manual, click the Bookmarks tab, scroll down to INDEX (the 
last topic in Bookmarks), then click the + button to expand the index. The letters A through Z 
are displayed. Click a letter to display its corresponding index entries as shown in the follow-
ing example.

After you display the entries, locate the item of interest and click on the page reference to 
access the information.

Cross References

Cross-references work in the same manner. In the example below, clicking on the cross-refer-
ence, FILE MENU (shown on the screen in blue type) will display the first page of the 
chapter describing the commands found on the File menu.

FILE MENU

Provides a description of the commands available on the File menu.

Click a letter to display 
its index entries.
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Using the Find Command

The Adobe Acrobat Find command provides another method of easily accessing specific 
information. For example, suppose you want to know how the Save as command works. You 
could select Edit > Find from the Adobe Acrobat menu, then enter Save as in the Find dialog. 
The following example shows the results.
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Printing

You can print the entire manual, a selected page, or range of pages. There are several options 
for printing. You can:

• Select the printer icon ( ) on the Adobe Acrobat toolbar.
A standard Print dialog is displayed. Select the page(s) to print, then click OK. When using 
this option (or the next one), be sure to enter the page number(s) displayed in Adobe 
Acrobat; do not use the page number(s) listed in the footer(s) of the manual.

• Select File > Print. 
A standard Print dialog is displayed. Select the page(s) to print, then click OK.

• Click the Thumbnails tab.
Thumbnails of manual pages are displayed.

a. Click the pages you want to print.

b. Right-click to display a shortcut menu, then select Print Pages.

c. A standard Print dialog is displayed; click OK.

Enter 
this 
number.

Do not use 
number in 
footer of the 
manual.

Thumbnails 
tab
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3.  OPERATIONAL PROCEDURES

This chapter describes brief, step-by-step instructions on how to:

• Create a file template, beginning on this page
• Create parameter files, page 3-4
• Create a sample file, page 3-11
• Measure a background, page 3-18
• Rinse the system, page 3-15
• Perform an analysis, page 3-22
• Print file contents, page 3-31
• List file statistics, page 3-34
• Import and export sample files, pages 3-37 and 3-38
• Generate reports, page 3-39
• Overlay data, page 3-48

This chapter does not contain detailed descriptions of the dialogs used to perform these proce-
dures. Refer to Chapters 4 through 7 for dialog descriptions. Use the index or online manual to 
assist you in locating the appropriate dialog. 

Some procedures cannot be performed by the Analyst; these procedures are marked 
accordingly.

Creating File Templates

When you create a sample or parameter file, a dialog containing available templates is dis-
played so that you can choose one on which to base your file. Several predefined templates 
have been included with the analysis program. A new template can be created using the values 
from an existing sample file. If you create a template from a completed sample file, you cannot 
edit the values. For example, you may wish to create a template for a sample file that you used 
with a sample material that you analyze on a routine basis.

You can also create a template from a sample file that has been created but has not been used 
with an analysis. This method allows you to edit file parameters as desired before saving the 
contents as a template. This is the method used in our example below.

The values in a template cannot be edited; however, you can edit the values in the sample file 
you create using the template.

An Analyst is not authorized to create sample and parameter file templates.
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Perform the following steps to create a template:

1. Select File > Open > Sample information; the Open Sample Information dialog is 
displayed.

2. Click on the Status drop-down list and choose No Analysis; this allows only the sample 
files that have not been used with an analysis to display in the Files window. 

3. Choose a file, then click Open; the Sample Information dialog is displayed.

4. Edit the fields of all parameters (click the tabs to access each parameter) as desired.

5. Select File > Save As Template, then choose:

• Sample information to save all parameters as a sample file template; the Save As 
Sample Template dialog is displayed. You can also click Save As Template on the 
sample information dialog if you are saving all parameters. You cannot use this push 
button to save individual parameter files.

• a parameter file to save the values of one of the parameters as a parameter file template. 
For example, select Analysis conditions to save the values in the Analysis conditions 
dialog as a template for Analysis conditions files.

6. Edit or enter a new description in the Sample field; you can use up to 42 characters. Be 
sure to use an intuitive description.

7. Click Save; the Save As Template dialog is displayed.

You can also create parameter file templates using an existing parameter file.
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8. Click Save to save the sample template. If Save is disabled, a template containing the 
same description already exists. Edit the description to enable Save.

9. Click Close on the No Analysis sample file; the following error message is displayed:

            (file name) has been changed. Save changes before closing?

Click No (unless you wish to save the changes made) to close the dialog.
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Creating Parameter Files

The following file types can exist as part of the sample information file, as well as individual 
parameter files:

• Analysis conditions
• Material properties
• Report options

Having these files exist independently allows you to use them over and over again. 

Several predefined parameter files are included with the Saturn DigiSizer Confirm program. 
Although these files may come close to the needs of your laboratory, you may wish to define 
additional ones. Or you can use a predefined file as a starting point. You can do this by creat-
ing a new file and then selecting Replace. A dialog is displayed so that you can select the 
existing parameter file. Then you can make any changes you need to make and the original file 
remains unchanged.

Analysis Conditions

Analysis conditions specify the data used to guide an analysis. 

Refer to Analysis Conditions, page 4-11 for a description of the fields on this dialog.

Perform the following steps to create an analysis conditions file.

1. Select File > New > Analysis conditions; the Create an Analysis Conditions File dialog 
containing the available templates is displayed.

2. Choose a template, then click Create; the Analysis Conditions dialog is displayed.

An Analyst is not authorized to create parameter files.
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3. Enter a description in the Analysis Conditions field. Be sure to use an intuitive 
description so that you will recognize it easily when needed. 

4. Specify flow rate requirements. You can have the flow rate calculated automatically by the 
DigiSizer or you can enter a value. 

5. In the Redispersion group box:

a. Select Ultrasonic probe if you are using an ultrasonic probe, then enter the percent of 
intensity for operation and how long you wish to have the sample agitated before 
analysis. You can also choose to have the probe remain on during analysis.

b. Select Circulate before data collection if you wish to have the analysis liquid 
circulated through the system after adding the sample, then enter how long circulation 
is to occur.

c. Select Redisperse before each test to have the sample redispersed just before each 
analysis.

6. In the Obscuration group box:

a. Specify a range for beam obscuration, or accept the defaults.

b. Select Autodilute to have the Saturn DigiSizer automatically maintain dilution of the 
sample concentration.

Use a description that will help you identify the type of sample you plan to analyze 
using these analysis conditions. You may want to use a description that contains the 
type of sample material and dispersing liquid. For example, Garnet/Water.
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7. In the Data Collection group box:

a. Enter the beam angle at which to stop data collection. This field defaults at 45, and 
typically is appropriate for most samples. The beam angle can be decreased if the 
sample does not contain small particles, or increased if the sample contains a 
significant quantity of particles smaller than 0.3 micrometers.

b. Enter the number of tests to be used with this file. Eight tests can be performed using 
the same file.

8. Select Rinse after analysis to rinse the system after all specified tests are complete. Then 
choose Autorinse (the system determines the rinses) or enter a specified number of rinses.

9. If you are using the MasterTech, click MasterTech Treatment and specify the stirring 
time, stirring speed, and probe time.

10. Click Save; the Save As Analysis Conditions File dialog is displayed.

11. Verify the description, then click Save to save the file and return to the Analysis 
Conditions file dialog. If Save is disabled, the description is a duplicate one and must be 
edited. The DigiSizer Confirm software does not allow duplicate descriptions.

12. Click Close to close the dialog.

You can click Save As Template if you wish to save the values in this file as an 
analysis conditions template.
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Material Properties

Material properties specify data for the sample material and its dispersant. 

Refer to Material Properties, page 4-16 for a description of the fields on this dialog.

1. Select File > New > Material properties; the Create a Material Properties dialog 
containing the available templates is displayed.

2. Choose a template, then click Create; the Materials Properties dialog is displayed.

3. Enter a description in the Material Properties field.

4. Choose the sample material from the Sample Material list box. If your material is not 
listed, add it to the list:

a. Enter the sample material in the Description field.

b. Enter the real and imaginary portions of the material’s refractive index.

c. Enter the material’s density.

d. Click Add.

Use an intuitive name that will help you identify the type of sample you plan to analyze 
using this file. You may want to use a description that contains the type of sample 
material and dispersing liquid. For example, Garnet/Water.
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5. Choose a dispersing liquid from the Analysis Liquid list box. If your dispersing liquid is 
not listed, add it to the list:

a. Enter the dispersing liquid in the Description field.

b. Enter the refractive index for the liquid

c. Enter the viscosity and density for the liquid.

d. Click Add.

6. The refractive indices for the sample material (in parentheses) and the dispersing liquid 
are displayed on the top line of the Scattering Model group box. The model chosen by the 
system is displayed on the second line. Click Options to choose a different model or to 
generate a model for the exact refractive indices selected.

7. Click Save; the Save As Material Properties File dialog is displayed.

8. Verify the description, then click Save to save the file and return to the Material Properties 
file dialog. If Save is disabled, the description is a duplicate one and must be edited. The 
DigiSizer Confirm software does not allow duplicate descriptions.

9. Click Close to close the dialog.

Refer to Appendix D, page D-1 for a list of common dispersing liquids and their 
density and viscosity values.

You can click Save As Template if you wish to save the values in this file as a material 
properties template.
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Report Options

Report options files specify the types of reports which can be generated from an analysis or 
from manually entered data. They also contain details of the reports such as axis scale, axis 
range, and column headings. These report options files may be used to generate reports auto-
matically at any time after the analysis. 

Report options files also may be defined to include three different types of overlays (refer to 
Generating Overlays, page 3-48). 

Refer to Report Options, page 4-21 for a description of the fields on this dialog.

Perform the following steps to define a report options file.

1. Select File > New > Report options; the Create a Report Options File dialog containing 
the available templates is displayed.

2. Choose a template, then click Create; the Report Options dialog is displayed.

3. Enter a description in the Report options field. Enter an identifier which gives a more 
intuitive description of the file’s contents. For example, Tabular Report using Volume 
Distribution.

4. Select Show report title and enter the title you wish to appear at the top of the report. Or 
deselect this option if you do not wish to have a report title.

If your company logo exists as a bitmap (bmp) or an enhanced metafile (emf), you can 
have it display in the report header by selecting Show graphic. Click Browse to select 
the file; use the Height and Width fields to specify the size.
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5. If you wish to compare analysis results for the current sample to those obtained for a 
reference sample, click Reference and choose a file. Results are reflected in the 
Difference from Reference report.

6. If you wish to determine if the results for the current sample are within coarse and fine 
specifications, click Specification and choose a sample file for each boundary. Results are 
reflected in the Out of Specification report.

7. If you wish to overlay graphs, click Overlays and choose the sample file(s) you wish to 
overlay with a graph of the current sample. Then be sure you edit the graph and choose 
Samples in the Overlay field.

8. Click Peaks to choose how peaks are detected.

9. From the Test drop-down list, choose the analysis for which you wish to have a report 
generated. 

• If you select Average, an average for all tests will be generated.
• If you select All, a separate report is generated for each test.

10. From the Reports to Generate list, choose the reports you wish to have generated. A 
report is selected when it is preceded with a check mark. To select (or deselect) a report: 
highlight the report, then double-click or press the Spacebar. 

11. Edit any reports you wish by highlighting the report, then clicking Edit.

12. Click Save; the Save As Report Options File dialog is displayed.

13. Verify the description, then click Save to save the file and return to the Report Options file 
dialog. If Save is disabled, the description is a duplicate one and must be edited. The 
DigiSizer confirm software does not allow duplicate descriptions.

14. Click Close to close the dialog.

You can click Save As Template if you wish to save the selections in this file as a 
report options template.
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Creating a Sample File

A sample information file must be created for each analysis. The sample information file con-
sists of information groups which, collectively, identify the sample, guide the analysis, and 
specify report options.

A sample file can be created by a Developer or an Analyst.

Analyst

An Analyst creates a sample information file by choosing predefined parameters. He/she can 
switch to an Advanced format to view details of the parameter files, but editing is not allowed. 

Refer to Analyst, page 4-4 for a description of the fields on this dialog.

Perform the following steps to create a sample information file:

1. Select File > New > Sample Information; the Create a Sample Information File dialog 
containing the available templates is displayed.

2. Choose the desired template, then click Create; the Sample Information dialog is 
displayed.

3. Enter a description in the Sample field. Be sure to use an intuitive description; the 
description is what displays in the Files list window.

Choose Replace All to copy parameters from an existing file into this one. After 
copying the parameters, you may edit them as desired. The file from which they were 
copied will not be altered in any way. 
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4. Select the down arrow at the Analysis Conditions field and choose an Analysis 
Conditions file from the drop-down list; selections specified in the file display for the 
Autodilute, Number of tests, and Rinse options. You can edit these selections if desired; 
it will not change the parameter file.

5. Click the down arrow at the Material Properties field and choose a file:

6. Click the down arrow at the Report Options field and choose a Report Options file from 
the drop-down list; reports selected in the file show in the Selected Reports window. You 
can edit these selections if desired.

7. After you have selected all parameters, click Save; the Save As Sample Information 
dialog is displayed. 

a. Choose the directory into which the file is to be saved.

b. Edit the description; the DigiSizer Confirm program does not allow duplicate 
descriptions.

c. Enter a comment in the Comment window; for example, you may wish to enter the 
date and time the file is created.

d. Click Save to return to the Sample Information file dialog.

8. Click Close to close the dialog.

You can edit details of a report by switching to the Advanced format.
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Developer

A Developer’s view of the sample information dialog is more flexible than that of an Analyst. 
A Developer is allowed to view and edit (if desired) all parameters of the file.

Perform the following steps to create a sample information file:

1. Select File > New > Sample Information; the Create a Sample Information File dialog 
containing the available templates is displayed.

2. Choose a template, then click Create; the Sample Information dialog is displayed.

3. Edit (or enter) the description in the Sample field; you can use up to 42 characters.

4. In the Operator field, enter the name of the Analyst who will be performing the analysis.

5. In the Submitter field, enter the name of the department, company, etc. submitting the 
sample for analysis. 

6. Choose whether you are going to use manually entered data or have it automatically 
collected.

7. Unless you are gathering statistical process control information, it is unnecessary to enter 
parameter values. These are user-definable parameters that can be entered and tracked 
along with other statistical process control data. This example shows unassigned 
parameters.

8. Click the following tabs to specify parameter values (refer to Creating Parameter Files, 
page 3-4 for assistance if needed):

• Analysis Conditions
• Material Properties
• Report Options
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9. After you have completed all parameters, click Save; the Save As Sample Information 
dialog is displayed. 

a. Choose the directory into which the file is to be saved.

b. Edit the description; the DigiSizer Confirm program does not allow duplicate 
descriptions.

c. Enter a comment in the Comment window; for example, you may wish to enter the 
date and time the file is created.

d. Click Save to return to the Sample Information file dialog.

10. Click Close to close the dialog.

You can click Save As Template if you wish to save the values in this file as a sample 
file template.
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Performing a Rinse Operation

A rinse operation should be performed to rinse the analysis cell of any debris or contaminants 
from previous analyses. Since contaminants from previous analyses can affect results of sub-
sequent analyses, it is best to perform a rinse operation after each analysis. 

Refer to Rinse, page 5-26 for a description of the fields on this dialog.

When you select Unit [n] > Rinse, three choices are presented: 

• DigiSizer - rinses the cell, the reservoir, and the tubing of the liquid sample handler and 
DigiSizer.

• MasterTech - rinses the MasterTech tubing into a specified beaker (enabled when a 
MasterTech is connected)

• MasterTech then DigiSizer - rinses the MasterTech first, then the liquid sample 
handler and DigiSizer as described above (enabled when a MasterTech is connected)

DigiSizer

Perform the following steps to rinse the analysis cell, the reservoir, and the tubing of the 
DigiSizer.

1. Select Unit [n] > Rinse > DigiSizer; the DigiSizer Rinse dialog is displayed.

2. Choose AutoRinse to have the analyzer automatically determine how many rinse cycles 
to perform based on beam obscuration, or Rinses to specify an exact number of rinses.

3. Click Start; progress messages are displayed until rinsing is complete, then the dialog 
closes automatically.
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MasterTech

This option is enabled only if a MasterTech is connected to the analyzer. 

Perform the following steps to rinse the MasterTech tubing:

1. Select Unit [n] > Rinse > MasterTech; the MasterTech Rinse dialog is displayed.

2. Enter the position number of the beaker that is to catch the rinse liquid. Be sure the beaker 
contains a small amount (approximately 10 mL) of liquid; otherwise, its presence may not 
be detected by the MasterTech.

3. Click Start; progress messages are displayed until rinsing is complete, then the dialog  
closes automatically.
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MasterTech then DigiSizer

This option is enabled only if a MasterTech is connected to the DigiSizer. 

Perform the following steps to rinse the analysis cell, the reservoir, and the tubing of the Digi-
Sizer and the MasterTech.

1. Select Unit [n] > Rinse > MasterTech then DigiSizer; the MasterTech then DigiSizer 
Rinse dialog is displayed.

2. In the MasterTech group box, enter the position number of the beaker that is to catch the 
rinse liquid. Be sure the beaker contains a small amount (approximately 10 mL) of liquid; 
otherwise, its presence may not be detected by the MasterTech. 

3. In the DigiSizer group box, choose Autorinse to have the analyzer automatically 
determine how many rinse cycles to perform based on beam obscuration, or Rinses to 
specify an exact number of rinses.

4. Click Start; progress messages are displayed until rinsing is complete, then the dialog 
closes automatically.
520-42812-01 (Rev G) - Nov 2018                                                  3-17 



Performing a Background Measurement Saturn DigiSizer II 5205 Confirm
Performing a Background Measurement

A background measurement is required for data collection. It is not necessary to measure a 
background for each analysis. It is recommended that you perform a background measurement 
once per shift and when you change analysis liquids. You can measure up to eight back-
grounds, but only the last one can be saved and used. Refer to Appendix H, page H-1 for a 
discussion and examples of acceptable and unacceptable backgrounds.

Refer to Background, page 5-22 for a detailed description of the fields on this dialog.

Perform the following steps to measure a background.

1. Select Unit [n] > Background; the Background Measurement dialog is displayed. 

2. Select the liquid you are using to measure the background (if different from the current 
one).

3. Click Next; another view of the Background Measurement dialog is displayed.

4. Ensure that the Flow rate option is selected; enter 6.

5. Select Report after measurement to have a background report generated automatically 
after the background is measured. Then select the drop-down list to choose a destination.

This background can be overlaid with backgrounds from other analyses for comparison if 
desired (refer to Background, page 6-5).

This group box displays 
statistics for the current 
background.

If using a different liquid, be sure that you have inserted the analysis liquid inlet tube 
(extending from the front panel of the liquid sample handler) into the new liquid.
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6. Click Next; a progress screen of the background being measured is displayed. The 
measurement is displayed in the final view of the Background Measurement window 
when it is finished. The current background is also displayed for comparison.

7. Click Done to accept the measured background and close the window. 

The progress view of the background window provides a suspend and skip option if 
either action is desired.

If this background measurement is unsatisfactory, you can perform another one by 
selecting Repeat. If you choose to measure another background, the current one 
becomes inaccessible. You must use the last background measured. Refer to 
Appendix H, page H-1 for guidelines on determining acceptable backgrounds.
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Changing Analysis Liquids

When changing analysis liquids, it is very important to remove all traces of the old liquid from 
the system and any air bubbles remaining in the liquid inlet pump. 

If the new liquid is immiscible with the old liquid, this procedure must be performed twice:

• the first time to change to a transition liquid which is miscible with the old and new 
liquid. Isopropanol (IPA) is often used as a transition liquid because it is miscible with 
water and many hydrocarbon-based liquids.

• and the second time to change from the transition liquid to the new liquid.

If a MasterTech is attached, its tubing must be drained and rinsed along with the rest of the 
system. Note that if a MasterTech is attached, it must always contain the same type of liquid 
used in the rest of the system, even if it is not used in analyses. This is necessary in order to 
prevent contamination or air bubbles.

1. Remove the analysis liquid inlet tube from the liquid supply. Drain the inlet tube, then 
wipe clean the outer surface; place it on a paper towel to absorb any further residue.

• If your DigiSizer is equipped with the standard liquid sample handler, repeat this step 
for the rinse inlet tube. 

2. Select Unit > Drain to drain the system of liquid.

3. Select Unit > Enable Manual Control to enable manual control.

4. Click the analysis pump icon. Turn on the pump and allow the pump to operate for 
approximately 10 seconds, then turn it off.

5. Select Unit > Drain to drain any liquid remaining in the system.

• If your DigiSizer is equipped with the standard liquid sample handler, repeat steps 4 and 
5 for the rinse pump. 

6. If a MasterTech is attached:

a. Place an empty beaker in position 1 of the MasterTech tray. 

b. Select Unit > Load from MasterTech; ensure that beaker 1 is designated and that the 
stirrer and probe times are specified as 0.

A quick-and-easy method for turning pumps on and off is simply to press the 
spacebar after selecting the appropriate pump.

If you receive an error message indicating that the beaker is not present, press down 
on the beaker to enable the sensing mechanism. then repeat the Load operation (step 
6-b).
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c. Select Unit > Drain to drain the system again. 

7. Wipe any additional residue from the analysis liquid inlet tube and place it into the new 
liquid supply. If the new liquid requires a new Waste container, replace the container.

8. Turn on the analysis pump; allow the inlet tube to fill until the liquid level  reaches the 
fitting on the front panel of the liquid sample handler, then turn off the pump.

9. Repeatedly turn on and off the analysis pump at one-second intervals until the Full liquid 
level sensor is on (sensor turns blue).

10. Select Unit > Drain to drain the system again. 

11. For the standard sample handler, repeat steps 6 through 10 for the rinse inlet.

12. Select Unit > Rinse > DigiSizer; for the:

• Standard sample handler: perform three separate rinse operations of one rinse cycle 
each (this flushes both the analysis inlet and rinse inlet three times).

• Low-volume sample handler: perform one rinse operation with 3 rinse cycles.

13. If a MasterTech is attached:

a. Place an empty beaker in position 1 of the MasterTech tray.

b. Select Unit > Rinse > MasterTech.

c. Empty the beaker, replace it onto the MasterTech tray, and repeat the rinse cycle.

d. Select Unit > Rinse > DigiSizer; rinse the DigiSizer with one rinse cycle.

14. Select Unit > Background, select the new liquid, then complete the measurement. 

15. Select Unit > Rinse > DigiSizer; perform one rinse cycle.

16. Perform another Background analysis. 

Examine the overlay of the current and previous background intensities. With the graph 
window maximized, most of the intensity data for the two curves should coincide so that 
only one color is showing. It is acceptable to have small differences (two colors showing 
with little or no white space between them) in small regions, and particularly in the data at 
greater than 10 degrees scattering angle. If the difference in the two background intensity 
curves is greater than 10 degrees, repeat steps 15 and 16 until a stable background inten-
sity is achieved.

If the background intensity is unusually high, remove and clean the cell (refer to 
Cleaning the Optics, page 8-4); then repeat this step. Appendix H, page H-1 provides 
guidelines for determining a good background.
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Preparing a Sample For Analysis

A sample must be dispersed properly before it can be analyzed. Refer to Appendix B, 
page B-1 for a discussion on sample dispersion and concentration. After the dispersed sample 
has been loaded into the reservoir, particle dispersion can be maintained using an ultrasonic 
probe (optional). 

Performing an Analysis

There are four different ways in which an analysis (or analyses) may be performed:

• Sample Analysis: Used to perform up to eight analyses on a single sample.

• QuickStart Analysis: Used to perform a series of samples of the same type with the 
same analysis conditions; sample files are generated automatically.

• MasterTech Automatic: Used to analyze a series of samples of the same type with the 
same analysis conditions. Sample files are created automatically; samples are 
transferred from the MasterTech automatically. 

• MasterTech Schedule: Used to analyze a series of samples which are different and, 
consequently, require different analysis conditions. Samples files are user-specified; 
samples are transferred from the MasterTech automatically. 

Choose the method you wish to use and proceed accordingly.

Sample Analysis

Refer to Sample Analysis, page 5-4 for a detailed description of the fields on this dialog.

Perform the following steps to perform up to eight analyses on one sample.

1. Select Unit [n] > Sample Analysis; the Sample Analysis dialog  is displayed with all 
fields grayed.

2. Click Browse to choose a file for your analysis, or New to create one; the Sample 
Analysis dialog containing the parameters of the selected file is displayed.
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3. Verify analysis conditions, material properties, and report options; edit if needed.

4. Click Next; the User Log in dialog is displayed. The purpose for this dialog is to ensure 
that the person logged into the application is the same one performing the analysis. 

5. Enter your password, then click OK;  an analyzing view of the window is displayed so that 
you can view data as collected. A short delay is encountered before the port status changes 
from the Idle state. If desired, you can obtain a report on the data collected so far by 
selecting the appropriate push button; the report is printed to the screen.
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6. While observing the beam concentration, slowly begin to add sample. Add enough sample 
to achieve the proper range for your material, using the following guidelines:

• If the beam obscuration is too high and you have chosen Autodilute, the concentration 
will be adjusted automatically until the correct beam obscuration is achieved. 

• If the beam obscuration is too low, continue to add sample.

7. Click Next when the proper obscuration is achieved to begin data collection.  

If your DigiSizer is equipped with the low-volume sample handler, be sure the sample 
is deposited into the liquid and does not adhere to the sides of the reservoir.

Sample Type
(micrometers) Beam Obscuration

Less than 0.1 4%

0.1 to 1 5% to 10%

1 to 10 10% to 20% 

10 to 100 20% to 30%

100 to 1000 30% to 45%
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QuickStart

Refer to QuickStart, page 5-10 for a detailed description of the fields on this dialog.

Perform the following steps if you wish to perform analyses on multiple samples using the 
same analysis conditions.  

1. Select Unit [n] > QuickStart; the QuickStart dialog is displayed.

2. Click New to create a file for this series of analyses; the Create a Sample File dialog 
containing available templates is displayed.

3. Choose a template, then click Create; the QuickStart dialog is again displayed. The 
parameters specified in the template display in the fields. You can edit any of the 
parameters you wish to change as outlined in the next few steps. Or you can accept the 
defaults and proceed to step 4.

a. Choose whether you wish to have the liquid level adjusted after each analysis before 
loading the next sample; if so, in which state.

• Full: when a maximum quantity of liquid is desired, a flow rate higher than 12 L/
min is used, or if you anticipate problems with bubbles.

• Primed: for normal operation and when a limited amount of sample is available, the 
reservoir will be filled with just enough liquid for circulation to occur.

• Empty: for previously dispersed samples already at the proper concentration. If you 
deselect this option, the system will leave the liquid level unchanged.

b. Select report output; you can have reports printed to the screen (Preview) or to a 
printer. (Print). 
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c. Choose a file management option:

• Prompt for files for each new sample; a dialog allowing you to select a file for 
every new sample is displayed. Analysis proceeds when you add the sample and 
click Next.

• Autodetect each new sample; a file is created by the system for each analysis and 
will be sequentially numbered. Analysis proceeds each time a new sample is added 
to the reservoir, creating a sample file automatically.

4. Edit the description so this file won’t be a duplicate.

5. Click Next; the User Log in dialog is displayed. The purpose for this dialog is to ensure 
that the person logged into the application is the same one performing the analysis. 

6. Enter your password, then click OK; the liquid is adjusted as requested then a second view 
of the QuickStart dialog prompting you to add the sample is displayed. If you chose 
Prompt for files for each new sample, the  push button is included allowing you to choose 
a different file for the analysis.

7. After all analyses are performed click Cancel to exit QuickStart mode.
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MasterTech Automatic

This option is functional only if you have a MasterTech connected to your analyzer. 

Refer to MasterTech Automatic, page 5-15 for a detailed description of the fields on this 
dialog.

Perform the following steps to analyze a series of samples of the same type using the same 
analysis conditions; sample files are created automatically. 

1. Select Unit [n] > MasterTech Automatic; the MasterTech Automatic dialog is displayed

2. Click New; the Create a Sample File dialog containing available templates is displayed.

3. Choose a template, then click Create; the MasterTech Automatic dialog containing the 
parameters of the selected template is again displayed.

You can edit any of the parameters you wish, or you can accept the defaults and proceed to 
step 4.

a. In the Start with beaker field, enter the position number of the beaker containing the 
first sample to be analyzed.

b. Enter the stirrer time, stirrer speed, and probe time for sample resuspension.

Samples tend to settle in the beaker while waiting for analysis, especially if several 
samples are prepared ahead of time. this option allows you to redisperse samples 
before analysis. Coarse materials and less stable dispersions may require a higher 
speed as well as more stirring and probe time than finer samples.
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c. Select report output; you can have reports printed to the screen (Preview) or to a 
printer (Print). 

4. In the Sample field, edit the description for this series of samples. Be sure to include the 
$ symbol if you want sample numbers included as part of the identification. 

5. Click Start; the User Log in dialog is displayed. The purpose for this dialog is to ensure 
that the person logged into the application is the same one performing the analysis. 

6. Enter your password, then OK to begin analyses; analyses of samples in consecutive 
beakers will continue as long as a beaker is present in the next beaker position. Be sure to 
remove used beakers after analysis.

You can also have the beaker number containing the sample included in the sample 
identification by entering # (number symbol) within the name you specify. For 
example, Garnet in beaker #.

If you wish to view the analyses in progress, select Analysis Results from the View 
drop-down list.
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MasterTech Schedule

This option is functional only if you have a MasterTech connected to your analyzer. 

Refer to MasterTech Schedule, page 5-18 for a detailed description of the fields on this 
dialog.

This mode of operation is used to analyze a series of samples that are different in size and 
shape and, consequently, require different analysis conditions. You also can schedule back-
ground measurements between samples. 

Perform the following steps to use this mode of operation.

1. Select Unit [n] > MasterTech Schedule; the MasterTech Schedule dialog is displayed.

2. Click Insert; the MasterTech Schedule Insert dialog is displayed.
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a. Select Sample analysis.

b. Enter the position number of the beaker containing the current sample.

c. Click Browse and choose the sample file you wish to use with the sample in this 
beaker position, or click New to create a file.

d. The values contained in the fields for Stirrer time, Stirrer speed, and Probe time are 
copied from the sample file you select. You may change them if you wish.

e. Click OK; the MasterTech Schedule dialog again is displayed. Note that the beaker 
information you just entered is shown in the list box.

3. Repeat step 2 for each beaker containing sample. 

4. Click Report Settings if you wish to have reports generated automatically after analysis; 
you can have reports printed to the screen (Preview) or to a printer (Print). 

5. Click Start; the User Log in dialog is displayed. The purpose for this dialog is to ensure 
that the person logged into the application is the same one performing the analysis. 

6. Enter your password, then click OK to begin analyses. 

You can also insert a background measurement between analyses if desired.
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Printing File Contents

You can print the contents of one or more sample file, parameter file, or file template. For 
example, if you print the contents of an analysis conditions file, you will receive the param-
eters used for the analysis conditions associated with the file.

• A Developer can print the contents of sample files, sample templates, parameter files, 
and parameter templates.

• An Analyst can print the contents of sample files, sample templates, and parameter 
templates (not parameter files).

Refer to Print, page 4-47 for a detailed description of the fields on this dialog.

Sample Files and Sample Templates

1. Select File > Print > Sample Information (or Sample Template); a dialog similar to 
this one is displayed.

2. From the Files window, select the desired file. If you plan to print the contents of multiple 
files, hold down Ctrl while selecting the files.

These fields do not display for a sample template.

Unavailable for 
an Analyst.

You can use the Category, Subcategory, Status drop-down list and/or the Date Range 
push button to limit the files displayed in the Files window; refer to page Selecting 
Files, page 2-15 for details. Only the Date Range push button is available for sample 
templates.
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3. Choose a destination for the output:

4. Click Print; the contents of the requested file(s) are sent to the selected destination. This 
example shows a sample information file sent to the screen (Preview).

Close: closes the dialog

Print: prints the report to the default printer

Header: toggles the header on and off

Prev and Next: enabled when the report contains multiple pages allowing you to advance 
to other pages

Preview Prints contents to the screen.

Print Prints contents to the default printer. Also enables the Copies field, 
allowing you to print up to four copies.

Export Prints contents to a file. Also enables the File name field so that you can 
enter a name (or you can accept the default). This option is not available 
for an Analyst.

Header
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Parameter Files and Templates

1. Select File > Print > (parameter file); a dialog similar to this one is displayed.

Only templates are displayed for an Analyst.

2. From the Files list window, select the desired file. If you plan to print the contents of 
multiple files, hold down Ctrl while selecting the files.

3. Choose a destination.

4. Click Print.

Unavailable for 
an Analyst.

Not displayed 
for an Analyst.
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Listing File Statistics

You can generate a list of the following information on one or more files to the screen, to a 
printer, or to a file. 

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• Status (not applicable for parameter files)

Refer to List, page 4-50 for a detailed description of the fields on this dialog.

• A Developer can list statistics for sample files, sample templates, parameter files, and 
parameter templates.

• An Analyst can list statistics for sample files, sample templates, and parameter 
templates (not parameter files).

Sample Files and Sample Templates

1. Select File > List > Sample Information  (or Sample Template); a dialog similar to this 
one is displayed.

2. From the Files window, select the desired file. If you wish to have statistics for multiple 
files, hold down Ctrl while selecting the file

These fields do not display for a sample template.

Unavailable for 
an Analyst.
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3. Choose a destination for the output:

4. Click List to generate file statistics to the specified destination; this example shows 
statistics for a sample information file printed to the screen (Preview).

Preview Prints contents to the screen.

Print Prints contents to the default printer. Also enables the Copies field, 
allowing you to print up to four copies.

Export Prints contents to a file. Also enables the File name field so that you can 
enter or a name (or you can accept the default). This option is not 
available for an Analyst.

The Status column is not applicable for parameter files.
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Parameter Files and Templates

1. Select File > List > (parameter file); a dialog similar to this one is displayed.

Only templates are displayed for an Analyst.

2. From the Files list window, select the desired file.  If you wish to have statistics for 
multiple files, hold down Ctrl while selecting the files.

3. Choose a destination.

4. Click List.

Unavailable for 
an Analyst.

Not displayed 
for an Analyst.
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Importing Sample and Parameter Files

The Import function allows you to import files which have been created on a computer other 
than the one controlling the analyzer and have them display in the Files list. 

Perform the following steps to import a file:

1. Copy the file(s) you wish to import to the Import directory. Files must be copied into this 
directory; otherwise they will not display in the Files window of the Import File dialog.

2. Select File > Import; a drop-down list containing file types is displayed.

3. Choose the file type; a dialog similar to this one is displayed.

4. Select the directory into which you wish to have the file imported. If you are importing a 
parameter file, the Category and Subcategory fields do not display. Parameter files are 
copied automatically into the directory assigned for parameter files.

5. Select the file(s) you wish to import; this enables the Import push button.

6. Click Import to import the file.

An Analyst is not authorized to import sample or parameter files.

Review the Micromeritics PROGRAM License Agreement for restrictions on the use of 
another copy.
520-42812-01 (Rev G) - Nov 2018                                                  3-37 



Exporting a Sample Information File Saturn DigiSizer II 5205 Confirm
Exporting a Sample Information File

Export allows a Developer to:

• export the entire sample file to the Export directory. For example, you may wish to use 
this option to transfer a sample file to another computer.

• copy the particle distribution data (Particle size option) in a sample information file and 
export it as ASCII text.

• copy the intensity and background data (Intensity option), and export it as ASCII text.

Perform the following steps to export a sample information file or ASCII data:

1. Select File > Export menu. Then from the drop-down, choose Sample information or the 
type of data you wish to export. This example shows exporting a sample information file; 
the dialogs are the same.

2. From the Files list window, choose the file you wish to export. You can select multiple 
files by holding down Ctrl while clicking on the desired files. Note that the confirm 
program has assigned a name with an smp extension for each file. Make a note of the smp 
file name(s) you are exporting. You will need this information when you retrieve the file 
from the Export directory.

An Analyst is not authorized to import sample or parameter files.

You can use the Status drop-down list and/or the Date Range push button to limit the 
files displayed in the Files list.
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3. Click Export; the file is exported automatically to the export directory.

4. Access the Export directory to retrieve the exported file(s).

Generating Reports

The following types of reports are available with the Saturn DigiSizer analysis program:

• Tabular and/or graphical
• Background
• Statistical process control

Refer to Onscreen Reports, page 6-20 ways in which to edit and change the appearance of 
your report. 

Tabular/Graphical Reports

Tabular and graphical reports are generated automatically (if requested) after an analysis. You 
can also generate reports manually if you simply wish to view a report, print additional copies, 
or change parameters and reprint.

Perform the following steps to generate reports manually.

1. Select Reports > Start Report; the Start Report dialog is displayed.

2. From the Files list window, click on the name of the file(s) for which you wish to have 
reports generated.
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3. Choose whether you wish to send report output to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to four 
copies.

4. Click Report; the Selected Reports dialog is displayed.

5. The reports selected (preceded with a check mark) are the ones chosen in the sample file; 
you may edit choices if desired. Double-click on a report to select (or deselect) it; 
alternatively, you may highlight the report and press the Spacebar.

6. Click OK; the selected reports are generated and sent to the specified destination.

This dialog is not displayed if you choose multiple reports to generate. Reports 
selected in the sample file are generated.

Check marks indicate
selected reports.

If you select Preview to generate reports to the screen, there are many options for 
manipulating and customizing reports. Refer to Onscreen Reports, page 6-20 for 
information on these options.
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Background Reports

A graphical report can be generated for the instrument’s background. This report generates a 
graph illustrating light intensity versus scattering angle when no sample is present. The header 
of this report also contains background statistics, such as the unit serial number, date the back-
ground was performed, etc.

You can also overlay the current background with backgrounds used with other analyses for 
reference. 

Perform the following steps to generate a background report. Refer to Background, page 6-5 
for detailed information on this option. 

1. Select Reports > Background; the Start Background Report dialog is displayed.

2. From the Instrument drop-down list, select the instrument on which you wish to have the 
background report generated. 

3. If you wish to compare the current background with backgrounds for a sample (or multiple 
samples), select Overlay Samples and then click Samples to specify the desired file(s).

4. Choose whether you wish to generate the report to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to four 
copies.

5. Click OK; the background report is generated and sent to the specified destination.  

This destination is not 
available for an Analyst.
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Statistical Process Control Reports

Statistical process control (SPC) reports assist you in maintaining control of a manufacturing 
process. 

There are three types of SPC reports: Regression, Control Chart, and PSD History. Before you 
can generate SPC reports, you must specify the calculation parameters to be used. These selec-
tions determine what values are available for SPC reporting. For efficiency, it is best to choose 
only the variables you actually intend to use since all variables selected are computed for each 
sample file used in an SPC report. 

Specifying SPC Options

Refer to SPC Report Options, page 6-6 for a detailed description of the fields on this dialog.

Perform the following steps to specify calculation parameters:

1. Select Reports > SPC report options; the SPC Calculations dialog is displayed.

2. From the Test  drop-down list, select the analysis on which you wish to report. If you 
select Average, an average of all analyses for the specified sample file are reported.

3. Select the types of statistics you with to report.

4. Select the type of distribution you wish to apply.

An Analyst is not authorized to choose SPC options.
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5. Select whether you wish to have arithmetic (linear) or geometric (logarithmic) type of 
statistics.

6. From the Statistics group box, select the statistics you wish to be included in SPC 
reporting.

7. Click Sample to choose the sample parameters you wish to report.

8. Click Analysis to choose the analysis conditions you wish to report.

9. Click Sizes to specify the percentiles for the corresponding diameters.

10. Click Percentiles to specify the diameters for corresponding percentiles.

11. If peak statistics are desired, select the peaks you wish to include.

12. Click OK to save SPC report options.
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Generating a Regression Report

Refer to Regression Report, page 6-9 for a detailed description of the fields on this dialog.

Perform the following steps to generate a regression report.

1. Select Reports > Regression report; the Regression Report Options dialog is displayed.

2. Select Show report title and enter the title you wish to appear at the top of the report (or 
accept the default). Deselect this option if you do not wish to have a report title.

3. Select your X- and Y-axes variables. The variables displayed in these drop-down lists are 
the ones specified in SPC report options.

4. Deselect Autoscale if you do not wish to have data scaled automatically; then enter the 
desired ranges.

5. Select Tabular if you wish to have tabular, as well as graphical, data of the included 
samples generated.

6. Select Label to have the points on the plot correspond with the sample files from which 
they came.

7. Click Samples to choose the files you wish to have reported; you can choose up to 200 
files.

Not available for 
an Analyst.

If your company logo exists as a bmp or emf file and you wish to have it display in the 
report header, select Show graphic. Click Browse to select the file.
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8. Select Recalculate archived SPC results if you wish to have the SPC statistics 
recalculated for each of the included sample files. You may wish to use this option when a 
statistic you have selected is labeled N/A (not available) on the tabular report.

9. Choose whether you wish to generate the report to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to four 
copies.

10. Click Report; the regression report is generated and sent to the specified destination.

Generating a Control Chart Report

Control chart reports can be generated to illustrate process variations.

Refer to Control Chart, page 6-13 for a detailed description of the fields on this dialog.

Perform the following steps to generate a control chart.

1. Select Reports > Control chart; the Control Chart Options dialog is displayed.

2. Select Show report title and enter the title you wish to appear at the top of the report (or 
accept the default). Deselect this option if you do not wish to have a report title.

You can click Save as Default if you wish to have the selected options become the 
defaults for Regression reports.

Not available for 
an Analyst.

If your company logo exists as a bmp or emf file and you wish to have it display in the 
report header, select Show graphic. Click Browse to select the file.
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3. Choose whether you wish to have files listed in order by Time, File name, Date, 
Minutes, or Days.

4. Click Graph [n] to select Y-axis labels.

5. Select Recalculate archived SPC results if you wish to have the SPC statistics 
recalculated for each of the included sample files. You may wish to use this option when a 
statistic you have selected is labeled N/A (not available) on the tabular report. 

6. Select Tabular report if you wish to have tabular, as well as graphical, data generated.

7. Click Samples to choose the files you wish to have reported; you can choose up to 200 
files.

8. Click Summary Statistics to choose the type of statistics you wish to report.

9. Choose whether you wish to generate the report to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to four 
copies.

10. Click  Report; the control chart report is generated and sent to the specified destination.

You can click Save as Default if you wish to have the selected options become the 
defaults for Regression reports.
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Generating a PSD History Report

PSD History reports allow you to generate a sequence of particle size distributions on up to 
200 files.

Refer to PSD History, page 6-17 for a detailed description of the fields on this dialog.

Perform the following steps to generate a PSD History report:

1. Select Reports > PSD history; the PSD History Options dialog is displayed.

2. Select Show report title and enter the title you wish to appear at the top of the report (or 
accept the default). Deselect this option if you do not wish to have a report title.

3. Choose whether you wish to have the X-axis order by Time, File name, Date, Minutes, 
or Days.

4. Click Samples to choose the files you wish to have reported; you can choose up to 200 
files.

5. Choose the report destination and click Report; the report is generated to the specified 
destination.

This destination is 
not available for an 
Analyst.

Click this push but-
ton to save the 
current definitions 
as the default.

If your company logo exists as a bitmap (bmp) or an enhanced metafile (emf)  and you 
wish to have it display in the report header, select Show graphic. Then click Browse to 
select the file
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Generating Overlays

Use the overlay function when you wish to compare graphically multiple graph options. Over-
lays may be generated in three ways:

• Multiple-Graph Overlay
Overlay two different types of plots from one sample 

• Multiple-Samples Overlay
Overlay up to eight plots of the same type with the current plot 

• Multiple-Tests Overlay
Overlay the same plot of all tests in one sample file

It is much easier to generate overlays if you have predefined report options files created for 
specific overlay functions. For example, if you frequently compare Out of Specification 
graphs, define a report options file containing the desired options and assign an identification 
such as Out of Spec Overlays. Then you can use Replace to load the predefined file into the 
sample file. You do not have to save the file to have overlays generated, so the report options 
for your original sample file remain intact.

Multiple-Graph Overlay

To overlay multiple graphs from the same sample file:

1. Select File > Open > Sample information. Choose the desired sample file and click 
Open.

2. Select the Report Options tab (an Analyst must click Advanced); the report options dialog 
is displayed.

3. Use one of the following methods:

If... Then...

You are using a predefined 
Report Options file:

Click Replace and choose the report options file you wish to 
use.

You are defining report 
options:

Select which test you wish to use.

In the Selected Reports list, select the graph(s) you wish to 
overlay with other graph(s).

Click Edit for each requested graph; a Graph Options dialog 
is displayed.

From the Overlay drop-down list, choose the type of graph 
you wish to overlay; then click OK.
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4. Select Reports > Start Report; the Start Report dialog is displayed. 

5. Select the desired file.

6. Choose whether you wish to generate the report to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to four 
copies. 

7. Click Report; the Selected Reports dialog is displayed, allowing you to change report 
selection if desired.

8. Click OK; requested overlays are generated and sent to the specified destination.

Multiple-Sample Overlay

To overlay the same type of graph(s) on multiple samples:

1. Select File > Open > Sample information. Choose the desired sample file and click 
Open.

2. Select the Report Options tab (an Analyst must click Advanced); the report options dialog 
is displayed.

3. Use one of the following methods:

You do not have to save these options to generate the overlays. If you do save, the 
reports options for your original sample file will be replaced with the new ones.

If... Then...

You are using a predefined 
Report Options file:

Click Replace and choose the report options file you wish to 
use.

You are defining report 
options:

From the Test drop-down list, select the test (analysis) of this 
sample file for which you wish to have results reported.

The graph(s) you select for this report will be overlaid with 
the corresponding graph(s) of the test designated in the 
Report Options file(s) of the sample file(s) you select in step 
6.

In the Selected Reports list, select the graph(s) you wish to 
overlay.

Click Edit for each requested graph; a Graph Options dialog 
is displayed.

Ensure that Samples is selected in the Overlays field.

Click OK to display the Report Options dialog.
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4. Click Overlays; the Graph Overlay Samples dialog is displayed.

5. Click Browse; the Graph Overlay Sample File Selection dialog is displayed.

6. Choose the file you wish to use; then click OK. You may choose up to eight files in this 
manner.

7. Select Reports > Start Report; the Start Report dialog is displayed; select the desired file.

8. Choose whether you wish to generate the report to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to four 
copies. 

9. Click Report; the Selected Reports dialog is displayed, allowing you to change report 
selection if desired.

10. Click OK; requested overlays are generated and sent to the specified destination.

You do not have to save these options to generate the overlays. If you do save, the 
reports options for your original sample file will be replaced with the new ones.
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Multiple-Test Overlay

This options enables you to overlay the same type of graph for all tests from the same sample 
file:

1. Select File > Open > Sample information. Then choose the desired sample file. If your 
window is presented in the Basic format, click Advanced.

2. Select the Report Options tab (an Analyst must click Advanced); the report options dialog 
is displayed.

3. Use one of the following methods:

4. Select Reports > Start Report; the Start Report dialog is displayed; select the desired file.

5. Choose whether you wish to generate the report to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to four 
copies. 

6. Click Report; the Selected Reports dialog is displayed, allowing you to change report 
selection if you wish.

7. Click OK; requested overlays are generated and sent to the specified destination.

If... Then...

You are using a predefined 
Report Options file:

Click Replace and choose the report options file you wish to 
use.

You are defining report 
options:

In the Selected Reports list, select the graph(s) you wish to 
overlay.

Click Edit for each requested graph; a Graph Options dialog 
is displayed.

Ensure that Tests is selected in the Overlays field.

Click OK to return to the Report Options dialog.

You do not have to save these options to generate the overlays. If you do save, the 
reports options for your original sample file will be replaced with the new ones.
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4.  FILE MENU

The File menu contains commands which allow you to manage sample and parameter files.

Description

Listed below are brief descriptions of the File menu commands. Detailed descriptions follow 
this section.

New Allows you to create a sample information or parameter file. 
Page 4-3.

Open Opens an existing sample information or parameter file. 
Page 4-38.

Save Saves the file in the active window. Page 4-43.

Save As Saves the file in the active window as a different name. You 
also can use this option to save a subset of the sample file as a 
parameter file. Page 4-43.

Save As Template Allows you to save the values from the open file as a 
template for a sample information or parameter file. 
Page 4-45.
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Save All Saves all open files. Page 4-45.

Close Closes the file in the active window. Page 4-45.

Close All Closes all open files. Page 4-46.

Print Prints the contents of a sample or parameter file.  Page 4-47.

List Generates a list of certain information for sample or 
parameter files.  Page 4-50.

Import Allows you to import a sample information or parameter file 
into the assigned application directory. Page 4-51.

Export Allows you to export the data from a sample information file. 
Page 4-52.

Log in Allows you to log into the application. Page 4-53.

Log out Allows you to log out of the application. Page 4-53.

Exit Exits the analysis program. Page 4-54.
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New

New allows you to create a sample information or parameter file. Regardless of the type of file 
you are creating, a dialog allowing you to choose a template is displayed.

A Developer can create sample information and parameter files. An Analyst can create only a 
sample information file using predefined parameter files chosen from drop-down lists.

After you choose a template, click Create to display a dialog for the associated file.

Title bar indicates type 
of file you are creating.
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Sample Information

Sample information files contain information used to control the analysis. Therefore, an analy-
sis cannot proceed until it has been assigned a sample information file. A sample information 
file consists of the following:

• sample identification
• analysis conditions
• material properties
• report options
• collected (after an analysis has been completed) or entered data  

Parts of the sample information file can also exist as parameter files which are separate from 
the sample information file itself. Having these files exist independently allows you to use 
them as many times as you wish. For example, if you typically use the same analysis condi-
tions for many of your analyses, you can create an analysis conditions file containing those 
conditions. Then when you create your sample file, select that file for your analysis conditions.

A sample information file can be created by an Analyst or a Developer. A Developer can cre-
ate a sample file in its entirety, specifying values for all parameters; all fields on the dialogs are 
enabled for input. An Analyst can create a sample file by selecting predefined parameter files 
from drop-down lists.

Analyst

The Sample Information dialog displays in this manner for the Analyst.
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Sample Displays the description of the template. You may enter a 
new description or add to the existing one. You can use up to 
50 alphanumeric characters.  The description you enter in this 
field appears in the Files list window on the Open Sample 
Information dialog.

You can use up to 50 alphanumeric characters.

Revert Displays the Revert dialog allowing you to choose a previous 
version (if any exist) of the sample file.

This dialog will list previous versions of the current file and 
the comment entered for each one; it does not list the current 
version. You can use the drop-down list to choose other 
versions; each version’s comments will be listed in the 
Comment window.

Analysis Conditions Contains the description of the current Analysis Conditions 
file.

To choose a different file, click on the down arrow to the 
right of the field. This drop-down list contains predefined 
files created by the Developer. You can view the values of the 
file you choose by clicking Advanced; however you cannot 
edit them.

Autodilute Enables monitoring of the sample’s concentration and adds 
liquid as needed to attain the appropriate concentration before 
analysis and data collection begin.

Number of tests Enter the number of analyses you wish to perform using this 
sample file; you can perform up to eight tests with one file.
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Rinse Allows rinsing of the cell, the tubing, and the reservoir after 
each analysis. We recommend this option remain selected. If 
you deselect this option and rinses are not performed after 
analysis, inaccurate results may be obtained on subsequent 
analyses.

Material Properties Contains the description for the current Materials Properties 
file.

To choose a different file, click on the down arrow to the 
right of the field. This drop-down list contains predefined 
files created by the Developer. You can view the values of the 
file you choose by clicking Advanced; however you cannot 
edit them.

Report Options Contains the description for the current Report Options file.

To choose a different file, click on the down arrow to the 
right of the field. This drop-down list contains predefined 
files created by the Developer. You can edit some reports by 
clicking Advanced, then Edit.

Selected Reports Displays a list of available reports. The reports selected for 
the current Report Options file are preceded with a check 
mark (); these selections can be edited.

Certain parameters of some reports can be edited by 
switching to the Advanced format.
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Save Displays the Save As Sample File dialog.

From this dialog, choose the directory in which to save the 
file. The Save push button becomes enabled allowing you to 
complete the save operation after you make an entry in the 
Comment window.

If Save does not become enabled after an entry is made in the Comments window, a 
file with the same ID currently exists in the selected directory. You must choose a 
different directory or edit the identification of the current file.

Close Closes the dialog. If the file contains unsaved changes, you 
are prompted to save before the dialog closes.

Advanced Displays the sample information file in the Developer’s 
format. This format allows you to view details of the sample 
file and allows some fields to be edited. Refer to the next 
section for a description of the fields for the Developer’s 
format.
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Developer

The Sample Information dialog displays in this manner for a Developer. 

Some fields on the Developer’s view of the Sample Information dialog are also enabled for the 
Analyst when Advanced is clicked from the Analyst Sample Information dialog. 

Sample Displays the description for the current sample template. You 
may enter a new description or add to the existing one. You 
can use up to 50 alphanumeric characters.

Operator 
Submitter

Enter the name of the operator who will be using this file to 
perform the analysis and the name of the person (or 
department) submitting the sample for analysis. You can use 
up to 40 characters in each field.

Bar code This field enables you to enter bar code information. If bar 
code information is not used, you can use this field to enter 
additional information about the sample; for example, you 
may wish to enter the lot number of your sample. This field 
can also be omitted using the Edit Labels command on the 
Options menu.

This field will also accept data from a bar code reader.

You can use up to 40 characters in  this field.
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Type of Data Choose whether you wish to enter the data or have it  
collected automatically by the analysis program.

If you choose Manually entered, an “Entered” tab is added 
so that you may enter the desired data. You cannot enter data 
if you are creating the file on a computer that is not attached 
to the analyzer.

User Parameters These fields are used specifically for SPC (Statistical Process 
Control) reporting. The parameters on which you wish to 
report are specified by selecting Edit Labels from the 
Options menu (refer to Edit Labels, page 7-4 for additional 
information). The parameter(s) you specify will replace the 
User Parameter label(s) displayed here. 

If SPC reporting is not desired, you can specify to have these 
fields omitted from the sample information file.

Comments Allows you to enter comments about the sample or its 
analysis conditions. Anything you enter in this window is 
printed in the header of the report.

Add Log Entry Displays a dialog so that you may enter comments about the 
sample or its analysis conditions. Anything you enter using 
the dialog displayed by this push button appears in the 
Instrument Log Report; it does not display in the report 
header.

Revert Displays the Revert dialog allowing you to choose a previous 
version (if any exist) of the sample file.

This dialog will list previous versions of the current file and 
the comment entered for each one; it does not list the current 
version. You can use the drop-down list to choose other ver-
sions; each version’s comments will be listed in the Com-
ment window.
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Replace All Click this push button to replace all parameters of the current 
sample file with those from another one.

Save Displays the Save As Sample File dialog. Refer to page 
Save, page 4-7 for an explanation of this dialog.

Close Closes the dialog. If the file contains unsaved changes, you 
are prompted to save before the dialog box closes.

Save As Template Saves all parameters as a Sample File template.

Basic Displays the sample information file in the Analyst’s format 
(explained in the previous section).
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Analysis Conditions

This dialog allows you to specify the analysis conditions for your sample. An analysis condi-
tions file can be created as an independent parameter file or as part of the sample information 
file. 

Analysis Conditions Displays a description of the current Analysis Conditions 
template.

Enter a new description or add to the existing one if desired. 
Be sure to use an intuitive name (perhaps one that character-
izes the analysis conditions) so that it can be easily 
recognized when needed.

Range: 40 alphanumeric characters

Replace Click this push button to choose a file containing parameters 
you wish to copy and use in the current file.

After the values have been copied into the file, you can edit 
them as desired. It does not affect the values of the file from 
which they were copied.

Flow rate group box Displays the flow rate conditions for the current template.
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Set flow rate Select this option to enter a flow rate or have the flow rate 
calculated automatically. 

Select Enter rate; the Flow rate field is enabled so that you 
can enter a specific flow rate.

Select Auto calculate; the Maximum particle size field is 
enabled so that you can enter the estimated maximum particle 
size of your sample. This enables you to set a flow rate large 
enough so that no sampling error (due to a slow flow rate) is 
introduced.

If you deselect this option, the previous flow rate (typically, 
from the previous analysis) is used.

Redispersion group box Displays redispersion parameters for the current template.

Ultrasonic probe Select this option if you are using an ultrasonic probe. 

In the Intensity field, enter the percent of intensity at which 
to have the ultrasonic probe operate. In the Time field, 
specify how long the sample is to be agitated before each 
analysis. Select On during test to have the probe remain 
operating during analysis.

Coarse materials and less stable dispersions may require more agitation than finer 
materials.

Circulate before 
data collection

Circulates the analysis liquid through the system after you 
have added the sample. Enables the Circulation time field so 
that you can enter how long the sample circulates before 
analysis and data collection begin.

Redisperse before 
each test

Redisperses the sample just before each test (analysis) is 
performed. You can perform up to eight tests with one sample 
file.

Obscuration Displays details of the beam obscuration criteria.
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Minimum
Maximum

These fields allow you to specify a recommended range for 
the beam obscuration. The range you specify will be used on 
the obscuration bar graph during sample loading. Refer to 
Appendix B, page B-1 for guidelines on appropriate 
obscuration levels for various particle sizes.

Autodilute to Allows monitoring of the sample’s concentration and adds 
liquid as needed to attain the appropriate concentration before 
analysis and data collection begin.

Data Collection Specify the beam angle at which to stop data collection. 

• Lower beam angles produce shorter analysis times.

• Lower beam angles can be used for samples that do not 
contain small particles.

• Higher beam angles allow smaller particles to be detected.

Generally, the default of 45º is suitable for most samples 
unless a significant quantity of the material has particle size 
less than 0.3 micrometers; if this is the case, 65º is 
recommended.

Number of tests Allows you to enter the number of tests (analyses) you wish 
to perform using this file; you can perform up to eight tests 
with one file.

Rinse after analysis Deselect this option if you wish to examine the reports before 
proceeding with, perhaps, further tests on the file or further 
dispersion. If this is the case, however, you should perform a 
rinse using the option on the Unit [n] menu or select a sample 
file and enable the Rinse after analysis option to prepare for 
the next analysis.

Select this option to rinse the cell, the tubing, and the reser-
voir after each analysis. 
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Autorinse Rinses the system until a beam obscuration of 0.1 or less is 
attained. 

If your analysis and rinse liquids are the same, rinsing 
stops when:

• No significant decrease in beam obscuration is attained 
twice in a row, displaying an error message. 

• The system has performed 10 rinses and was unable to 
attain 0.1 or less; an error message is displayed. 

If your analysis and rinse liquids are different, rinsing 
stops when:

• Successive rinses show no significant decrease in beam 
obscuration. If the beam obscuration is greater than 1.0, an 
error message is displayed. If less than 1.0, it is assumed to 
be due to the difference in liquids and operation continues.

• The system has performed 10 rinses and was unable to 
attain a beam obscuration of less than 0.1, displaying an 
error message. 

Rinse cycles  Allows you to specify an exact number of rinses to perform.

MasterTech Treatment Displays the Mastertech Treatment dialog so that you can 
specify the stirrer time, stirrer speed, and probe time for the 
MasterTech.

Samples tend to settle in the beakers while waiting for sample 
analysis, especially if they are prepared in advance (as in 
most cases when using a MasterTech). The options in this 
dialog allow you to program the MasterTech stirrer and probe 
to redisperse the sample prior to analysis.

This option is applicable only if a MasterTech is being used 
in the analyses.
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Save Displays the Save As Analysis Conditions File dialog.

After you enter a description, the Save push button becomes 
enabled allowing you to complete the save operation. If Save 
does not become enabled, a file with the same ID currently 
exists. The DigiSizer Confirm program does not allow 
duplicate descriptions. You must edit the identification before 
you can save the file.

Close Closes the dialog. If the file contains unsaved changes, you 
are prompted to save before the dialog box closes.

Save As Template Allows you to create an analysis conditions template of the 
current file.
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Material Properties

This dialog allows you to specify the properties of the sample material being analyzed and the 
dispersing liquid in which it is dispersed. A Material Properties file can be created as an inde-
pendent parameter file or included as part of the sample information file.

Material Properties Displays a description of the current Material Properties 
template.

Enter a new description or add to the existing one if desired. 
Be sure to use an intuitive name (perhaps one that 
characterizes the sample’s properties) so that it can be easily 
recognized when needed.

Range: 40 alphanumeric characters

Replace Click this push button to choose a file containing parameters 
you wish to copy and use in the current file.

After the values have been copied into the file, you can edit 
them as desired. It does not affect the values of the file from 
which they were copied.
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Sample Material Displays a list of available sample materials. After you select 
a sample material from the list, its description and properties 
are displayed.

Description Displays the sample material you select from the list. This 
field is also used to add sample materials to the list.

Refractive Index Displays the real and imaginary portions of the refractive 
index for the selected material.

Density Displays the density of the selected material.

Add Enables you to add sample materials to the list

1. In the Description field, enter the name of the sample 
material you wish to add.

2. In the Density field, enter the density of the material you 
are adding. 

3. In the Refractive Index fields, enter the real (Re) and 
imaginary (Im) portions of the refractive index.

4. Click Add. 

Density and refractive index values can be obtained from a laboratory handbook.

This push button is also used to change density and/or 
refractive index values for a sample material.

1. Select (highlight) the sample material you wish to edit.

2. Enter the new value(s) in the appropriate field(s).

3. Move the mouse pointer to another field; note that Add 
changes to Change. 

4. Click Add; the values are changed.

Delete Deletes the selected sample material from the list.
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Analysis Liquid Displays a list of available analysis (dispersing) liquids. After 
you select a liquid from this list, its description and properties 
are displayed.

Description Displays the analysis liquid you select from the list. This field 
also is used to enter the name of analysis liquids you wish to 
add to the list.

Refractive Index Displays the refractive index (real portion) of the selected 
analysis liquid.

Viscosity Displays the viscosity of the selected analysis liquid.

Density Displays the density of the selected analysis liquid.

Add Enables you to add analysis liquids to the list.

Analysis liquids are added in the same manner as sample 
materials.

Delete Deletes the selected analysis liquid.

Scattering Model Displays the refractive indices for the sample material (real 
and imaginary) and analysis liquid, as well as  the model 
chosen by the system to be the closest match.

Options Use this push button to select a different model or to generate 
a new one; the Scattering Model Advanced Options dialog is 
displayed.
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Options

(continued)

You can choose a different model from the Available Models 
list, as well as specify the type of smoothing desired. 

Low should be used when high resolution is desired, and 
your sample material consists of near-perfect spheres with 
accurately known refractive indices.

Medium is the default and typically is appropriate for most 
materials.

High should be used for (1) materials in which an accurate 
refractive index is unknown, or (2) materials that differ 
greatly from the Mie scattering patterns (nonhomogeneous 
materials or materials that have a large aspect ratio in particle 
shape).

If a suitable model is unavailable, you can click Generate to 
create a new model. When you generate a new model, its 
progress is displayed across the lower portion of the dialog. 
Generation times vary, depending on computer speed. Typi-
cally for a 333 megahertz computer, generating a new model 
takes approximately 20 minutes. 

Truncate data at scattering angle
Choose this option to truncate the intensity data used in fit-
ting the model; data will be truncated at the angle specified in 
the adjacent field.

Minimum signal fraction
This field allows you to restrict intensity data used in fitting 
the model based on a percentage due to sample scattering 
rather than background.

Apply Changes
Enabled when the changes requested in this dialog are to a 
file that has been used in a completed analysis. You must 
select this push button to apply the  changes in fitting the 
model to the data  from all tests used with the file.

OK
Enabled when the changes you requested in this dialog are to 
a file that has not been used in an analysis. Clicking this push 
button saves the changes
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Save Displays the Save As Material Properties File dialog.

After you enter a description, the Save push button becomes 
enabled allowing you to complete the save operation. If Save 
does not become enabled, a file with the same ID currently 
exists. The DigiSizers Confirm program does not allow 
duplicate descriptions. You must edit the identification before 
you can save the file.

Close Closes the dialog. If the file contains unsaved changes, you 
are prompted to save before the dialog closes.

Save As Template Allows you to create an adsorptive properties template of the 
current file.
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Report Options

This dialog allows you to specify report options. A report options file can be created as an 
independent parameter file or included as part of the sample information file.

Report options Displays a description of the current Report Options 
template.

Enter a new description or add to the existing one if desired. 
Be sure to use an intuitive name so that it can be easily recog-
nized when needed.

Range: 40 alphanumeric characters

Replace Click this push button to choose a file containing parameters 
you wish to copy and use in the current file.

After the values have been copied into the file, you can edit 
them as desired. It does not affect the values of the file from 
which they were copied.
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Show report title This option allows you to enter a title for your report. 

If this is a new file, the title you specified as the default is 
displayed. Accept the default title or enter a different one.

Deselect this option to omit the report title.

Range: 40 characters

Show graphic Select this option to have a graphic display above the report 
title. The graphic can be in a bitmap (bmp) or an enhanced 
metafile (emf) format. For example, you may wish to display 
your company logo.

Click Browse to choose the graphic, then use the height and 
width fields to specify the size.

The image can also be edited from the report window.

Test Use this drop-down list to specify which test (analysis) you 
wish to have a report generated for.

Reference Displays the Reference Sample dialog so that you can specify 
a sample file with which to compare analysis results of the 
current sample; produces a Difference of Reference report.

• Click Browse to display the Reference Sample File Selec-
tion dialog.

• Choose the file you wish to use for the difference in refer-
ence calculation, then click OK.

• Use Clear to clear the field of its entry.
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Specification Displays the Specification Samples dialog so that you can 
specify the sample files to be used for the boundaries of the 
coarse and fine specifications; produces an Out of 
Specification report. Then you can quickly determine if the 
results of the current sample are within the specified 
boundaries.

• Click Browse to the right of each field to display the Spec-
ification Sample File dialog containing a list of sample 
files from which to choose.

• Choose a file, then click OK.

• Use Clear to clear the field of its entry.

Overlays Displays the Graph Overlay Samples dialog so that you can 
choose the sample files containing the data you wish to 
overlay onto a selected plot.

Click Browse to the right of the sample number field; choose 
the desired file, then OK. 

You can select up to eight files. Refer to Generating 
Overlays, page 3-48 for step-by-step instructions on 
generating overlays.
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Peaks Displays the Peak Detection Settings dialog, allowing you to 
choose how peaks are detected.

Auto Select this option to have peaks detected automatically. 
When you select this option, the Minimum distribution to 
report and Minimum valley depth to separate peaks fields 
are enabled, allowing you to specify a threshold for the peak 
size.

The valley depth option enables you to specify a threshold 
for resolving multiple peaks. Valley depth is calculated as:

where a = the smaller peak
b = lowest point between the two peaks

If the depth is greater than the value you enter as the 
minimum, the two peaks are treated as separate; otherwise, 
they are treated as one peak.

a b–
a

------------ 100%

a b
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Manual This option enables you to define the peaks by Diameter or 
Volume. Use the table to enter the minimum and maximum 
values for each peak to be detected.

Reports to Generate Contains a list of available reports. 

Select reports by double-clicking on the desired report(s). 
Alternatively, you can highlight the desired report and press 
the Spacebar. A report is selected when it is preceded with a 
check mark ().  

Reports are deselected in the same manner. Most reports can 
be edited by highlighting the desired report and clicking Edit. 

You can also generate Statistical Process Control (SPC) 
reports using the options on the Reports menu.

Edit Allows you to edit parameters of the selected report.

This push button is disabled for the following reports; they 
cannot be edited:

• Rosin Rammler
• Log Probability
• Sample Log

Save Displays the Save As Report Options File dialog.

After you enter a description, the Save push button becomes 
enabled allowing you to complete the save operation. If Save 
does not become enabled, a file with the same ID currently 
exists. The DigiSizer Confirm program does not allow 
duplicate descriptions. You must edit the identification before 
you can save the file.

Close Closes the dialog. If the file contains unsaved changes, you 
are prompted to save before the dialog closes.

Save As Template Allows you to create a report options template of the current 
file.
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Combined Report

Select the Combined Report to edit; the Combined Report Options dialog is displayed.

The list of reports for the Combined Report is almost identical (the Combined report, of 
course, is not included in this list) to the list of reports generated in the normal manner. The 
difference is that the reports generated from the selections on this dialog contain no page 
breaks or headings. And, unless too many are selected, all reports display on one page.
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Tabular Reports

Select a table to edit; a dialog similar to this one is displayed.

The Standard Class Size Table and the Standard Sieve Table are fixed and, therefore, do not 
contain a table nor push buttons. 

• The Standard Class Size Table is fixed based on 40 classes per decade (refer to Appendix F, 
page F-1 for data reduction information). 

• The Standard Sieve Table is fixed based on the sieves you specify (refer to page Sieve 
Table, page 7-6).

Table Enter the values at which you wish the data to be reported (or 
accept the defaults).

A table is not included on the dialogs for the Standard Class 
Size Table and the Standard Sieve Table.

Insert Inserts a point above the selected point.

Use Ctrl   to add points at the beginning of the table and 
Ctrl  to add points at the end of the table.

This push button is not included on the dialogs for the 
Standard Class Size Table and the Standard Sieve Table.

The title bar displays 
the name of the table 
being edited.

These components do 
not display if you are 
editing the Standard 
Class Size Table or the 
Standard Sieve Table.
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Delete Deletes the selected point.

This push button is not included on the dialogs for the 
Standard Class Size Table and the Standard Sieve Table.

Clear Clears all but the one required point from the table.

This push button is not included on the dialogs for the 
Standard Class Size Table and the Standard Sieve Table.

Column [n] Use the options from the drop-down lists to choose the type 
of data you wish to display in report columns.

Order of Sizes Choose whether you wish to have points collected in an 
ascending or descending order.

Truncate table at 
distribution limits

Select this option to have the table shortened to the limits of 
the distribution.
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Graphical Reports

There are 10 generic graphs included in the analysis software. These graphs can be tailored in 
many configurations using the graph options dialog displayed when you click Edit.

Data Plot
Difference from Reference
Out of Specification

From this group, choose the type of plot desired.

If you select Difference from Reference or Out of 
Specification, be sure to click the related push button on the 
Report Options dialog to choose the file(s).

Points
Curve
Histogram
Curve and Points

Enables you to choose the manner in which to have data 
plotted. 

X-Variable Enables you to choose the x-axis variable.

Y-Variable Enables you to choose the y-axis variable and the manner in 
which it is to be plotted; make a selection from each column.

The title bar displays 
the name of the graph 
being edited.
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Overlay Click on the down arrow to display the types of overlays 
available.

Samples Overlays the current curve with the same type of curve from 
multiple sample files. Click Overlays on the Report Options 
dialog to choose the sample file(s) containing the desired 
curves.

Tests Overlays the same type of curve from all tests performed 
with this file.

Plot Overlays a different variable with the selected variable (the 
one you are currently editing). Use the Edit button to specify 
details.

Edit Enabled when you choose Plot as the type of overlay 
allowing you to choose the overlay variable and specify 
details for the variable; the Overlay Settings dialog is 
displayed.

X Axis
Y Axis

Allows you to choose between a Linear or Logarithmic scale 
as well as autoscale options.
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Background Graph

Select Background to edit; the Background Options dialog is displayed.

Autoscale Select this option to have the X- and/or Y-axis scaled 
automatically. Both axes begin at zero; the highest values 
collected during analysis are the ending points. 

If you deselect this option, the adjacent fields become 
enabled so that you may specify a range. Valid ranges are 
displayed in the information bar when the field is selected.

No Overlays  Reports the background of this sample analysis only.

Overlay Samples Enables you to overlay the background of this sample 
analysis with the background(s) of other analyses. Click 
Overlays on the Report Options dialog to choose the sample 
file(s).

Overlay Current 
Background

Enables you to overlay the background of this sample 
analysis with the current stored background of the analyzer.
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Goodness of Fit Graph

Select Goodness of Fit Graph to edit; the Goodness of Fit Options dialog is displayed.

The options on this dialog allow you to specify the X-axis variable as well as the type of 
overlay.

Rosin Rammler

The Rosin Rammler report depicts the collected data as applied to the Rosin Rammler1 
theory; this report cannot be edited.

Overlay Model Fit Overlays the collected intensity data of this sample with the 
model fit.

Overlay Tests Enables you to overlay the collected intensity data for all 
analyses (tests) used with this sample file.

Overlay Samples Enables you to overlay the collected intensity data of this 
sample with that of another sample (or multiple samples). 
Click Overlays on the Report Options dialog to choose the 
sample file(s).

X-Axis Choose whether you wish to have the X-axis display the 
Scattering Angle or Scattering Vector.

1. Rosin, P. and Rammler, E., J. Inst. Fuel, 7, 20 (1933)
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Log Probability Report

The Log Probability Report provides a comparison of the collected data to that of a log-
normal distribution; this report cannot be edited.

Summary Report

Select the Summary Report to edit; the Summary Report Options dialog is displayed.

The Summary Report provides a condensed listing of analysis statistics and data results.

Statistics 
Type/Distribution

Choose the type of statistics and distribution you wish to 
report.

Arithmetic Statistics Choose the arithmetic statistics you wish to include in the 
report.

Statistics Select the variables you wish to include in the report.

Sample Choose the sample parameters you wish to include in the 
report.
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Analysis Select the analysis parameters you wish to include in the 
report.

Reports Choose the type of distribution(s) you wish to report.

Percentiles Displays the Summary Percentiles dialog.

This dialog allows you to report the particle diameter (or 
radius) corresponding to each specified coarser (or finer) 
percentile. You can enter up to 10 values in any order. If you 
enter zero (0.00), a blank line is shown on the report.

Sizes Displays the Summary Sizes dialog.

This dialog allows you to report the cumulative percent (or 
fraction) coarse (or finer) for each specified diameter 
(volume). You can enter up to 10 values in any order. If you 
enter zero (0.00), a blank line is shown on the report.
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Sample Log Report

The Sample Log report provides the following statistics:

• manual control operations performed during analysis
• information entered using  on the sample file editor
• warnings and/or errors that occurred during analysis

Peaks Displays the Summary Peaks dialog.

This dialog enables you to specify the types of data to 
display in the columns of the peak table. Column 1 is fixed 
and cannot be edited.
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Entered Data

The Entered Data tab displays when you choose Entered as the type of data on the Sample 
Information dialog. This dialog allows you to enter the data manually.

You cannot enter data if the analysis program is being used for offline data 
manipulation on a computer other than the one controlling the analyzer.

Pressure table Allows you to enter data for the size type you choose; 
Particle size or Sieve size.

Insert Inserts a row into the pressure table.

Delete Deletes the selected row.

Clear Clears the table of all rows except one; one is required.

This type of table displays if you 
choose Sieve size for the size type.

These push buttons are disabled for the Sieve table. Sieve sizes are specified by 
selecting Options > Data Presentation > Sieve Table.

Size Type Allows you to choose the type of size data you wish to enter.
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Particle size Allows you to enter the particle diameter and the cumulative 
coarser (or finer) percent for the sample.

Sieve size Allow you to enter the percent passed through each specified 
sieve.

Distribution Type Allows you to choose the type of distribution data you  plan 
to enter. You can choose to report by Volume, Area, or 
Number.
520-42812-01 (Rev G) - Nov 2018 4-37



Open Saturn DigiSizer II 5205 Confirm
Open

Open allows you to open an existing sample or parameter file, or a sample template.

Sample Information File

The following dialog displays for the Analyst and Developer when you select File >Open > 
Sample information.

A sample file can be edited by a Developer or an Analyst. The changes can also be saved. If 
you do choose to save the changes, a dialog prompting for a reason is displayed. After you 
enter a reason in the Comments field, Save is enabled so that you can complete the save oper-
ation. These changes are saved as a version of the sample file, becoming part of the sample file 
history. All versions of the sample file (of the Status selected) can be viewed when you click 
Revert on the Sample file dialog.

Category/Subcategory These drop-down lists contain existing archive locations 
(directories) in which files have been stored. The directory 
labels shown in this example are defaults. Many laboratories 
use the Year/Month system. A Developer can edit these labels 
if desired (refer to Edit Labels, page 7-4).

Status This drop-down list allows you to choose the types of sample 
files to display in the Files window. All files of the type you 
choose, within the range of dates, and in the current directory 
are displayed. Refer to Table 2-2. File Status and 
Description, page 2-16 for a description of file types.
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Analyst

When an Analyst opens a sample information file, the dialog displays in this manner:

If desired, an Analyst can click Advanced to access the Developer’s view of the dialog. This 
view allows him to review the parameters used in the analysis. He/she can edit certain param-
eters of the sample file; the fields for those parameters are enabled. Report options can also be 
edited and reports generated.

Date Range Click this push button to display files created within a 
specified range of dates; the Select Dates dialog is displayed. 
Refer to Selecting Files, page 2-16 for information on this 
dialog.

Files window Lists the file(s) of the type selected in the Status list within 
the selected directory and range of dates.
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Developer

When a Developer opens a sample information file, the dialog displays in this manner:

A Developer can view all parameters of the file, as well as edit certain parameters; those 
parameters are enabled. Report options can also be edited and reports generated. 

A Developer’s view of the dialog includes a Collected Data tab (post-analysis) which allows 
you to view the points collected during analysis. 
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Templates

Sample and Parameter templates can be opened and their contents viewed by a Developer or 
an Analyst. You cannot make changes to an existing template. If you wish to make changes, 
the Developer will have to create a new template. The Analyst is not authorized to create 
templates.

Table Displays the data points collected for the current test. 

Test Displays the current test for this sample file. If you wish to 
view data for another test, click on the down arrow to select 
the desired test. 

This drop-down list contains all tests performed using the 
current sample file.

Delete Test Enables you to delete the test shown in the Test field.

Merge with external data Select this option to merge data collected by manual methods 
with the data collected from the current test. 

External Data Enabled when you select Merge with external data. 
Displays the External Data dialog so that you can enter the 
data you wish to have merged.

This type of table displays if you 
choose Sieve size for the size type.
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Parameter Files

Parameter files (Analysis Conditions, Material Properties, and Report Options) can be opened 
only by a Developer. When you select File > Open > (parameter file), an Open (parameter) 
dialog is displayed. 

Location Allows you to open a parameter File or a Template for a 
parameter file.

You can open a template and view the details but you cannot 
edit the values. If you wish to make changes, you will have to 
create a new template. You can edit and save changes in a 
parameter file.

Date Range Allows you to choose a range of dates in which to display 
files in the Files window. Refer to Selecting Files, page 2-16 
for information on this dialog.

Title bar displays 
the type of file you 
are opening.
4-42                                                    520-42812-01 (Rev G) - Nov 2018



Saturn DigiSizer II 5205 Confirm Save
Save

Save enables you to save any changes you have made to the file in the active window. The file 
is saved under its current name.

Save As

A Developer can use this function to:

• save a sample file in the active window as another sample file with a different name. 
The sample file must have a No Analysis status if you plan to edit parameters. If you 
use the Save As function with a file of a Complete status, you will not be able to edit 
the values of the new file.

When you select this option, this type of dialog is displayed.

Enter a description in the ID field; you can use up to 50 characters. You must also enter 
a comment in the Comment window to enable the Save push button. The new file is 
saved as specified, but does not remain in the active window. Be sure to open the new 
file before making any changes.

An Analyst is not authorized to use the Save As function.
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• save a parameter file in the active window with a different name. The parameter file 
must be of the same type; for example, you can save an Analysis conditions file only as 
another Analysis conditions file.

When you save as a parameter file, this type of dialog is displayed.

Enter a description in the ID field; you can use up to 50 characters. If the Save push 
button does not become enabled, a file with the same description already exists. The 
confirm program disallows duplicate file descriptions. Edit the description to enable the 
Save push button.

• save a subset (parameter) of the sample file in the active window as a standalone 
parameter file. For example, select File > Save As > Analysis Conditions to create a 
standalone parameter file of the analysis conditions portion of the active sample file.

When you save a subset of a sample as a parameter file, the same type of dialog as 
shown above is displayed.
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Save As Template

Save As Template allows the Developer to:

• save the values of the sample file in the active window as a sample template. 

• save a subset (parameter) of the sample file in the active window as a parameter file 
template. 

• save the values of a parameter file in the active window as a parameter file template.

Save All

Save All enables you to save all open files under their current names. This option provides a 
faster way to save all open files at one time and avoids having to perform a Save operation on 
each individual file. 

A dialog prompting for a reason for the current change version of each file is displayed.

Close

Close enables you to close the file in the active window. If the file contains changes that have 
not been saved, the following message is displayed:

(file name) has been changed. Save changes before closing?

               Yes                         No                        Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the file closes.

Click No to close the file without saving the changes.

Click Cancel to return to the active file.
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Close All

Close All enables you to close all open files under their current names. The following message 
displays for every file containing changes that have not been saved:

               (file name) has been changed. 
               Save changes before closing?

               Yes            No            Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the file closes.

Click No to close the file without saving the changes.

Click Cancel to return to the active file.
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Print

Print enables you to print details of a sample file, sample template, or parameter file. For 
example, if you choose to print the contents of an analysis conditions file, you will receive the 
parameters used for all analysis conditions associated with the file.

Sample Information 

Contents of a Sample Information file can be printed by a Developer or an Analyst; the Print 
Sample Information dialog is displayed.

Category/Subcategory These drop-down lists contain the existing directories in 
which files are stored. 

Status This drop-down list allows you to choose the types of sample 
files to display in the Files window. (Refer to Table 2-2. File 
Status and Description, page 2-16 for a description of the 
status types.) All files of the type you choose, within the 
range of dates, and in the current directory are displayed. 

Date Range Allows you to specify a range of dates for the files you wish 
to display in the Files list window, or you can choose All for 
all files to display. The range you choose is displayed below 
the push button. (Refer to page Selecting Files, page 2-15 for 
information on this push button.)

Does not display 
for an Analyst.
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Sample Template

Contents of a Sample Template can be printed by a Developer or an Analyst; the Print Sample 
Template dialog is displayed.

Refer to the previous page for an explanation of the fields on this dialog.

Preview
Print
Export

Choose Preview to view the file on the computer screen; you 
can then print the file from the preview window.

Choose Print to send the file directly to the printer; you can 
print up to four copies. 

Choose Export to print to a file; use the field below the 
Export option to enter a name. The Export option is not 
available for an Analyst.

Files window Displays the file(s) of the type selected in the Status list 
within the selected directory and range of dates.

You may print the contents of multiple files by holding down 
Ctrl while selecting files.

Does not display 
for an Analyst.
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Parameter Files and Parameter Templates

The contents of a parameter file can be printed only by a Developer. The contents of 
parameter file templates can be printed by a Developer or an Analyst. This type of dialog 
displays for a Developer. A Developer simply selects File or Template.

Refer to page 4-47 for an explanation of the fields on this dialog.

An Analyst can print the contents of parameter file templates (not parameter files) by 
selecting File > Print > (parameter file). In this example, Analysis Conditions is selected 
as the parameter; the Print Analysis Conditions Template dialog is displayed.    

Select File for parameter 
files or Template for 
parameter templates.
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List

List enables you to generate a listing of the following information on a selected sample file, 
parameter file, or a sample template.

• File name
• Date the file was created (or edited)
• Time the file was created (or edited)
• File identification
• File status

The List dialog is common to all file types. The title bar displays the type of file for which 
you have requested statistics.

Permissions for listing statistics are the same as for the printing file contents. For example, an 
Analyst can list statistics for parameter file templates, but not for parameter files.

The behavior of the List dialog is the same as the Print dialog; refer to Print, page 4-47 for an 
explanation of the fields on this dialog.

You may request a list of multiple files by holding down Ctrl while selecting files. If no files 
are selected, a list is generated for all files.

Does not display 
for an Analyst.
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Import

The Developer can use this option to import files that have been created external to the Con-
firm software and copied into the Import directory. If the files are not copied into the Import 
directory, they will not display in the Files window. Use Windows Explorer to copy the files 
into the Import directory.

An Analyst is not authorized to import sample or parameter files.

Category
Subcategory

Use these drop-down lists to choose the directory into which 
you wish to import the file. Refer to Edit Labels, page 7-4 
for information on creating directories.

These drop-down lists do not display when importing 
parameter files. Parameter files are imported into an assigned 
directory.

Status
Date Range

Use these two options to limit the files displayed in the Files 
window. The Status drop-down list does not display when 
importing parameter files.

Refer to Selecting Files, page 2-15 if you need assistance on 
the Status types and the Date Range push button.
520-42812-01 (Rev G) - Nov 2018 4-51



Export Saturn DigiSizer II 5205 Confirm
Export

A Developer can use the Export option to:

• export the entire sample file. For example, you may wish to use this option to transfer a 
sample file to another computer.

• copy the particle distribution data (Particle size option) in a sample information file and 
export it as ASCII text.

• copy the intensity and background data (Intensity option), and export it as ASCII text.

All files are exported to the Export directory. Make a note of the automatically generated file 
number (shown in the dialog below) for retrieval.

When exported as ASCII text, the particle size and intensity data can be imported into other 
applications (such as spreadsheets) accepting ASCII format. The data are exported in a 
comma-delimited format. Refer to Appendix G, page G-1 for the exporting format. 

You may select multiple files by holding down Ctrl and clicking the left mouse button once on 
each file.

All fields on this dialog function in the same manner as other dialogs, such as the Import and 
Print dialogs. Refer to the Print, page 4-47 if you need information on these fields.

An Analyst is not authorized to export sample files.
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Log In

Log in enables you to log into the application; the User Logon dialog is displayed.

Simply enter your user name and password, then click OK. 

Log Out

Select this option to log out of the system. If files are open and contain changes that have not 
been saved, you are prompted to save or discard them before log out is completed. 

User name Typically in this field, you should enter your Windows User 
name, unless your Administrator has specified a different 
user name.

Password Enter your password. If you enter your password incorrectly 
a specified number of times (your Administrator determines 
the number when setting up system options; the default is 
three), the application will lock and you will not be allowed 
to proceed. Contact the Administrator to unlock the 
application and assign a new password.

The first time you log into the application after the Confirm 
software is installed, you will be prompted to change your 
password to one of personal preference.  You must enter at 
least six characters.

Change password Select this option to change your password after you have 
logged in; the Set password dialog allowing you to change 
your password is displayed.
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Exit

Exit enables you to exit the Saturn DigiSizer analysis program. Even if an analysis is in prog-
ress, it will continue until completion; analysis data are collected and stored in the analyzer’s 
memory.

• If a window containing a modified file is open, you are given the opportunity to save the 
modifications before exiting.

• If deconvolution (calculations) is in progress, the following message is displayed:

You cannot exit the DigiSizer program while a critical operation is in progress. Click 
OK to close the dialog, wait a few minutes, and try again.

• If an analysis is in progress, the following message is displayed:

Yes exits the analysis program
No allows the analysis program to remain active and the analysis to finish.

• If a report window is open, the following message is displayed.

Yes closes the report window and the analysis program.
No leaves the analysis program active and the report window open.

2458- An analyzer is performing a critical operation. Wait a few 
moments before exiting the application.

OK

2459- An analyzer is busy. A delay in restarting this application 
could result in loss of new data. continue with program exit?

Yes                               No

Although data are stored in the analyzer when you exit the program during analysis, 
they are not saved in the file until the program is restarted. At that time the data are 
saved automatically. If a power failure occurs in the interim and you do not have an 
Uninterruptible Power Supply (UPS) installed, loss of data will result.

If the MasterTech is being used, the current analysis continues until it is finished; 
subsequent analyses are postponed and resumed when the analysis program is 
restarted.

A report is currently printing. Exiting the application now 
will cancel the report. Continue with termination?

Yes                  No
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5.  UNIT MENU

The Unit menu contains the options for the operations which can be performed with the Saturn 
DigiSizer. The main menu will contain a Unit menu for each attached analyzer. For example, if 
you have two attached analyzers, the main menu contains two Unit menus. For convenience 
and quick recognition, the status displays associated with each unit are displayed in different 
colors. The unit number and the serial number also are displayed in the title bar of the opera-
tional windows. This feature is especially helpful when you have more than one analyzer 
attached to the same computer.

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are found 
later in this chapter.

This menu does not appear on the menu bar if the analysis program is being used for 
offline data manipulation.

Sample Analysis Use this mode of operation to perform single sample 
analyses. This option is disabled if analyses are being 
performed in another mode. Page 5-4.
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QuickStart Analysis Use this mode of operation to perform successive sample 
analyses. Page 5-10.

MasterTech Automatic Use this mode of operation to analyze a series of samples of 
the same type with the same analysis conditions. Sample files 
are created automatically. Enabled only if a MasterTech is 
installed. Page 5-15.

MasterTech Schedule Use this mode of operation to analyze a series of samples 
which may be different in size and shape and, consequently, 
require different analysis conditions. Enabled only if a 
MasterTech is installed. Page 5-10.

Background Allows you to perform a background measurement.
 Page 5-22.

Load from MasterTech Allows you to load a sample from the MasterTech into the 
analyzer. Page 5-25.

Rinse Allows you to perform a rinse operation on the DigiSizer, 
MasterTech, or the MasterTech and the DigiSizer. Page 5-26.

Drain Allows you to drain liquid from the Saturn DigiSizer system. 
Page 5-31.

Initialize MasterTech Allows you to start the MasterTech or realign the MasterTech 
turntable. Page 5-31.

Enable Manual Control Allows you to control the system manually. Page 5-32.

Show Instrument 
Schematic

Displays a schematic of the analyzer. Page 5-40.

Show Results Allows you to have results displayed as data are collected 
when performing multiple analyses. Page 5-41.

Show Status Displays the status window of the operation in progress. 
Page 5-41.
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Show Instrument Log Displays a log of recent analyses, calibrations, and error 
messages. Page 5-42.

Unit Configuration Displays the configuration of the analyzer. Page 5-44.

Calibration Enables you to perform calibration functions. This option is 
enabled only with the direction of a Micromeritics service 
representative. Page 5-46.

Service Test Enables you to perform certain troubleshooting procedures. 
This option is enabled only with the direction of a 
Micromeritics service representative. Page 5-46.
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Sample Analysis

Use this mode of operation to perform up to eight tests (analyses) on a single sample. When 
you select this option from the Unit menu, the Sample Analysis dialog is displayed with all 
fields disabled (greyed out). You must use the New push button to create a new file or the 
Browse push button to select an existing one. You can choose a Complete file if all tests have 
not been run; up to eight tests can be performed using a single file.

After a sample file has been designated, the Sample Analysis dialog is displayed. The fields 
now contain the values for the selected file or, if creating a new file, the defaults from the tem-
plate. 

View Allows you to view one of the following in the current 
window:

• the current operation 

• the instrument schematic (refer to Show Instrument Sche-
matic, page 5-40 for additional information)

• the instrument log (refer to Show Instrument Log, page 
5-42 for additional information)

Browse Displays the Open File for Analysis dialog allowing you to 
select a different sample file for your analysis.
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New Displays the Create a File for Analysis dialog allowing you to 
choose a sample template to create a file for the current 
analysis.

Sample Contains the description of the current sample file.

If this is a new file, this field contains description of the 
sample template. Edit the description as desired.

You can enter a new description or add to the existing one if 
desired.

Range: 50 alphanumeric characters

Analysis Conditions Contains the name of the Analysis Conditions file for the 
current sample file. 

The drop-down list contains a list of predefined parameter 
files. Click on the down arrow to choose a different file. 

Autodilute Allows monitoring of the sample’s concentration and adds 
liquid as needed until the appropriate concentration is 
attained before analysis and data collection begin.

Number of tests Enter the number of analyses you wish to perform using this 
sample file; you can perform up to eight tests with each file.

Rinse after analysis Allows rinsing of the cell, the tubing, and the reservoir after 
each analysis. We recommend this option remain selected. If 
you deselect this option and rinses are not performed after 
analysis, inaccurate results may be obtained on subsequent 
analyses.

Material Properties Contains the name of the Material Properties file for the 
current sample file. 

The drop-down list contains a list of predefined parameter 
files. Click on the down arrow to choose a different file.
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Report Options Contains the name of the Report Options file for the current 
sample file.

The drop-down list contains a list of predefined parameter 
files. Click on the down arrow to choose a different file.

Selected Reports Displays a list of available reports. To select a report: 
Double-click on the desired report, or highlight the report and 
press the Spacebar. Selected reports are preceded with a 
check mark (). Reports are deselected in the same manner.

Report after analysis Displays the Report Settings dialog so that you can specify 
report output requirements.

Select the option presented on this dialog to have reports 
generated automatically after each analysis. 

Report after analysis Select this option to have reports generated automatically 
after analysis, then choose a destination.

Preview Prints the report to the monitor screen. This option allows 
you to customize reports with details such as font and column 
placement. Refer to Onscreen Reports, page 6-20 for the 
options available for onscreen reports.

Print Prints the report to the printer.

Copies Enabled when you choose Print as the destination for 
reports, allowing you to generate up to four copies.

Not available for
an Analyst.
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After verification of the user, this view of the Sample Analysis dialog is displayed.

This view of the window shows beam obscuration of the sample as it is being loaded. Add 
only enough sample to achieve the proper range for your material; use the following 
guidelines:

Export Exports report data to a file; files are exported as their 
assigned name. This option is unavailable for an Analyst.

Next Click this push button to advance to the next view of the 
Analysis dialog; a log in dialog is displayed.

This dialog is used to verify that the logged-in user is  
performing the analysis. Select the Log out after start option 
to have the system log you out automatically after the 
analysis starts. For example, you may wish to use this option 
if you plan to start the analysis at the end of your workshift.
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These push buttons are also used to adjust the beam obscuration to the appropriate range for 
your sample as it is being added to the reservoir:

• If the beam obscuration is too high (indicating high concentration), use Adjust level to 
full or Adjust level to primed to add liquid. Do not try to adjust a high obscuration if 
you have chosen Autodilute. The Saturn DigiSizer system will adjust the concentration 
automatically until the correct beam obscuration is achieved.

• If the beam obscuration is too low (indicating low concentration), continue to add 
sample. If the reservoir is too full, you can use any of these push buttons to adjust the 
liquid level to allow room for added sample.

Refer to Appendix B, page B-1 for additional information on sample dispersion and sample 
concentration.

When the concentration is in the recommended range, click Next to begin data collection. A 
status view of the Sample Analysis window is then displayed.

This view of the window displays:

• the identification of the sample file
• an estimated time remaining on the analysis
• the current test number
• the current beam angle

Sample Type
(micrometers) Beam Obscuration

Less than 0.1 4%

0.1 to 1 5% to 10%

1 to 10 10% to 20% 

10 to 100 20% to 30%

100 to 1000 30% to 45%

Adjust level to full Allows you to fill the reservoir with analysis liquid. 

Adjust level to primed Allows you to add enough analysis liquid to reach a primed 
state.

Adjust level to empty Empties the reservoir of analysis liquid.
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A more specific status of the sample is shown in the status area at the bottom of the window. 
After each test requested of the sample file is complete, data reduction for the test begins; 
simultaneously, the next test begins. 

The results window contains two panes. Each pane has a drop-down list (positioned just above 
the pane) containing the report options specified in the sample file.

In these panes, you can:

• Show results 
Select a report from the drop-down list to display its results in the pane. Scroll bars are 
provided in panes where tables are displayed so that you can scroll through the data.

• Resize the pane
Point to the center vertical border (separating the panes); when the cursor turns into a 
four-way arrow, drag the border in the direction desired.

• Edit tables and graphs
Right-click in the graph (or table) to display a list of editing options. Refer to Shortcut 
Menus, page 6-23 for additional information.

Cancel Click to cancel the current analysis; a confirmation dialog is 
displayed. If you choose to proceed with the cancellation, 
the Cancel Analysis dialog prompting for a reason for the 
cancellation is displayed. After you enter a reason and click 
OK, the analysis is cancelled.

Next Click this push button to advance to the next view of the 
Analysis dialog; this view contains the results of the current 
test.
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QuickStart

Use this mode of operation to analyze a series of samples of the same type which contain the 
same analysis conditions. You can request to have sample files created automatically or you 
can choose a sample file for each sample. When you select this option from the Unit menu, the 
QuickStart dialog is displayed.

View Allows you to view one of the following in the current 
window:

• the current operation 
• the instrument schematic
• the instrument log
• Results

New Displays the Create a File for Analysis dialog allowing you to 
choose a sample template to create a file for the analysis on 
the selected port.

Sample Contains the identification of the current file; the $ symbol is 
appended automatically allowing a numerical sequence of the 
generated files.

Set liquid level between 
analyses

Allows you to adjust the liquid level in the reservoir before 
the sample is loaded. 

Choices: Adjust to full level, Adjust to primed level, 
Adjust to empty level, Adjust to full level
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Adjust to full level Fills the reservoir with the dispersing liquid. Choose this 
level for undispersed, powdered samples; if a maximum 
amount of liquid is desired; or if bubble problems are 
anticipated.

Adjust to primed level Fills the reservoir with just enough dispersant to enable 
circulation. Choose this level for highly concentrated 
samples.

Adjust to empty level Empties the reservoir of all dispersant, allowing you to pour a 
previously dispersed sample into the reservoir. Choose this 
level for samples already at the proper concentration.

Report after analysis Select this option to have a report(s) generated automatically 
after each analysis

Preview Prints the report to the monitor screen. This option allows 
you to customize reports with details such as font and column 
placement. Refer to Onscreen Reports, page 6-20 for the 
options available for onscreen reports.

Print Prints the report to a selected printer.

Copies Enabled when you choose Print as the destination for 
reports, allowing you to generate up to four copies.

Export Exports report data to a file; files are exported as their 
assigned name. This option is unavailable for an Analyst.

Prompt for files for each 
new sample

The analyzer pauses before each analysis so that you can 
choose a sample file.

Autodetect each 
new sample

New files are created sequentially and automatically for each 
analysis.

If you use this method, be sure that Rinse after analysis is 
selected in the analysis conditions. Otherwise, the previous 
sample will not be rinsed from the reservoir; however, the 
system will detect its presence and analyze it repeatedly.
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• If you choose Prompt for files for each new sample, this view of the QuickStart dialog 
is displayed before each analysis. 

Next Click this push button to advance to the next view of the 
Analysis dialog; a logon dialog is displayed.

This dialog is used to verify that the logged-in user is actually 
performing the analysis. Select the Logout after start option 
to have the system log you out automatically after the 
analysis starts. For example, you may wish to use this option 
if you plan to start the analysis at the end of your workshift.

Click OK;  a window indicating Adjusting liquid level is 
displayed. You can suspend or skip this procedure by 
selecting the respective push button. 

After the liquid has been adjusted, one of two screens is 
displayed (depending on which file management method you 
choose):

Browse Displays a dialog so that you may select the sample file you 
wish to use with this analysis. If you do not choose a different 
file, the values specified in the template you chose on the first 
screen will be used.

Sample ID Displays the description of the file you choose for the 
analysis. You can edit the description if desired.
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After all selections have been made, begin adding your sample to the reservoir. Observe 
the beam obscuration as the sample is being added. When the concentration is in the 
recommended range for the type of sample you are analyzing (refer to the following 
guidelines), click Next to begin data collection. 

The beam obscuration range can also be manually entered using the Maximum and 
Minimum fields on the Analysis conditions dialog.

After all analyses have finished, select Cancel to close the dialog.

Background Enables you to perform a background before proceeding with 
analysis. The background is performed using the analysis 
liquid and the flow rate specified in the sample defaults. 
When the background has finished, a report is generated (if 
selected on previous screen) and the current window is again 
displayed.

Adjust level to full
Adjust level to primed
Adjust level to empty

These push buttons allow you to adjust the beam obscuration 
to the appropriate range for your sample as it is being added 
to the reservoir:

• If the beam obscuration is too high (indicating high con-
centration), use Adjust level to full or Adjust level to 

primed to add liquid. Do not try to adjust a high obscura-
tion if you have chosen Autodilute. The Saturn DigiSizer 
system will adjust the concentration automatically until the 
correct beam obscuration is achieved.

• If the beam obscuration is too low (indicating low concen-
tration), continue to add sample. If the reservoir is too full, 
you can use any of these push buttons to adjust the liquid 
level to allow room for added sample.

Sample Type
(micrometers) Beam Obscuration

Less than 0.1 4%

0.1 to 1 5% to 10%

1 to 10 10% to 20% 

10 to 100 20% to 30%

100 to 1000 30% to 45%
520-42812-01 (Rev G) - Nov 2018                                                  5-13 



QuickStart Saturn DigiSizer II 5205 Confirm
• If you choose Autodetect each new sample, this view of the QuickStart dialog is 
displayed:

After you add your sample to the reservoir, its presence is detected and the remainder of 
the analysis proceeds automatically. The obscuration must exceed the minimum recom-
mended obscuration on the Analysis conditions window for the analysis to start 
automatically. If you wish to use a lower obscuration, load the sample and click Skip to 
start the analysis. After the current sample is analyzed, this window is again displayed 
prompting you to add the next sample.

A Background push button is also provided on this dialog, allowing you to perform a 
background measurement between analyses. 

After all analyses have finished, click Cancel to close the dialog.

A status view of the Sample Analysis window is then displayed. This view of the window 
displays:

• the identification of the sample file
• an estimated time remaining on the analysis
• the current test number
• the location of the beam angle

A more specific status of the sample is shown in the status area at the bottom of the window. 
After each test requested of this sample file is complete, data reduction for the test begins; 
simultaneously, the next test begins. After all tests and rinses (if requested) are finished, the 
previous window is displayed.

Use these push buttons 
to adjust the sample 
concentration.
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MasterTech Automatic

Use this mode of operation to analyze a series of samples of the same type which contains the 
same analysis conditions; sample files are created automatically. When you select this option 
from the Unit menu, the MasterTech Automatic Mode dialog is displayed.

This option is functional only if you have a MasterTech connected to your analyzer.

Sample Contains the identification of the file you choose; the $ 
symbol is appended automatically allowing a numerical 
sequence of the generated files. A # (number) symbol 
representing the beaker is also appended.

New Displays the Create a File for Analysis dialog allowing you to 
choose a sample template to create a file for the analysis.

Start with beaker Enter the position number of the beaker containing the first 
sample to be analyzed. 

This field is disabled if an analysis is in progress.
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Sample resuspension This group box is used to enter resuspension parameters. 

Samples tend to settle in the beaker while waiting for 
analysis, especially if samples are prepared ahead of time, as 
in most cases when using a MasterTech. The options in this 
group box allow you to program the MasterTech stirrer and 
probe to redisperse the sample before analysis.

All fields in this group box are disabled if an analysis is in 
progress.

Stirrer time Enter the number of seconds you wish to have the stirrer 
operate during resuspension.

Stirrer speed Choose the stirrer speed. 

Coarse materials and less-stable dispersions may require 
more high-speed stirring time than finer materials.

Probe time Enter how long to have the ultrasonic probe operate during 
resuspension.

Report Settings This group box is used to designate report output.

These options are disabled if analyses are in progress.

Preview Prints the report to the monitor screen. This option allows 
you to customize reports with details such as font and column 
placement. Refer to Onscreen Reports, page 6-20 for the 
options available for onscreen reports.

Print Prints the report to a selected printer.

Copies Enabled when you choose Print as the destination for 
reports, allowing you to generate up to four copies. 

Export Displays for a Developer only, allowing export of report data 
to a file; files are exported as their assigned name.
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This window contains separate status windows for the DigiSizer and the MasterTech. Each 
status window contains its own Skip and Suspend push buttons allowing you to perform 
either or both of these actions on the DigiSizer, the MasterTech, or both. Also displayed just 
above the status window for the analyzer is the progress of the analysis.

Start The User Logon Dialog is displayed. This dialog is to assure 
that the current logged-in user is the one performing the 
analysis. After you enter your password and click OK, the 
analysis begins.

This push button changes to Stop after analysis begins which 
(if clicked) will stop the analysis.

Cancel Displays a dialog allowing you to choose which operation(s) 
you wish to cancel. Disabled options indicate that an 
operation of that type is not in progress and, therefore, cannot 
be canceled.

Cancel the MasterTech 
preparation

Cancels the  sample currently being prepared by the 
MasterTech as well as all subsequent samples. It does not 
cancel any analysis that may be in progress.

Cancel the MasterTech 
load operation

Cancels the loading of the next sample as well as all 
subsequent samples. It does not cancel any analysis that may 
be in progress.

Cancel the analysis Cancels the current analysis only; you may continue with 
other analyses if desired.

Close Displays a dialog allowing you to choose which operation(s) 
you wish to cancel. Disabled options indicate that an 
operation of that type is not in progress and, therefore, cannot 
be canceled.
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MasterTech Schedule

Use this mode of operation to: 

• Analyze a series of samples which may be different in size and shape and, consequently, 
require different analysis conditions

• Analyze samples and measure a background alternately

When you select this option from the Unit menu, the MasterTech Schedule is displayed.

This option is functional only if you have a MasterTech connected to your analyzer.

Insert Displays the MasterTech Schedule Insert dialog so that you 
can select the sample files you wish to use for scheduled 
analyses.
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Insert

(continued)

If you have a sample file selected in the Sample File window, 
the new file is inserted before the selected file; otherwise it is 
inserted at the end of the list.

Background 
measurement

Inserts a background measurement.

Select the liquid you wish to use from the Liquid drop-down 
list. Then enter a value in the Flow rate field; typically, 6 is 
sufficient.

Sample analysis Allows you to schedule a sample analysis.

Beaker number
Enter the beaker number containing the sample.

Sample
Displays the description of the selected sample file. Click 
Browse to choose the sample file or New to create a new 
one.

Stirrer
Enter the number of seconds to have the stirrer operate during 
resuspension.

Stirrer speed 
Choose the stirrer speed.

Coarse materials and less-stable dispersions may require 
more high-speed stirring time than finer materials.

Probe time
Enter how long you wish to have the ultrasonic probe operate 
during resuspension. 
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Edit Displays the MasterTech Schedule Edit dialog so that you can 
edit the sample file or dispersion conditions. 

This dialog is identical to the MasterTech Schedule Insert 
dialog explained on the previous page. 

Delete Removes the selected item from the list. This push button is 
disabled if nothing is selected.

Clear Removes all of the files listed in the window. The files do not 
have to be selected.

Report settings Displays the Report Settings dialog so that you can specify 
report output.

Select the option presented on this dialog to have reports 
generated automatically after each analysis. 

Report after analysis Select this option to have reports generated automatically 
after analysis, then choose a destination.

Preview Prints the report to the monitor screen. This option allows 
you to customize reports with details such as font and column 
placement. Refer to Onscreen Reports, page 6-20 for the 
options available for onscreen reports.

Print Prints the report to a selected printer.

Copies Enabled when you choose Print as the destination for 
reports, allowing you to generate up to four copies.

Not available for
an Analyst.
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This window contains separate status windows for the DigiSizer and the MasterTech. Each 
window contains its own Skip and Suspend push buttons allowing you to perform either or 
both of these actions on the DigiSizer, the MasterTech, or both. Also displayed just above the 
status window for the analyzer is the progress of the analysis.

Export Exports report data to a file; files are exported as their 
assigned name. This option is unavailable for an Analyst.

Cancel Displays a dialog allowing you to choose which operation(s) 
you wish to cancel. Disabled options indicate that an 
operation of that type is not in progress and, therefore, cannot 
be canceled.

Cancel the MasterTech 
preparation

Cancels the  sample currently being prepared by the 
MasterTech as well as all subsequent samples. It does not 
cancel any analysis that may be in progress.

Cancel the MasterTech 
load operation

Cancels the loading of the next sample as well as all 
subsequent samples. It does not cancel any analysis that may 
be in progress.

Cancel the analysis Cancels the current analysis only; you may continue with 
other analyses if desired.

Close Closes the dialog. This push button is disabled if an 
automatic operation is in progress. 
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Background

Before you can perform an analysis, you must have a background measurement for data col-
lection. It is not necessary to measure a background for each analysis. Micromeritics 
recommends that you perform a background measurement at the change of each shift or if you 
change dispersing agents. You may perform up to eight measurements; however, you can save 
and use only the last one. Refer to Appendix H, page H-1 for a discussion and illustrations on 
background quality.

When you select Unit [n] > Background, the Background Measurement dialog is displayed. 

Current background data Displays the following information for the last background 
measured for this unit:

• the analysis liquid and its refractive index
• the date and time of the last background

Analysis liquid Displays a list of analysis liquids. Select the liquid you wish 
to use for the measurement; its properties are displayed 
automatically in the fields to the right of the list. You can also 
add new liquids to the list using the Add push button 
(described below).

Description Displays the name of the selected analysis liquid. This field is 
also used to add new liquids to the list.

Refractive Index
Viscosity
Density

Display the properties of the selected analysis liquid. These 
fields are also used to enter properties of an analysis liquid 
that you wish to add to the list.
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Select Next on this dialog to display the next window for the Background Measurement. This 
view allows you to enter the flow rate for the measurement and specify report output options.

Add Adds a new analysis liquid to the list. 

Enter the name of the liquid you wish to add in the 
Description field, its properties in the Refractive Index, 
Viscosity, and Density fields; then click Add. 

Delete Deletes the selected analysis liquid from the list.

Analysis Liquid Displays the liquid being used for the background 
measurement.

Set flow rate Select to enter the flow rate; typically, 6 liters per minute is 
sufficient.

Flow rate Enter the desired flow rate; disabled if Set flow rate is not 
selected.

Report after measurement Select to have a report generated automatically after each 
measurement.

Preview Prints the report to the monitor screen. This option allows 
you to customize reports with details such as font and column 
placement. Refer to Onscreen Reports, page 6-20 for the 
options available for onscreen reports.
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Click Next to begin the background measurement; a status view of the Background Measure-
ment window is then displayed. This view of the window displays:

• the analysis liquid being used for the background measurement
• an estimated time remaining on the measurement
• the current beam angle

The status window at the bottom of the dialog shows a more specific status. After the back-
ground measurement is finished, the completed background measurement is displayed.

Print Prints the report to a selected printer.

Copies Enabled when you choose Print as the destination for 
reports, allowing you to generate up to four copies.

Export Exports report data to a file; files are exported as their 
assigned name. This option is unavailable for an Analyst.

Repeat Select to perform another measurement. This push button 
becomes disabled after eight measurements. Refer to 
Appendix H, page H-1 for information on determining a 
suitable background.

Done Saves the last measured background and closes the dialog.
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Load from MasterTech

This option allows you to manually redisperse a sample then transfer it to the DigiSizer for 
analysis; the MasterTech Load dialog is displayed.

This option is functional only if you have a MasterTech connected to your analyzer.

Beaker number Enter the position number of the beaker containing the 
sample you wish to load.

Range: 1 to 18

Stirrer time Enter the number of seconds to have the stirrer operate during 
resuspension.

Stirrer speed Choose the stirrer speed. 

Coarse materials and less-stable dispersions may require 
more high-speed stirring time than finer materials.

Probe time Enter how long you wish to have the ultrasonic probe operate 
during resuspension. 

Coarse materials and less-stable dispersions may require 
more stirring time than finer materials.

Start Begins the load operation; a message is displayed indicating 
a load operation is in progress. After the sample has been 
loaded, the dialog closes.

Cancel Cancels the load operation and closes the dialog.
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Rinse

A rinse operation should be performed to rinse away any contaminants from the analysis cell, 
reservoir, and tubing which may have remained from a previous analysis.

When you select Unit [n] > Rinse, three choices are available:

• DigiSizer - rinses the analysis cell, reservoir, and tubing of the DigiSizer.

• MasterTech - rinses the MasterTech tubing. Disabled if a MasterTech is not connected 
to the DigiSizer.

• MasterTech Then DigiSizer - rinses the MasterTech tubing, then the analysis cell, 
reservoir, and tubing of the DigiSizer. Disabled if a MasterTech is not connected to the 
DigiSizer.

DigiSizer

This option is disabled if analyses are in progress.

Rinse Cycles Select Autorinse to have the system determine how many 
rinses to perform in order to reach a beam obscuration of 0.1 
or less. 

If your analysis and rinse liquids are the same, rinsing 
stops when:

• No significant decrease in beam obscuration is attained 
twice in a row, displaying an error message.

• The system has performed 10 rinses and was unable to 
attain 0.1 or less; an error message is displayed.
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Rinse Cycles

(continued)

If your analysis and rinse liquids are different, rinsing 
stops when:

• Successive rinses show no significant decrease in beam 
obscuration. If the beam obscuration is greater than 1.0, an 
error message is displayed. If the beam obscuration is less 
than 1.0, it is assumed to be due to the difference in liquids 
and operation continues.

• The system has performed 10 rinses and was unable to 
attain a beam obscuration of less than 0.1, displaying an 
error message. 

Select Rinses to specify an exact number of rinses to 
perform.

Start Begins the rinse operation; a message is displayed indicating 
a rinse operation is in progress. When rinsing is complete, the 
dialog closes.

Cancel Cancels the rinse operation and closes the dialog.
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MasterTech

This option is functional only if you have a MasterTech connected to your analyzer.

Beaker number Enter the position number of the beaker you wish to rinse 
into. Be sure the beaker contains a small amount 
(approximately 10 mL) of liquid; otherwise, its presence may 
not be detected by the MasterTech. 

Range: 1 to 18

Start Begins the rinse operation; a message is displayed indicating 
a rinse operation is in progress. When rinsing is complete, the 
dialog closes.
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MasterTech Then DigiSizer

Select MasterTech then DigiSizer; the MasterTech Then DigiSizer Rinse dialog is displayed.

This option is functional only if you have a MasterTech connected to your analyzer.

MasterTech Group Box Enter the position number of the beaker you wish to rinse 
into. Be sure the beaker contains a small amount 
(approximately 10 mL) of liquid; otherwise, its presence may 
not be detected by the MasterTech. 

DigiSizer Group Box Select Autorinse to have the system determine how many 
rinses to perform in order to reach a beam obscuration of 0.1 
or less.

If your analysis and rinse liquids are the same, rinsing 
stops when:

• No significant decrease in beam obscuration is attained 
twice in a row, displaying an error message.

• The system has performed 10 rinses and was unable to 
attain 0.1 or less; an error message is displayed.
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DigiSizer Group Box

(continued)

If your analysis and rinse liquids are different, rinsing 
stops when:

• Successive rinses show no significant decrease in beam 
obscuration. If the beam obscuration is greater than 1.0, an 
error message is displayed. If the beam obscuration is less 
than 1.0, it is assumed to be due to the difference in liquids 
and operation continues.

• The system has performed 10 rinses and was unable to 
attain a beam obscuration of less than 0.1, displaying an 
error message. 

Select Rinses to specify an exact number of rinses to 
perform.

Start Begins the rinse operation; a message is displayed indicating 
a rinse operation is in progress. When rinsing is complete, the 
dialog closes.

Cancel Cancels the rinse operation and closes the dialog.
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Drain

Select this option to drain the Saturn DigiSizer system of all liquid. This operation must be 
performed before the sample cell can be removed; otherwise, the sample compartment will be 
flooded with liquid. This operation also moves the rotation arm out of the way so that the sam-
ple cell is accessed easily.

Initialize MasterTech

Select this option to align the MasterTech tray or if you wish to perform manual operations 
with the MasterTech. When the MasterTech is initialized, the tray is aligned so that beaker #1 
is in the starting position.

Start Begins the draining process; when all liquid has been 
drained from the system, the dialog closes automatically.

Start Begins initialization; when initialization is complete, the 
dialog closes automatically.
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Enable Manual Control

Select this option to control your system manually. If the instrument schematic is not dis-
played, select Show Instrument Schematic. This illustration shows a schematic of the 
DigiSizer with the standard liquid sample handler installed. 

When you enable manual control, the symbols for valves and pumps change color on the 
screen to indicate manual operation. 

*The analysis pump displays as light green when operating at high speed, and dark green when 
   operating at low speed.

Use the mouse pointer or the Tab key to select schematic components.  A component is 
selected when it is surrounded by a dotted line.

Each component has a pop-up menu displaying the operations available for that particular 
component. These menus may be accessed by right-clicking on the desired component, or by 

• Valves: Closed = Yellow Open = Green
• Pumps: Off = Yellow On = Green *

Displayed when a MasterTech is installed.

Displayed when 
an ultrasonic 
probe is 
installed.

The reservoir portion of the schematic 
displays in this manner when using the 
Low-volume sample handler.
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using the shortcut keys, Shift + F9.

You can turn pumps on and off, as well as open and close valves by using one of the following 
methods:

• access the pop-up menu and select the appropriate action
• double-click on the pump (or valve) symbol
• select the pump (or valve) symbol and press the Spacebar

Circulating pump Pumps the sample and dispersing liquid through the analysis 
system. The direction of the flow of liquid is fixed as 
indicated by the arrow just above the pump.

Colors: Green = On
Yellow = Off

Actions: On, Off, Set speed

The speed at which the pump is operating is displayed to the 
left of the pump symbol. To specify a different speed, select 
Set speed; the Pump Speed Setting dialog is displayed:

Rinse pump Pumps the rinse liquid into the reservoir. The direction flow 
of the liquid is fixed as indicated by the arrow just above the 
pump.

Colors: Green = On
Yellow = Off

Actions: On, Off

If your DigiSizer has the Low-volume liquid sample handler 
installed, the rinse pump does not display. The Low-volume 
liquid sample handler uses the analysis liquid for the rinsing 
operation.

On Off

On Off
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Analysis liquid pump Pumps analysis liquid into the reservoir.

Colors: Green (light) = On at high speed
Green (dark) = On at low speed
Yellow = Off

Actions: High, Low, Off

Waste Valve When open, allows the sample and analysis liquid to be 
flushed from the system.

Colors: Green = Open
Yellow = Closed

Actions: Open, Close

Liquid level sensor Detects the liquid level of the associated component. Two 
sensors are located on the reservoir, one for the primed level 
and one for the full level. One sensor is located on the Waste 
valve.

Colors: Blue = Liquid sensed
Gray = No liquid sensed

Actions: None available; display component only

Reservoir Holds the dispersed sample. 

The temperature of the dispersion liquid is displayed to the 
left of the reservoir.

The reservoir has two liquid level sensors; one for the primed 
level and one for the full level.

On Off

Open Closed

Sensors

Standard Reservoir

Low-Volume Reservoir

Sensors

Dispersion Liquid 
Temperature
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Ultrasonic 
Probe

Typically, an optional ultrasonic probe is installed to maintain 
sample dispersion. The percentage of power being generated 
is shown to the left of the probe.

Colors: Green = On
Yellow = Off

Actions: Probe on, Probe off, Set probe intensity

Colors are not displayed and actions are unavailable if an 
ultrasonic probe is not installed.

Select Set probe intensity to edit the ultrasonic power; the 
Ultrasonic Intensity Setting dialog is displayed.

Laser assembly The exposure parameters, drive current, pulse time, and 
number of pulses are displayed to the left of the laser 
assembly. The light dose for the photodiode is shown directly 
below the photodiode.

Colors: Laser Assembly
Yellow = Manual control enabled
Green = Exposure in process
Red = Laser is on

Photodiode
Grey = Idle
Blue = Exposure in process

Actions: Filter in, Filter out, Expose, 
Stop exposure, Display

Error conditions associated with the laser assembly are 
displayed on the schematic in red with yellow text. Appendix 
A provides causes and actions for these error messages.

The filter controls the light coming from the laser. Select 
Filter in to have the laser intensity absorbed by a factor of 
approximately 7,200.

The probe is displayed in this 
position when using the stan-
dard sample handler.

The probe is displayed in this 
position when using the low-
volume sample handler.

Filter in position

Filter out of position

Photodiode
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Laser assembly

(continued)

Select Expose to specify detector exposure values; the 
Detector Expose dialog is displayed.

Continuous scan allows successive exposures to be taken 
using the same conditions.

Stop exposure stops the continuous scan as well as any 
exposure that may be in progress.

Display displays the Detector Display dialog allowing you to 
select a format in which to view an image of the raw data.

Choose Image to view the data in a bitmap format and 3D 
plot to view the data in a 3-dimensional format. If you choose 
both options, two windows are opened. After you click OK, a 
Display window is shown. All subsequent exposures will be 
shown in the windows.

Each time an exposure is taken, it is displayed in the window 
as long as the window remains open. This window contains 
six push buttons:

Snap
Makes a duplicate copy of the entire window and its contents. 
The duplicate copy does not contain a Snap push button and 
does not get updated with future images.

Print
Prints the contents of the window to the specified printer.

Copy
Copies the contents of the window to the clipboard.
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Laser assembly

(continued)

Save
Saves the image to an IMG file for future retrieval.

Load
Loads a previously saved image (IMG file) into the window.

Close
Closes the display window.

Rotation arm The arm position is displayed in degrees and steps  above the 
component image.

Colors: None

Actions: Move, Set reference angle

Select Move to change the arm position; the Rotation Move 
dialog is displayed.

Angle Move to moves the arm to the specified beam angle.

Steps Move moves the arm the specified number of steps 
from the current position. There are approximately 78,507 
steps per degree.

Select Set reference angle to specify the current position of 
the rotation arm; the Reference Angle dialog is displayed.
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CCD and beam photodiode The light dose of the last exposure is displayed directly above 
the component image.

Colors: Grey = No exposure in process
Blue = Exposure in process

Actions: None available; display component only

Error messages are displayed in red with yellow text. Refer to 
Appendix A, Unnumbered Messages, page A-35 for causes 
and actions.

MasterTech pump Displayed only when a MasterTech is installed. Flow 
direction is indicated by the direction of the arrows between 
the rollers and the one above the pump.

Colors: Green = On
Yellow = Off

Actions: On, Off, Flow direction rinse,
Flow direction load

Flow direction rinse pumps the rinse liquid to the 
MasterTech to rinse the MasterTech tubing of any sample 
which may have remained from a previous analysis.

Flow direction load sends the sample to the Saturn DigiSizer 
analyzer for analysis.

MasterTech arm Displayed when a beaker is in position.

Colors: Arm
Yellow = manual control enabled

Probe
Green = On
Black = Off

Stirrer
Black = Off
Green = On, low speed
Blue = On, high speed

Load Rinse
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MasterTech arm

(continued)

Actions: Move arm up, Move arm down
Ultrasonic on, Ultrasonic off
Stirrer on, Stirrer off
Stirrer speed fast, Stirrer speed slow
Move to beaker
Initialize
Self Test

Move to beaker allows you to specify the position of the 
beaker to which you wish to move the arm.

Initialize aligns the MasterTech tray so that Beaker #1 is in 
the starting position.

Self Test verifies that all components of the MasterTech are 
working properly.
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Show Instrument Schematic

Select this option to display a schematic of the Saturn DigiSizer. Refer to the previous section 
for an explanation of the components displayed on the instrument schematic.

When manual control is not enabled, you still can determine the state of the valves and pumps 

Displayed when 
an ultrasonic 
probe is installed.

Displayed when a MasterTech is installed

Displayed when 
an ultrasonic 
probe is installed.

Schematic of Saturn DigiSizer with the Standard liquid sample handler 
installed.

Schematic of Saturn DigiSizer with the Low-volume liquid sample handler 
installed.
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by color.

If you wish to change the state of a valve or pump, you must enable manual control.

Show Results

Choose this option to have results displayed as data are collected for multiple analyses.

Show Status

A status window is shown across the bottom of all operational dialogs. The Show Status 
option enables you to show only the status window of the operational dialog. If you have a 
MasterTech installed, its status is also included.

You may wish to use this option if:

• You have an automatic operation in progress and you decide to edit a sample file, for 
example. This way, you can monitor the status of your operation while performing 
another task.

• You have two units attached to your computer. You can select Show Status on each unit 
menu and have the status for all units displayed at one time.

• Valves: Closed = White Open = Green
• Pumps: Off = White On = Green *

If you have two instruments attached to your computer, the status bar for each 
instrument is displayed in a different color.

Displays when a MasterTech 
is attached to the analyzer.
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Show Instrument Log

Displays a log of recent analyses, calibrations, and errors or messages. By default, this infor-
mation is logged for a 7-day period for analyses and a 30-day period for messages and 
calibrations. You may change the time for which this information is retained in the Unit sec-
tion of the cfr5205.INI file.

You can choose the type of information to display in the window by selecting only the desired 
item(s). For example, select only the Analysis check box to display only analysis information.

Analysis
Calibration
Messages

These options allow you to choose which entries are 
displayed in the window.

Add Log Entry Allows you to enter information pertinent to the instrument 
that is not automatically recorded by the software. For 
example, you may wish to make an entry when you clean the 
analysis cell. The information you enter here is contained in 
the log report; it does not display in the Instrument Log 
window.

Report Allows you to generate the log contents to a specified 
destination; the Log Report Settings dialog is displayed.
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Report

(continued)

Use the Start Date field to specify the date at which to start 
the printout. You can specify a date using one of the follow-
ing methods:

• Highlight the field (or press F2) to clear the field and type 
in the desired date.

• Double-click in the field (or press F4) to display a calendar 
to choose a date.

• Press F3 to insert the current date.

Enter the number of copies desired in the Copies field; you 
may print up to four. This field is disabled if you are printing 
to a File or to the Screen.

Choose the report destination from the drop-down list in the 
Destination field. If you choose File, the File name field is 
enabled, allowing you to enter a name for the printed file (or 
you may accept the default).
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Unit Configuration

Select this option to display the software/hardware configurations for the Saturn DigiSizer 
system. When you select Unit [n] > Unit Configuration, the Unit Configuration dialog is 
displayed.

Software Versions Displays the software versions being used by the analyzer.

Calibration Displays calibration dates. 

Configuration Displays the analyzer’s serial number and the IP address.

Board ID Displays the Board ID dialog so that you can view the 
statistics of the board contained in the requested slot of the 
computer.
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Change Displays the Unit IP Setup dialog.

This dialog shows the IP address and Subnet mask that were 
assigned during installation. Do not edit these fields unless 
directed by a Micromeritics service representative.

Sample Handling Unit Displays the type of sampling unit being used, its serial 
number, software versions, and installed options. This group 
box also lets you know if your analysis liquid and dispersing 
liquid are the same or different.

Config Displays the LSHU configuration options dialog so that you 
can specify whether the rinse and analysis liquids are to be 
the same or different.

Auto Sampler Displays the type of autosampler being used (if any) and its 
software versions.
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Calibration

These calibrations, like the service tests, are enabled and performed only with the assistance of 
a trained Micromeritics service representative.

Service Test

Various service tests are included in the Saturn DigiSizer operating program. These tests can 
be enabled and performed only with the assistance of a trained Micromeritics service represen-
tative. These tests are designed to provide your service representative with instrument 
readouts, as well as to assist him in troubleshooting potential problems and, perhaps, eliminat-
ing unnecessary repair services. This service strategy allows you to conduct expert tests in less 
time than it would take to be trained in servicing the instrument properly.
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6.  REPORTS MENU

The Reports menu contains options which allow you to initiate and close reports for:

• Sample analyses
• Background information
• Statistical process control
• Historical particle size distribution

This chapter describes the options contained on the Reports menu, the type of reports avail-
able, and sample copies of generated reports.

Description

Listed below are brief descriptions of the options contained on the Reports menu. Detailed 
descriptions follow this section.

Start Report Allows you to generate a report on a completed sample 
analysis. Page 6-2.

Close Reports Closes all open report window(s). Page 6-4.

Open Report Enables you to open a report that was saved from the report 
window. Page 6-4.

Background Initiates a report on the current background for the selected 
unit. Page 6-5.
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Start Report

Select this option to generate a report on a sample analysis. Select Reports > Start report  to 
display the Start Report dialog.

SPC Report Options Allows you to specify the sample data to be included in SPC 
reports. Page 6-6.

Regression report Allows you to generate a regression report. Page 6-9.

Control chart report Allows you to generate a control chart report. Page 6-13.

PSD history Allows you to generate a particle size distribution history 
report. Page 6-17.
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Category/Subcategory Use these drop-down lists (directories) to navigate to the 
desired file(s).

• If you select multiple files on which to have reports gener-
ated, the reports specified in each sample file are printed to 
the output destination. 

• If you choose a single file, the Selected Reports dialog 
containing the available reports is displayed. This dialog 
allows you to verify or edit selections. 

Select (or deselect) reports by double-clicking on the desired 
report (reports are selected when they are preceded with a 
check mark). Alternatively, you can highlight the report and 
press the Spacebar.

Status This drop-down list determines the type of sample files that 
display in the Files list window in the specified directory for 
all dates, or within the specified range of dates (using Date 
Range push button).

Choices: All, Analyzing, Complete, Entered

Refer to Table 2-2. File Status and Description, page 2-16 
for a description of the status types.

Date Range Displays the Select Dates dialog so that you may specify a 
range of dates. Refer to Selecting Files, page 2-16 for a 
description of this push button.
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Close Reports

This option enables you to close all open report windows at one time. This avoids having to 
select close on each report window. This option is unavailable if reports are being generated.

Open Report

This option enables you to open a report that was saved from the Report window; the Report 
window opens with an Open dialog positioned on top. 

After you navigate to the desired directory, select your file, and click Open, your report is dis-
played in the Report window.

Preview Choose this option to have the report(s) generated to the 
screen. If a printed copy is desired, you can print the report 
from the report window.

Print Choose this option to have the report(s) generated directly to 
the printer without reviewing them first. If you choose this 
option, the Copies field is enabled allowing you to print up to 
four copies.

Files window Displays a list of the available sample files for the choice 
shown in the Status field and within the range of dates 
specified in the Dates dialog.

Report window
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Background

This option allows you to generate a report on a specified instrument’s background. When you 
select Reports > Background, the Start Background Report dialog is displayed.

Instrument Displays a drop-down list of the attached instruments, 
allowing you to choose the instrument on which to have a 
background report generated.

Background date 
and time

Displays the date and time the current background was 
performed on the selected instrument.

Overlay Samples Choose this option to overlay the background for a sample 
(or multiple samples) with the current background. Click 
Samples to choose the desired file(s).

Preview Prints the report to the monitor screen. This option allows 
you to customize reports with details such as font and column 
placement. Refer to Onscreen Reports, page 6-20 for 
additional information.

Print Prints the report to a selected printer.

Copies Enabled when you choose Print as the destination for 
reports, allowing you to generate up to four copies. 

Export Displays for a Developer only, allowing export of report data 
to a file; files are exported as their assigned name.
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SPC Report Options

This option enables you to select the data that are to be reported in Regression and Control 
Chart reports. For efficiency, it is best to select only the variables you actually intend to use. 
All variables selected must be computed for each sample file used in an SPC report. These 
archived values are used in all future reports unless you have selected Recalculate archived 
SPC results on the individual report dialog.

When you select SPC Report Options, the SPC Calculations dialog is displayed.

An Analyst is not authorized to specify SPC options.

Test Drop-down list containing analysis choices for SPC 
calculations.

Last reports statistics for the last analysis.

First reports statistics for the first analysis.

Average reports an average based on all tests in the sample 
file(s).

Statistics Type Allows you to choose the type of statistics for which the SPC 
variables are to be calculated.
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Distribution Type Allows you to choose the type of distribution data for which 
the SPC variables are to be calculated.

Arithmetic Statistics Allows you to choose the type of arithmetic statistics for 
which the SPC variables are to be calculated.

Statistics Displays a list of the variables available for SPC reporting; 
you may choose as many as you wish.

Sample Displays the SPC Sample Options dialog, allowing you to 
select the sample parameters you wish to have reported. 

Analysis Displays the SPC Analysis Options dialog, allowing you to 
select the analysis conditions you wish to have reported.

Specific parameters can 
be designated in these 
fields. 
520-42812-01 (Rev G) - Nov 2018                                                  6-7 



SPC Report Options Saturn DigiSizer II 5205 Confirm
Sizes Displays the SPC Size Options dialog, allowing you to spec-
ify up to 10 sizes and 3 distribution types at which the cumu-
lative percent finer (or coarser, depending on the selection for 
data presentation) is to be reported.

Percentiles Displays the SPC Percentile Options dialog, allowing you to 
specify the percentiles and distribution types for which the 
cumulative percent finer (or coarser, depending on the selec-
tion for data presentation) is to be reported.

Peaks Allows you to choose the peaks to include in SPC calcula-
tions; you can include up to 10 peaks. 
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Regression Report

Select this option to generate a regression report. The regression report is used to determine 
the interdependency between two variables. Up to three dependent variables (Y-axis) may be 
plotted against a single independent variable (X-axis). The degree of correlation between the 
variables also is reported. The graphs for the regression report are scaled so that all three fit on 
a single page. If you choose less than three, the graphs are scaled to fill most of the page.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title.

Deselect this option to omit the report title.

Range: 40 characters

Show graphic Select this option to have a graphic display above the report 
title. The graphic can be in a bitmap (bmp) or an enhanced 
metafile (emf) format. For example, you may wish to display 
your company logo.

Click Browse to choose the graphic, then use the Height and 
Width fields to specify a size. The image can also be edited 
from the report window.
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X- and Y-Axes 
Variable fields

Allows you to designate the X- and Y-axes variables. Click 
on the down arrow to display a list of variables. The variables 
in this list are the ones you specified in SPC report options.

With this option, you may plot the regression of up to three Y-
axis variables against the X-axis variable. The X-axis 
specifies the independent variable for the regression, while 
the Y-axes provide the dependent variables.

Axis Range Allows you to specify the beginning and ending values for 
the X- and Y-axis ranges. Data collected outside these ranges 
are not included in the plot. These fields are disabled if you 
choose Autoscale.

Autoscale Allows you to have the X- and/or Y-axes scaled automati-
cally. When scaled automatically, both axes begin at zero. 
The analysis program uses the highest values collected during 
analysis as the ending points.

Recalculate archived 
SPC results

Select this option to have archived SPC values recalculated. 
This ensures that any changes made to the SPC Report 
Options are included in the new report; however, it will 
lengthen the time required to generate the report.

Tabular report Allows you to generate tabular, as well as graphical, data of 
the included samples. A tabular report contains the numeric 
values contributed by each sample.

Label data Allows you to label the points on the plot to correspond with 
the values in the sample files.
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Samples Displays the Regression Report Sample Selection dialog, 
allowing you to choose the sample files you wish to have 
reported.

Category
Subcategory

Drop-down lists containing current directories. The 
Category represents the Directory, and the Subcategory 
represents the Subdirectory of the selected Directory.

Status This drop-down list determines the type of sample files that 
display in the Files list window in the specified directory for 
all dates, or within the specified range of dates (using Date 
Range push button).

Choices: All, Analyzing, Complete, Entered

Refer to Table 2-2. File Status and Description, page 2-16 
for a description of the status types.

Date Range Displays the Select Dates dialog so that you may specify a 
range of dates. Refer to Selecting Files, page 2-16 for a 
description of this push button.

Use all files in 
this location  

Select this option to include all files from the selected 
directory in the Regression report.
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Available Samples
Selected Samples

The Available Samples pane contains the sample files 
residing in the selected directory and within the selected 
range of dates. The Selected Samples pane contains the files 
you select to include in the Regression report.

Add Moves the selected file to the Selected Samples panel. 
Alternatively, you can simply double-click on the desired 
file(s). You can select multiple files by holding down Ctrl 
while making your selections.

You can choose up to 200 sample files.

Delete Removes the selected file from the Selected Samples list and 
moves it back to the Available Samples list.

Preview Prints the report to the monitor screen. This option allows 
you to customize reports with details such as font and column 
placement. Refer to Onscreen Reports, page 6-20 for 
additional information.

Print Prints the report to a selected printer.

Copies Enabled when you choose Print as the destination for 
reports, allowing you to generate up to four copies. 

Export Displays for the Developer only, allowing export of report 
data to a file; files are exported as their assigned name.

Save as default Saves the current definition of the report as the default.

Report Generates the report.
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Control Chart

This option enables you to generate a control chart report which plots the changes in a statistic. 

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title.

Deselect this option to omit the report title.

Range: 40 characters

Show graphic Select this option to have a graphic display above the report 
title. The graphic can be in a bitmap (bmp) or an enhanced 
metafile (emf) format. For example, you may wish to display 
your company logo.

Click Browse to choose the graphic, then use the Height and 
Width fields to specify a size. The image can also be edited 
from the report window.
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Order x-axis by Enables you to choose the order in which X-axis statistics 
are placed. You can have them placed by Time, File name, 
Date, Minutes, or Days.

Time places the files on the graph at numerical points in the 
order of the date/time the files are analyzed.

File name places the files on the graph at numerical points 
in alphanumeric order.

Date places the files on the graph at points representing the 
actual date/time the files are analyzed.

Minutes places the files on the graph at points representing 
the minutes that have elapsed from the first file placed on the 
list, which is the earliest-analyzed file.

Days places the files on the graph at points representing the 
number of days that have elapsed from the first file placed 
on the list, which is the earliest-analyzed file.

Graph [n] Displays the Control Chart Graph [n] Options dialog, 
allowing you to define the Y-axis of each graph. 

Statistic This drop-down list displays the SPC variables selected on 
the SPC Report Options dialog. The variable you choose will 
be plotted against time.

Autoscale Allows you to have the Y-axis scaled automatically. If you 
wish to specify a range, deselect this option and enter ranges 
in the From and To fields.
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Center Line Displays placement options for the variable’s optional value. 
Choose Entered to specify placement of the line.

Limit Lines Displays the options available for limiting lines. You can 
have the lines placed at some multiple of the standard 
deviation () or at specified positions (Entered).

Recalculate archived 
SPC results

Select this option to have archived SPC values recomputed. 
This ensures that any changes made to the SPC Report 
Options are included in the new report. It also lengthens the 
time required to generate the report.

Tabular report Allows you to generate tabular, as well as graphical, data of 
the included samples. A tabular report contains the numeric 
values contributed by each sample.

Samples Displays the Control Chart Sample Selection dialog, allowing 
you to choose the sample files on which you wish to report.

This dialog functions in the same manner as the Regression 
Report Sample Selection dialog explained previously. 

Preview Prints the report to the monitor screen. This option allows 
you to customize reports with details such as font and column 
placement. Refer to Onscreen Reports, page 6-20 for 
additional information.
520-42812-01 (Rev G) - Nov 2018                                                  6-15 



Control Chart Saturn DigiSizer II 5205 Confirm
Print Prints the report to a selected printer.

Copies Enabled when you choose Print as the destination for 
reports, allowing you to generate up to four copies. 

Export Displays for a Developer only, allowing export of report data 
to a file; files are exported as their assigned name.

Summary Statistics Allows you to select the statistics to display in the report.

Coefficient of Variation is the Standard Deviation
divided by the Mean.

Confidence Interval of the mean value (shown on the same 
line below the graph on the report). When you select this 
option, the Confidence Level field is enabled allowing you 
to enter the percentage.

Select Number of Samples to have the number of samples 
analyzed included in the report.

Save as default Saves the current definition of the report as the default.

Report Generates the report.
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PSD History

This option enables you to report a sequence of full particle size distribution graphs.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title.

Deselect this option to omit the report title.

Range: 40 characters

Show graphic Select this option to have a graphic display above the report 
title. The graphic can be in a bitmap (bmp) or an enhanced 
metafile (emf) format. For example, you may wish to display 
your company logo.

Click Browse to choose the graphic, then use the Height and 
Width fields to specify a size. The image can also be edited 
from the report window.

Order x-axis  by Enables you to choose the order in which X-axis statistics are 
placed. You can have them placed by Time, File name, Date, 
Minutes, or Days. Refer to page 6-14 for explanation of 
these options.
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Samples Displays the PSD History Sample Selection dialog, allowing 
you to choose the sample files on which you wish to report

This dialog functions in the same manner as the Regression 
Report Sample Selection dialog (refer to Regression Report, 
page 6-9). 

Preview Prints the report to the computer screen. This option allows 
you to customize reports with details such as font and column 
placement. Refer to Onscreen Reports, page 6-20 for 
additional information.

Print Prints the report to a selected printer.

Copies Enabled when you choose Print as the destination for 
reports, allowing you to generate up to four copies. 

Export Displays for the Developer only, allowing export of report 
data to a file; files are exported as their assigned name.

Save as default Saves the current definition of the report as the default.

Report Generates the report.
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Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics.

• Tabular and graphical reports contain sample and instrument statistics such as date and 
time of analysis, analysis conditions, and background data.

Headers also contain notes of any changes to the sample file which occur after analysis.

• Summary report headers contain the same type of information displayed in tabular and 
graphical reports with the exception of notes.

• SPC report headers display the current date as well as the range of dates of the samples 
you select to have reported. 

Software version of DigiSizer used for analysis. Analyzer serial number.

Current version 
of DigiSizer 
software.

Software version of LSHU used for analysis.
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Onscreen Reports

The report window containing onscreen reports provides many options for customizing and 
manipulating reports: 

• a tool bar
• short-cut menus
• zoom feature
• axis cross hairs 

When reports are printed to the screen, they are printed in a window like the one shown below. 
Each requested report is listed in the Reports window on the tool bar; they are also indicated 
by selectable tabs across the top of the report header. To view a specific report, select its tab or 
select the report in the Reports window and click Show.

Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the report 
has been hidden, it and its associated tab will become visible.

Delete Deletes the selected report. A deletion confirmation dialog is 
displayed since this function cannot be undone. The deleted 
report(s) will have to be regenerated if deleted in error.

Tabs display for each type of report you choose to generate.

List of reports 
requested.

Options on 
Tool bar.

Displays graphi-
cal (or tabular) 
data.

Header
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Hide Hides (removes) the selected report from the report window. 
The report’s associated tab is also removed. 

Open Allows you to open a previously saved report file.

Print Displays a print dialog so that you can choose an appropriate 
printer for report output. A list of available reports is 
displayed in the window on the right side of the dialog. 

For convenience in selecting reports to print, push buttons are 
provided beneath the report window. Or, you can make your 
selection by clicking on the desired reports.  

Current
selects the report displayed in the report window.

Shown
selects only the shown reports; any unlighted reports indicate 
they are hidden. You can still select hidden reports from this 
window to print.

All
selects all reports, including those that may have been 
hidden.

Clear
clears all selections.

Save Saves all reports of the currently open file in a report format 
using the same name as the sample file, only with an rep 
extension. If you wish to specify a name and/or specific 
reports to save, use the Save as push button.
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Save as Allows you to save all or specified reports from the currently 
open file. The push buttons displayed on this dialog perform 
in the same manner as the print dialog (explained above).

Reports can be saved in three different formats:

Report system (*.rep): Saved in a format which allows you 
to reopen the file using the Open push button on the Report 
window tool bar.

Spreadsheet (*.xls): Saved in a format which can be 
imported into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be 
imported into programs accepting this type of file.

Default Style Displays the Default Style dialog so that you can edit report 
defaults.

Fonts Contains a list of report elements for which the font can be 
edited. Simply highlight the desired element and click Edit; a 
font dialog is displayed so that you can specify the desired 
font and attributes.

Curve The items in this group box enable you to specify a thickness 
for report curves and, when using histograms, the type of fill 
to apply.

Graph border 
line thickness

Enables you to specify a thickness for the border of the graph.

Load Loads the last saved defaults.
6-22                                                    520-42812-01 (Rev G) - Nov 2018



Saturn DigiSizer II 5205 Confirm Printed Reports
Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

For Tabular Reports

Save Saves the changes as the defaults. If you do not click Save, 
the changes will apply to the current report set only. The next 
reports will revert to the defaults.

Close Closes the dialog and applies the changes. If you clicked 
Save, the changes become the defaults. If you did not click 
Save, the changes apply to the current report only.

Close Closes the report window.

Resize column Displays a dialog so that you can specify the width  of the 
selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.

Move column Allows you to move the location of the selected column to 
the left or to the right.
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Align column Enables you to right-align, left-align, or center the data in the 
selected column.

Hide column Displays a list of all columns, enabling you to select the one 
you wish to hide.

Show column Displays a list of all hidden columns, enabling you to select 
the one you wish to have shown again.

Column font Displays a Font dialog, allowing you to change font attributes 
for the tabular data in the current report. 

Header font Displays a Font dialog, allowing you to change font attributes 
for column headers in the current report.

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns are 
tab-delimited, allowing easy alignment.
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For Graphs

Autoscale Autoscales all axes of the graph. This function is useful for 
returning to a full view after having zoomed in.

Redraw Sets axis boundaries to its original view. You can also use this 
function to remove cross-hairs.

Show curve Allows you to show curves that have been hidden. This 
option is disabled (greyed) if no curves have been hidden.

Hide curve Allows you to hide (remove) unwanted curves.

Edit curve Displays the Curve Properties dialog, allowing you to edit 
curve properties.
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Title Displays the title of the curve you are editing.

Style Drop-down list containing styles in which collected data can 
be displayed.

Choices: Curve, Histogram, Points, Curve and Points

Curve 
group box

Contains options for curves and points. You can edit the 
curve interpolation, the style of curve and/or points, as well 
as the pen color. The options in this group box are disabled if 
Histogram is chosen in the Style drop-down list.

Histogram
group box 

Allows you to specify the type of fill as well as the color if 
Histogram is chosen as the style for collected data.

Edit axis Displays the Axis Properties dialog, allowing you to edit axis 
properties.

Edit legend Displays the Legend Properties dialog, allowing you to edit 
the placement of the legend.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine 
detail of the distribution. To use this feature, simply hold down the left mouse button and drag 
the mouse cursor (drawing a box) across the area you wish to view; then release the button. 
The enlarged area immediately fills the graph area. You can return to the normal view by right-
clicking on the graph and selecting Autoscale. 

Edit title Displays the Title Properties dialog, allowing you to edit the 
current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing you 
to paste it into other applications accepting Windows 
metafiles. 

Copy as text Copies the data used to generate the graph as a series of tab-
delimited columns of text.
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Axis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature, 
simply left-click in the desired area of the graph.

You can remove cross-hair lines and return to the normal view by right-clicking on the graph 
and selecting Autoscale, or clicking out of the graph area.

Report Examples

This section contains examples of the types of reports available using the Saturn DigiSizer 
analysis program.

X-axis position

Y-axis positionPoint of Coordination
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Combined Report

The Combined report is a combination of all reports you select on the Combined Report 
options dialog. Reports are shown consecutively with no page breaks or headings.
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Particle Size Table
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Volume Percent Table
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Cumulative Volume Percent vs. Particle Diameter
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Incremental Volume Percent vs. Particle Diameter
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Difference from Reference
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Out of Specification
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Background Report
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Goodness of Fit
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Summary

The Summary report allows you to choose the type of statistics to report; this one shows geo-
metric statistics for volume distribution and peaks.
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7.  OPTIONS MENU

The Options menu contains commands which allow you to configure the system to your labo-
ratory’s requirements. With the options on this menu, you can:

• Add directories
• Edit labels for sample files and directories
• Specify data presentation modes

The only function available to the Analyst on the Options menu is to add an archive location. 
All other operations are initiated by the Developer or an Administrator.

Description

Listed below are brief descriptions of the commands contained on the Options menu. Detailed 
descriptions follow this section.

Add archive location Allows you to add a directory. Page 7-3.

Edit labels Allows you to edit the labels for the directories that appear on 
some file dialogs. Page 7-4.

Update file list Allows you to update the cache file for the sample or 
parameter file directory. This operation has to be initiated by 
an Administrator. Page 7-5.

Data Presentation Allows you to choose the way in which data are presented on 
the screen and in printed reports. Page 7-6.
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Service Test Mode Enables you to perform certain troubleshooting procedures. 
This option is available only under the direction of a 
Micromeritics service representative. Page 7-7.
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Add Archive Location

New archive locations (directories) can be created by an Analyst or a Developer; the Add 
Archive Location dialog is displayed.

Category 
Subcategory

These fields allow you to create new directories and/or 
subdirectories for the repository.

The drop-down lists in the All Locations column contain  the 
existing directories and subdirectories. 

The fields in the New Location column allow you to enter 
new directories. Category represents the “Directory,” and 
Subcategory represents the “subdirectory.” You can add a 
subdirectory to an existing directory by choosing the direc-
tory from the drop-down list, then entering the new directory 
name in the Subcategory field.

The labels for the directories can be changed by the 
Developer (see following section). Many laboratories use the 
month/year combination for organizing files.

Existing directories and 
subdirectories.

These directories and their contents cannot be seen through use of Windows 
Explorer; they can only be viewed through use of the analysis program.

Sequence number Allows you to enter a new sequence number for the directory 
you create. This number is incrementally sequenced for each 
sample file you create and displays as part of the 
identification if the sample template included a $ symbol 
when it was created.

Add Enabled when you make an entry in the Subcategory field, 
allowing you to add the new directory and close the dialog.
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Edit Labels

Edit labels allows the Developer to edit the labels that display on the sample file editor; the 
Edit Labels dialog is displayed.

Repository Levels The Top and Second Levels represent the directory and 
subdirectory for the location of sample files. Many 
laboratories use the Year/Month file storage system.

Sample Information 
Prompts

These are the labels that appear on the sample information 
dialog.

If you do not wish to have the Operator and Submitter (or 
other specified names) lines, you can click Omit to have them 
excluded.

A third line is available for other information as desired; for 
example, for entering (or scanning) bar code information.  

User Parameters These fields are used specifically for SPC (Statistical Process 
Control) reporting. They are used to specify characteristics of 
either the sample or its manufacturing process.

For example, you may wish to report the relationship of the 
motor speed of a grinder used in the manufacturing process to 
the median diameter of the sample. Enter Motor speed as a 
Parameter. The value can be added in the sample file. When 
you add the value in the sample file, you can save the file as a 
Template, making it available when desired. Specified 
parameters display in the SPC Sample Options dialog 
(accessed through the SPC Calculations dialog).

You can omit these fields from displaying on the sample file 
dialog by selecting Omit.
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Update File List

This function cannot be performed by the Analyst nor the Developer, unless the Developer has 
Administrator rights. This is an Administrator function only; details for performing this opera-
tion are covered in the Administrator’s Guide.

This option allows the directory to be updated when files have been added outside of the appli-
cation. For example, if you need to restore the directory with a backup file.
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Data Presentation

The options on the Data presentation drop-down menu allow a Developer to specify the man-
ner in which tabular and graphical data display on screen and in printed reports. 

Size in diameter/radius
Invert size axis
Cumulative coarser/finer
Percent/Fraction

Allow you to choose the manner in which data display on the 
screen and in printed reports. Selected options are preceded 
with a check mark.

Sieve Table Displays the Sieve Table dialog so that you can specify 
default sieve sizes when presenting sieve data.

A sieve size is selected when it is preceded by a check mark 
(). Make your selection(s) by double-clicking on the 
desired sieve(s), or highlight the desired sieve and press 
Spacebar.

Indicates selected 
sieves.
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Service Test Mode

Various service tests are included in the Saturn DigiSizer operating program. These tests can 
be performed only with the assistance of a trained Micromeritics service representative. When 
you select Service Test Mode from the Options menu, a dialog prompting you to enter a pass-
word is displayed. This password will be provided  by your service representative. You will 
not be able to perform these tests without the guidance of your service representative. After 
Service Test Mode has been activated, the tests can be accessed from the Unit menu.
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8.  TROUBLESHOOTING AND MAINTENANCE

The Saturn DigiSizer system has been designed to provide efficient, continuous service and 
requires very little maintenance. The few maintenance procedures recommended are simple, 
easy to perform, and require no tools. If any service beyond the scope presented in this chapter 
is required, you should contact your local trained service representative. You should never at 
any time attempt to remove any panels from the analyzer. 

Troubleshooting

Most common operational problems are caused by improperly installed tubing, or a dirty sam-
ple cell. Always check these things first when expected analysis results are not obtained. Most 
operational problems are indicated by an error message on the monitor screen. Appendix A 
provides solutions for these messages. Listed below are some troubleshooting tips when oper-
ational problems occur.

Table 8-1. Common Operational Problems

Problem Action

No power to the analyzer Ensure that the power cord is firmly plugged into the 
analyzer and the receptacle.

Ensure that the ON/OFF switch is in the ON position.

Ensure that the power source is energized.

Check the fuse located in the power entrance located on the 
rear panel of the analyzer; replace if necessary. (Refer to 
Replacing Fuses, page 8-11.)

Ensure that the line voltage is correct for the analyzer’s 
configuration.

Make sure the Linear circuit breaker has not tripped. If the 
breaker has tripped (indicator button is extended), turn off 
the analyzer and wait for a few minutes. Reset the breaker 
and turn on the analyzer. 
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Problem Action

No communication between the 
analyzer and the computer

Ensure that the ethernet cable is firmly seated at the analyzer 
and computer ethernet ports.

Time-out message during rinse 
or drain operation

Make sure the Analysis and/or Rinse containers contain 
liquid; if not; refill and resume operation.

Check the rinse/analysis tubing to see if it is primed (fluid 
inside the tubing). If no fluid is present, inspect the tubing 
for a cut or worn spot; replace the tubing if necessary (refer 
to Replacing the Tubing, page 8-9).

Make sure a sample cell is installed. If a sample cell is not 
installed, the sample cell compartment will be filled with 
liquid. Remove the rubber mat from the sample cell 
compartment. Thoroughly dry the inside of the compartment 
and the mat. Replace the mat and install the sample cell 
(refer to Cleaning the Optics, page 8-4).

Check the tubing connections to the sample cell to make sure 
they are secure. If leaking, cancel the current operation. 
Thoroughly dry the inside of the sample compartment and 
tighten the tubing connections, then resume operation.

Check the pumps and solenoid valves for proper operation. 
Access the instrument schematic and enable manual control. 
Turn the analysis and rinse pumps on to ensure that liquid is 
being pumped into the reservoir. Call your local 
Micromeritics representative if liquid does not pump into the 
reservoir properly.
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Problem Action

—————————— MASTERTECH —————————

No power to the MasterTech Ensure that the power cable is plugged securely into the 
power source.

Ensure that the ON/OFF switch is in the ON position.

Check the fuse located in the power entrance located on the 
rear panel of the MasterTech; replace if necessary. (Refer to 
Appendix I, page I-1.)

Stirrer will not work. Ensure that the stirrer is properly connected.

Turntable will not move. Press the arm AUTO/LOAD switch on the front panel to 
place it in the AUTO position.

MasterTech pump will not run. Ensure that the pump AUTO/OFF switch on the front panel 
is in the AUTO position.

Tubing may be bunched up in the pump; pull the tubing taut.

Ultrasonic probe will not work. Check the BNC connector cable to ensure that it is properly 
connected.

Ultrasonic agitation diminished. Check the probe tip; replace if necessary.

MasterTech will not initiate 
commands from the computer.

Check the cable connection from the MasterTech to the 
computer to ensure that it is properly connected.

Pump leaks or is not operating 
efficiently.

Tubing is leaking or clogged; replace tubing.
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Cleaning the Analyzer

A clean cloth, dampened with isopropyl alcohol (IPA), a mild detergent or a 3% hydrogen per-
oxide solution may be used to clean the outside casing of the analyzer and liquid sample 
handler. It it not necessary to remove any control knobs or screws while cleaning. If you have 
a MasterTech installed on your Saturn DigiSizer, it may be cleaned in the same manner.

Cleaning the Optics

The accessible optics of the Saturn DigiSizer 5205 consist of three components: the sample 
cell, the detector lens, and the collimator lens. It is important that these components be kept 
clean.

Sample Cell and Detector Lens

The sample cell should be cleaned as needed based on changes in background intensity (refer 
to Appendix H, Page H-1 for a discussion on background quality). You will need the follow-
ing items to clean the sample cell (included in the accessories kit):

• Lens cleaner 
• Lens paper
• Soft absorbent (non-scratching) foam swab 

1. Select Unit [n] > Drain to drain the system of all liquid and to move the rotation arm out 
of the way, allowing easy access to the sample cell assembly. The dialog will close when 
draining is complete.

2. Open the front panel of the DigiSizer analyzer and remove the cover of the analysis 
compartment.

3. Loosen the two knurled nuts on the top bracket of the sample cell holder; then pull up on 
the bracket to allow removal of the sample cell.

4. Rotate the cell out of its holder by pulling the right-hand side of the cell assembly toward 
the front of the analyzer. The left side will remain against the vertical support.

The sample cell is coated with an anti-reflective substance. Be careful not to scratch 
or abrade this coating. Also avoid touching the front and back surfaces of the sample 
cell to prevent fingerprints.
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5. Grasp the sample cell by its side edges and place on a sheet of lens paper while performing 
the next two steps.

6. Using your fingertip, check the o-rings in the upper and lower bracket of the sample cell 
holder to ensure that they are clean (no grit is present) and properly seated. If the o-rings 
appear dirty, wipe them with a sheet of lens paper dampened with lens cleaner. 

7. Using a flashlight or other type of illumination, examine the detector lens (located at the 
back of the analysis compartment). If particles or smudges are evident, gently clean the 
lens surface with a sheet of lens paper dampened with lens cleaner. Then, using a dry sheet 
of lens paper, gently wipe the surface dry.

8. Holding the sample cell by its side edges, blow or gently brush away any debris from the 
surface of the sample cell.

9. Using a sheet of lens paper dampened with lens cleaner, clean the upper and lower edges 
of the cell. Then, using a foam swab dampened with lens cleaner, clean the outside and 
inside of the cell. 

10. Using a dry sheet of lens paper, gently and completely wipe dry the outside of the cell; DO 
NOT dry the inside of the cell.

Knurled Nuts

The detector lens is coated with an anti-reflective substance. Be careful not to scratch 
or abrade this coating. Also avoid touching the front and back surfaces of the sample 
cell to prevent fingerprints.

Always hold the sample cell by the side edges. Fingerprints on the front and back 
surfaces of the cell can alter analysis results.
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11. Reinstall the cell:

a. Orient the cell so that the groove is on the left side and the extended flange is on the 
front of the right side.

b. Slide the grooved (left side) of the cell onto the left vertical bar.

c. Rotate the sample cell toward the right vertical bar; ensure that the cell is seated 
properly between the two vertical bars.

d. Slide the top bracket of the sample cell holder down; tighten the knurled nuts. You 
should see a black oval on the bottom of the cell where the o-ring makes a seal.

12. Perform a quick leak-check to ensure proper installation of the cell:

a. Select Unit [n]  > Rinse > DigiSizer.

b. Choose the Rinses option, specify 1, and then click Start.

c. Observe the sample cell. If no leaks occur, proceed to Step 13. If leaks occur, click  
Cancel, then Yes to stop the rinsing function.

d. Close the front panel (you do not have to reattach the cover of the sample analysis 
compartment); then select Unit [n]  > Drain to drain the system.  

e. After draining is complete, turn off the analyzer, then close the analysis program.

f. Open the front panel and remove the rubber mat from the analysis compartment. 

g. Wipe dry the area around the sample cell, the mat, and the analysis compartment; 
replace the mat.

h. Make sure the cell is seated properly and the knurled nuts are secure.

i. Turn on the analyzer and start the analysis program.

j. Repeat steps a, b, and c (and the remainder if necessary).

13. Replace the sample cell compartment cover and close the front panel.

Right vertical barLeft vertical bar

External flange
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Collimator Lens

The collimator lens should not require cleaning unless the Saturn DigiSizer is being exposed 
to an environment where high levels of dust are present. If this is the case, you should occa-
sionally inspect the collimator lens and the analysis compartment to ensure their cleanliness. 
You should always keep the analysis compartment and the analyzer’s front cover closed 
except during cleaning to minimize dust build-up.

You will need the following items to clean the collimator lens:

• Small mirror
• Lens paper

1. Select Unit [n]  > Drain to drain the system of all liquid and to move the rotation arm up. 
The dialog will close when draining is complete.

2. Open the front panel of the DigiSizer analyzer and remove the cover of the analysis 
compartment.

3. Wipe or brush the inside of the analysis compartment if needed.

4. Use the mirror to locate the collimator lens (on the underside of the rotation arm).

5. Using a sheet of dry lens paper, gently wipe the surface of the lens. Be careful not to touch 
the lens with your fingertips. Do not use compressed air to blow away particles from the 
detector lens. This merely resuspends the particles, allowing them to resettle on the optics.

6. Replace the sample cell compartment cover and close the front panel.
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Cleaning the Sample Reservoir

Rinsing after analysis generally will keep the reservoir in a clean state. Occasionally, however, 
particles may accumulate on the surface of the reservoir where rinsing may not sufficiently 
remove them. If the reservoir appears dirty or feels gritty to the touch, clean it as follows:

1. Select Unit [n] > Drain to empty the reservoir of all liquid.

2. Using a clean, soft cloth, wipe the inside of the reservoir. If necessary, use a soft brush to 
remove any stubborn particles.

3. Perform a rinse operation to rinse the reservoir; this operation also fills the reservoir to the 
primed level.
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Replacing the Tubing

Tubing may occasionally become worn or damaged in some way and require replacing. 

Liquid Sample Handler

The types of tubing connected to the liquid sample handler are identified as follows:

• Rinse tubing* 0.64-cm (1/4-in.) diameter
• Analysis tubing 0.64-cm (1/4-in.) diameter
• Overflow tubing 1.27-cm (1/2-in.) diameter
• Drain tubing 0.79-cm (5/16-in.) diameter

*The Low-volume unit uses the same liquid for analysis and rinsing. Therefore, 
Rinse tubing is not installed. Ignore all references to the rinse tubing in this 
procedure if you have the Low-volume unit.

The tubing on the liquid sample handler should be replaced as needed. Refer to Chapter 10 for 
part numbers and ordering information. All tubing is removed and replaced in the same man-
ner. The rinse and analysis tubing are the same type tubing. The drain tubing is the same color 
and very close to the same size as the rinse and analysis tubing; be sure that you are replacing 
the damaged tubing with the correct tubing.

1. Slide the damaged tubing off the connector on the front panel of the liquid sample handler. 

2. Remove the other end from its liquid container. If you are removing the analysis or rinse 
liquid tubing, be sure to remove the weights; place aside for installation on the 
replacement tubing. 

3. Slide one end of the replacement tubing onto its appropriate connector on the front panel.

4. Insert the other end of the tubing into its appropriate liquid container. Be sure to reinstall 
the weights if replacing the analysis or rinse tubing.

Analysis Tubing Rinse Tubing

Overflow TubingDrain Tubing
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Replacing the Air Filter

The air filter should be replaced every 30 days (more often in environments with increased 
levels of dust).

1. Remove the filter by inserting a pointed object, such as a flat-head screwdriver, into the 
center portion of the retaining cover; then pop off the cover.

2. Discard the old filter and replace with a new one from your accessories kit.

3. Replace the retainer cover.

A supply of air filters is provided in the accessories shipped with your instrument. 
Refer to Ordering Information, page  when reordering is required.

Insert screw driver here.
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Replacing Fuses

If a fuse has blown, the analyzer power indicator will not illuminate.

The fuses are located in the power-selector module on the lower, right side of the rear panel of 
the analyzer.

Replace the fuse(s) as follows:

1. Turn off the analyzer and disconnect the power cord from its power source.

2. Insert the tip of a small pocket screwdriver (or pointed object) into the left side of the 
power module located on the rear panel of the AquaPrep.

3. Gently lift up until the cover lifts up approximately 1/4 inch, then swing the cover to the 
left; the cover is hinged and cannot be removed.

4. Remove the fuse block (you may have to use needle-nose pliers to grasp the fuse block).

5. Remove the blown fuse and replace with a new one. Be sure to use the appropriate fuse 
for the input power source.

The power cord should be disconnected from the analyzer when replacing fuses. 
Failure to do so could result in electrical shock.

The fuses used in the analyzer must be identical in type and rating to that specified. 
Use of other fuses could result in electrical shock and/or damage to the unit.
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6. Position the fuse block so that the side containing the fuses is facing the power module 
and

7. Close the cover to the power entry module; ensure that the indicator pin is in the correct 
position.

8. Plug the power cord back into its power source; turn on the analyzer.

Power Source Fuse

100-120 VAC 1.6 Amp, slow blow

200-240 VAC 1.25 Amp, 5x20 mm, slow blow (requires two)
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9.  ORDERING INFORMATION

Components and accessories for the Saturn DigiSizer 5205 system can be ordered by one of 
the following methods:

• contact our Customer Service Department at 770.662.3636
• access our web site at www.micromeritics.com
• contact your local sales representative

When ordering, please use the information provided below.

Part Number Description

052-00052-00 MasterTech 052, for automatic sample preparation. Redisperses up to 18 
samples and transfers them to the DigiSizer for analysis.

055-00000-00 AquaPrep, for preparing water to be used with the DigiSizer 

004-32065-00 Lens paper, pkg. of 50

004-38600-00 Lens cleaner

004-35152-00 Foam swab, pkg. of 50

004-27015-00 Air filter (rear panel), package of 10

520-42812-00 Operator’s manual

003-51207-00 Fuse, 5 x 20 mm, Slow-Blow, 1.6 Amp  (100 - 115 VAC)

003-51197-00 Fuse, 5 x 20 mm, Slow-Blow, 1.25 Amp  (220 - 240 VAC)

520-34900-00 Sample cell, packed in protective case; includes lens papers for handling 
the cell

004-25575-01 O-ring, for sample cell, Viton

520-32802-00 Gasket (spacer), light blocking, for tubing orifices on liquid sample 
handler

004-16841-00 Reference material, Garnet, 5.30 m

520-32803-04 Tubing, flexible, for lower sample cell port (standard liquid sample 
handler)

520-32803-05 Tubing, flexible, for upper sample cell port (standard liquid sample 
handler)

520-32804-07 Tubing, flexible, for lower sample cell port (low-volume liquid sample 
handler)

520-32804-04 Tubing, flexible, for upper sample cell port (low-volume liquid sample 
handler)
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Part Number Description

—————— MASTERTECH ACCESSORIES ——————

003-51131-00 Fuse, 3AG,  Slow-Blow, 2 Amp 

003-51197-01 Fuse, 5 x 20 mm, Slow-Blow, 1.25 Amp

051-14811-00 Evaporation cover

051-14814-00 Turntable assembly

051-32901-00 Tubing set, Tygon

051-58605-02 Ultrasonic probe tip, 1/8 in.

051-61702-01 Beaker, molded, 125 mL without spout, PE

052-58605-02 Ultrasonic probe tip, 1/4 in.

052-54600-00 Key, Tubing loading
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A.  ERROR MESSAGES

Two types of error messages may be encountered while operating the Saturn DigiSizer 
program:

• Numbered error messages: displayed during operational procedures
• Unnumbered error messages: displayed on the instrument schematic

If the Action response for either type of message instructs you to contact your service rep-
resentative, record the error message and make backup copies (if appropriate) of any files 
involved in the operation.

Numbered Messages

2200 Series

2201- Cannot execute report subsystem

The 1000-series error messages (used primarily for software testing) are not 
included in this appendix. These errors should not occur during normal operation. 
If you receive a 1000 series error message or an error message not listed in this 
appendix: record the error message, make backup copies of any files involved, 
then contact your service representative.

Cause: A system or application problem has occurred and has prevented out-
put of the requested report(s).

Action A: Close the analysis program, then restart it and request the report(s) 
again.

Action B: Close the analysis program and all other applications, then restart the 
analysis program and request the report(s) again.

Action C: Close all applications and shut down Windows. Restart Windows and 
the analysis program, then request the report again. 

If you continue to get this message, contact your Micromeritics service 
representative.
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2300 Series

2331- Logged-in Windows user is not an application user.

2333- You did not enter user name or password.

2334- Incorrect user name or password.

2335- Attempt of unauthorized access was detected. Please contact administrator.

Cause: You attempted to log into the application but the user logged into Win-
dows is not an application user.

Action A: Close the application, restart Windows, and log in as the Windows 
user. Then log into the application.

Action B: Contact your Administrator to assign application rights to the current 
logged-in Windows user.

Cause: You attempted to access the application without entering your user 
name or password.

Action: Enter your Windows OS user name and password in the User Logon 
dialog.

Cause A: You entered an incorrect user name or password in the User Logon dia-
log.

Action A: Reenter your user name and password. Ensure that Caps Lock is not 
enabled; entries are case-sensitive. 

Cause B: You entered your user name but failed to enter your password.

Action B: Enter your password in the Password field.

Cause C: You entered your password in the User name field.

Action C: Enter your windows OS user name in the User name field.

Cause: You have exceeded the allowed number of log-on attempts.

Action: Contact your Administrator.
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2336- This user account is locked. Please contact administrator.

2337- The user is not an administrator.

2338- Your password has expired or needs to be changed. You will not be able to log 
in without changing the password.

2339- Your password will expire soon. Do you want to change your password?

2340- You must log in as a Windows OS user to change a password.

Cause: You entered an incorrect password more than the allowed number of 
times (by default, this is three), and your account has been locked (dis-
abled).

Action: Contact your Administrator to unlock your account.

Cause: You attempted to log in and perform a task that only the Administrator 
is allowed to perform.

Action: Contact your Administrator to complete the task.

Cause: The allowed time using a password has expired.

Action: Change your password.

Cause: The allowed time for using a password is about to expire.

Action: Change your password. 

Cause: You attempted to change your password but you are not logged in as 
the Windows OS user.

Action: You cannot change your password unless you are logged in as the Win-
dows OS user. Close the application, then restart Windows and log in 
as the user.
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2341- Error writing file or the user is not Windows OS user.

2342- Please enter a valid password.

2343- This password is already in use. Please enter a valid password.

2344- Application locked.

Cause: You attempted to log into the application but have been denied access. 
Your password file may have become corrupt.

Action: Contact your Administrator.

Cause: You entered an incorrect password.

Action: Reenter your password in both fields. Ensure that Caps Lock is not 
enabled; entries are case-sensitive. 

Cause: You attempted to change your password but entered one that has 
already been used. 

Action: Choose a different password.

Cause: Your account has been disabled.

Action: Contact your Administrator.
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2400 Series

2430- Error accessing file (file name), error code = (number). 

2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI ‘FILE_READ’ request.

Cause A: Media may be damaged.

Action A: Clean the media drive. If this does not eliminate the problem, attempt 
operation using a backup copy of the file.

Cause B: Hard disk may be damaged.

Action B: Run diagnostics on your computer.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your service representative.

Cause D: The name specified contains one or more invalid characters.

Action D: Enter a valid filename; do not use characters such as * or ?.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to diskette, delete 
them from the hard disk, and then try the operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2433- New entries have been found in this directory. Refresh the directory 
information?

2434- File (file name) — Subset # (number) wrote wrong amount of data.

2436- Path specification (path name) is invalid.

2437- File (file name) does not exist.

2438-  Disk drive (letter): is inaccessible.

Cause: Several Saturn DigiSizer files (sample information, analysis condi-
tions, material properties, or report options) have been added to this 
directory by some function other than the Saturn DigiSizer program.

Action: Select Yes to update the directory information with data from each new 
file. This operation may take a minute. 

Select No if you do not want to spend the time updating the directory 
information. This option may be feasible if a large number of files have 
been copied into the directory and you know the name of the file you 
wish to access.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension) and press 
Enter.

Cause: You entered an invalid file name.

Action: Enter the name of an existing file or select a file name from the list box.

Cause: You selected a disk drive that is not presently accessible.

Action: Ensure that the media in the disk drive is not write-protected.
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2439-  Could not register file.

2440-  Subset not found.

2441-  Seek within file failed.

2442-  Had header in subset file.

2443-  Subset owner denied access.

2444-  Not a valid file format.

2445-  Subset wrote the wrong amount of data.

2446-  Error reading data.

2447-  Error writing data.

2448- File directory (path name) is invalid. Resetting to the installation directory.

2449-  This field does not contain a valid file specification.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories list to move to the correct directory.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your Windows man-
ual and reenter the name.

Cause: You attempted to exit the application while the analyzer is performing 
a critical operation. This operation must be completed before the appli-
cation can be exited.

Action: Wait a short time and attempt to exit the application again.
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2459- An instrument is busy. Continue with program Exit? (Yes, No)

2460- Fatal Communications error on (Unit n - S/N: nnnn)

2461- No active instruments. Application will stop.

Cause: You attempted to exit the application while an analysis is in progress. 
While this is possible, the data collected while the application is inac-
tive will not be permanently recorded until the application is restarted. 
A power failure to the instrument could cause some data to be lost.

Action: If you are not concerned with the potential for loss of data should a 
power failure occur, select Yes to continue; otherwise select No.

Cause: There was a fatal error in the communications between the application 
and the analyzer. All displays for that analyzer will be closed.

Action: Ensure that the ethernet cable is securely connected at the computer 
and analyzer ports. Exit the analysis program and then restart it. If this 
error persists, contact your service representative.

Cause: At least one instrument must be active for the application to operate. 
The initialization of all of the instruments configured with the Setup 
program has failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the instrument’s failure to initialize. See the instructions for that 
message. 

Action B: Check the cable connection between the analyzer and the computer. 
Verify that the instrument has the power switch in the ON position and 
that the light on the front panel is illuminated. If the application con-
tinues to fail in its attempts to initialize the instrument, contact your 
service representative.
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2468- The instrument contains an unknown software version. Do you want to reset it?

2469- The instrument software did not initialize properly on Unit n - S/N: nnnn.

2470-  Unable to read instrument software file for Unit n - S/N: nnnn.

2477- Unit n - S/N: nnnn did not properly initialize.

2486-  Could not construct (name) report type. Program will terminate.

Cause: The application has discovered a different version of software operat-
ing in the instrument. 

Action: If there is no chance that an instrument other than the Saturn DigiSizer 
is connected to the computer, click Yes to reset the instrument and 
download the proper software. Otherwise, click No to leave the instru-
ment unchanged.

Cause: The Saturn DigiSizer software failed to execute properly.

Action: Reinstall the software, then restart it. If the problem persists, contact 
your service representative.

Cause: The application tried to read the instrument software file to download it 
to the instrument. It was unable to do so. 

Action: Reinstall the Saturn DigiSizer software, then restart it.

Cause: The software was unable to initialize this instrument; this is usually 
caused by one of the conditions listed in the error messages above.

Action: Correct the problem as described above, then restart the application.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2487-  Could not start report generator. Error code (number). Program will terminate.

2488-  File (file name) cannot be opened for editing. It is already in use.

2489-  File (file name) cannot be opened for writing. It is already in use.

2490-  No ‘.INI’ file present. Application will terminate.

2492-  This field’s entry is INVALID.

2493-  An entry is REQUIRED for this field.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The file you specified is already open for editing.

Action: Check the Windows list to locate the other edit session.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII file containing initialization information and system 
options information used during program startup does not exist.

Action: Uninstall the application, then reinstall to create the control file 
required by the analyzer.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field requires a valid entry for you to proceed.

Action: Enter or select an appropriate value.
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2494-  Value is out of the valid range.

2495-  Value is out of the valid range. Enter a value between (value) and (value).

2496-  Invalid number.

2497-  This field contains an invalid character.

2498-  The requested change to the Sample’s status is invalid at this time.

2499-  Sequence number must contain at least 3 digits.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select a value within the indicated range.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered) could not be done.

Action: Contact your service representative if you continue to receive this error 
message. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.
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2500 Series

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

2502- Error writing to file (name) during print. Error code: (number).

2505- Error Logger cannot be initialized! Error code (number). Program will exit.

2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2507-  Error opening file (name) for printing. Error code: (number).

Cause: A large number of windows are open and consuming the system 
resources available to all applications.

Action: Close one or more windows on the screen. Contact your service rep-
resentative if you continue to receive this error message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.

Cause: The selected output device is not installed.

Action: Select a different output device. Use the Control Panel > Printers 
option to specify a default printer.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.
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2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name):  (error). Reports cannot be produced.

2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.
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2511- Print job (name) has been canceled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) has been canceled.

2521- Unable to program controller.

2522- Invalid controller application file.

2523- Programming controller failed.

2524- CRC check failed on programming controller.

2525- Unknown error programming controller.

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files from the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the DigiSizer analysis program.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.
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2526- Controller download was not successful.

2527- Controller CRC error on boot block.

2528- Controller DRAM error.

2529- Controller Com1: error.

2530- Controller Com2: error.

2531- Controller debug port error.

2532- The instrument contains an unknown software version. Do you want to reset it?

2533- Analyzer initialization failed.

Cause: A communications problem between the computer and the analyzer 
has occurred.

Action A: Check the cable connection between the computer and the analyzer.

Action B: Exit the Saturn DigiSizer application, and turn off the analyzer and liq-
uid sample handler. Then turn on the liquid sample handler first, the 
analyzer second, and restart the Saturn DigiSizer application. If the 
problem persists, contact your local Micomeritics representative.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: The application has discovered a different version of software operat-
ing in the instrument. 

Action: If there is no chance that an instrument other than the Saturn DigiSizer 
is connected to the computer, select Yes to reset the instrument and 
download the proper software. Otherwise, select No to leave the instru-
ment unchanged.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.
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4200 Series

4200- An error occurred while loading the application control information. Data entry 
cannot be performed. (Code # [n])

4201- No reports selected.

4202- No valid data to report.

4203- The reference file is not valid. ‘Diff. from ref.’ column was deleted.

Cause A: You may not have full rights to the application’s folders and files.

Action A: Contact your system administrator to have full rights granted.

Cause B: An internal error occurred while read control information was being 
read from a disk file.

Action B: The disk on which the application is installed may have failed. Contact 
your Micromeritics service representative and report the code number 
given in the message.

Cause: You failed to select reports in the Reports to Generate list box. No 
output could be produced.

Action: Ensure that at least one report is selected for the sample and reinitiate 
the report.

Cause: The sample file you selected for reporting does not contain any valid 
data.

Action: If the sample is still analyzing, wait until enough data are collected to 
allow reporting. If the sample file has a Complete status, an error or 
operator intervention stopped the analysis before sufficient data were 
collected. The analysis may be deleted from the file.

Cause: You requested a tabular report with Difference from reference 
selected as one of the columns. This quantity cannot be computed 
because the reference file is invalid.

Action: Select a reference file containing valid data.
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4204- Coarser specification file is not valid. ‘Out of spec.’ column was deleted.

4205- Finer specification file is not valid. ‘Out of spec.’ column was deleted.

4206- The tabular report has no valid columns selected. No report produced.

4207- No valid data is available for this report. No report produced.

4208- An overlay file is not valid. It was not included in the report.

Cause: You requested a tabular report with Out of Specification selected as 
one of the columns. This quantity cannot be computed because the 
coarse specification file is invalid.

Action: Select a file containing valid data.

Cause: You requested a tabular report with Out of Specification selected as 
one of the columns. This quantity cannot be computed because the 
finer specification file is invalid.

Action: Select a file containing valid data.

Cause: You requested a tabular report with all of the columns set to none.

Action: Edit the options for that table and select a variable in at least one col-
umn of the table.

Cause: You selected a test in the sample file that does not contain valid data.

Action A: If the sample is still analyzing, wait until enough data are collected to 
allow reporting. 

Action B: Choose another test on which to report. If the sample file has a Com-
plete status, an error or operator intervention stopped the analysis 
before sufficient data were collected. The analysis may be deleted from 
the file.

Cause: You selected a sample file for overly that contains invalid data.

Action: On the Report Options dialog, click Overlays and remove the file and 
choose one containing valid data.
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4209- The reference file is not valid. The report was not produced.

4210- Coarser specification file is not valid. The report was not produced.

4211- Finer specification file is not valid. The report was not produced.

4212- At least one report item must be selected. Press Cancel if you do not want a 
report.

4213- Are you sure you want to delete the test?

Cause: You selected the Difference from Reference report; it cannot be com-
puted because the reference file is invalid.

Action: You selected a file for reference that contains invalid data; choose a 
different file.

Cause: You selected the Out of Specification report; it cannot be computed 
because the coarse specification file is invalid.

Action: You selected a file that contains invalid data; choose a different file.

Cause: You selected the Out of Specification report; it cannot be computed 
because the finer specification file is invalid.

Action: You selected a file that contains invalid data; choose a different file.

Cause: You failed to select reports in the Reports to Generate list box. No 
output could be produced.

Action: Ensure that at least one report is selected for the sample and reinitiate 
the report.

Cause: You clicked Delete on the Collected Data dialog to delete a test.

Action: Click Yes to remove the indicated test from the sample file; click No to 
allow the test to remain in the file.
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4214- The reference file is not valid. The overlay was not produced.

4215- Coarser specification file is not valid. The overlay was not produced.

4216- Finer specification file is not valid. The overlay was not produced.

4217- No table entries are within the distribution limits.

4218- In order to use (option) you must select a Statistics Type or Arithmetic Statis-
tics Type.

4219- In order to display summary statistics, you must select a Distribution Type.

Cause: The reference file specified in the current file does not exist.

Action: On the Report Options dialog, click Reference and choose a different 
file.

Cause: The file specified for the coarser specification does not exist.

Action: On the Report Options dialog, click Specification and choose a dif-
ferent file.

Cause: The file specified for the finer specification does not exist.

Action: On the Report Options dialog, click Specification and choose a dif-
ferent file.

Cause: Truncate to distribution limits is selected on the report editor, but 
table entries are not within the range of the collected data.

Action: Edit the table entries, or deselect Truncate to distribution on the 
report editor.

Cause: You requested a Summary report, but did not select a Statistics Type.

Action: Edit the Summary report and select at least one Statistics Type.

Cause: You requested a Summary report but did not select a Distribution Type.

Action: Edit the Summary report and select a Distribution Type.
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6000 Series

6003- New data reduction options are currently being applied to the test data. Do you 
wish to cancel the reprocessing?

6004- All of the test data will be converted to the new data reduction options. Do you 
wish to continue?

6005- Model generation is already in progress. Only one generation is allowed at a 
time.

6006- Application of new data reduction options to <file name> is complete.

6007- A new model generation cannot be started. One is already in progress.

Cause: You have requested to cancel the reprocessing of the intensity data.

Action: Select Yes to cancel the reprocessing. Select No to continue the repro-
cessing.

Cause: You requested Scattering Model Advanced Options to be applied to 
collected data.

Action: Select Yes to convert the data to the new data reduction options, and 
No to stop the reprocessing.

Cause: You requested  that a new scattering model be generated, but one is 
currently being generated.

Action: Wait for the current model to complete its generation process and then 
try again.

Cause: You requested Scattering Model Advanced Options to be applied to 
collected data and the process is now complete.

Action: None required; notification message only.

Cause: You requested  that a new scattering model be generated, but one is 
currently being generated.

Action: Wait for the current model to complete its generation process and then 
try again.
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6008- Error loading the model generation task. Error code: <number>

6009- An error occurred while converting <file name> to a new model. All further pro-
cessing aborted.

6010- An unusual condition occurred while converting <file name> to a new model. 
Processing will continue.

6014- Sample (file name) has an invalid status and cannot be used for this analysis.

6015- The liquid selected for the analysis in sample (file name) does not match the 
background.

Cause: An error occurred while generating the model, probably due to a prob-
lem with the background generation application.

Action: Reinstall the software and try again.

Cause A: You chose a sample file that has no tests remaining for analysis. 

Action A: Choose a sample file with a status of No Analysis or Complete. Eight 
tests can be performed using one sample file. 

Cause B: You chose a sample file that is currently in an analyzing or calculations 
state.

Action B: Watch the status window and proceed when the status window indi-
cates analysis and/or calculations are complete.

Cause: You attempted to begin an analysis, but the analysis liquid specified in 
the sample file did not match that of the current background.

Action A: Measure a new background with the proper liquid and continue with 
analysis.

Action B: Choose a sample file that matches the dispersing liquid of the current 
sample and background.
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6016- Warning, the instrument is not calibrated.

6017- Error accessing the sample information file <name>.

6018- File <file name> already has all its tests filled.

6020- File <file name> cannot be analyzed. It is currently being edited.

Cause: You attempted to begin an analysis, but the instrument is not fully cal-
ibrated.

Action A: Exit the analysis program and turn off the analyzer. Turn the analyzer 
back on and restart the analysis program. Select Unit [n > Unit Con-
figuration to verify that calibrations are installed (calibration items 
will contain dates). If no information displays for the calibration items, 
go to Action B. 

Action B: Contact your Administrator to reinstall the calibration files.

Cause: An unexplained error prevents you from accessing this file.

Action: The hard disk drive may be corrupt. Run diagnostics.

Cause: You tried to insert a new test using a sample file which already contains 
eight tests.

Action: A single sample file can have a maximum of eight tests. If additional 
tests are required on this sample, you must create another sample file.

Cause: You selected a file that was still open in an editing window for anal-
ysis.

Action: Finish the changes to the sample file, then save and close the editing 
window.
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6021- An analysis cannot be performed on <file name>. It is open for editing and con-
tains errors.

6022- The edit session for <file name> must be saved before the analysis. Save 
changes and continue with the analysis?

 6023- An error occurred while loading the scattering models. Data reduction cannot 
be performed.

6024- An automatic analysis mode is enabled. The sample defaults may not be edited 
while this mode is active.

6025- Unable to find optical model <file name>.

Cause: You selected a file that is currently being edited. Editing cannot be fin-
ished because the sample contains entry fields with errors.

Action: Correct the errors and finish editing the sample file. Then save, close 
the editing window, and try opening the file again.

Cause: You selected a file for analysis that is currently being edited. The 
changes to this file must be saved before it can be used in an analysis.

Action: Click Yes to save the changes and proceed with the analysis. Click No 
if you wish to review the changes before you save them.

Cause: The application was unable to load the scattering models properly.

Action: Exit the application and reinstall the software.

Cause: One of the automatic analysis modes is active. Sample defaults cannot 
be edited while this mode is active.

Action: End all automatic analysis modes on all attached units and try again.

Cause: The model used by the sample could not be loaded.

Action: Select the Options push button on the Materials Properties dialog and 
make sure the selected model exists.
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6026- The angles of the optical <file name> do not match the collected data.

6027- The size classes of the optical model <file name> do not match the standard 
size classes.

6028- Cannot read the deconvolution results.

6029- Cannot execute the deconvolution application.

6042- Unable to download CCD characterization data.

6043- Unable to download calibration data.

6045- CCD characterization data not found.

6046- Calibration data not found.

Cause: An error occurred during deconvolution of the model, probably due to 
a problem with the background calculation application.

Action: Reinstall the software and try again.

Cause B: A model file generated for the DigiSizer 5200 was used with the
DigiSizer 5205 application.

Action B: Remove DigiSizer 5200 model files from the model directory and 
install or calculate models for the DigiSizer 5205 application.

Cause A: A communications error occurred between the computer and the 
instrument during initialization. 

Action A: Exit analysis program and turn off the analyzer. Ensure that the ether-
net cable is securely connected to the computer and the analyzer. Turn 
on the analyzer and restart the program. 

Contact your Micromeritics service representative if the problem per-
sists.

Cause B: System components were not turned on in the proper order.

Action B: Refer to Turning on the System in Chapter 2 for the correct sequence.

Cause: The calibration file for this analyzer could not be found.

Action: Insert the CD containing your analysis program and reinstall the cali-
bration file.
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6054- Unknown error downloading CCD characterization data.

6056- Unable to establish the TCP connection with the instrument.

6058- Unrecognized sample handler.

Cause A: A communications error occurred between the computer and the 
instrument during initialization. 

Action A: Exit analysis program and turn off the analyzer. Ensure that the ether-
net cable is securely connected to the computer and the analyzer. Turn 
on the analyzer and restart the program.

Cause B: The calibration file for this analyzer could not be found.

Action B: Insert the CD containing your analysis program and reinstall the cali-
bration file.

Action C: If Actions A and B do not correct the problem, contact your 
Micromeritics service representative.

Cause: A communications problem between the computer and the analyzer 
has occurred.

Action A: Check the cable connection between the computer and the analyzer.

Action B: Exit the Saturn DigiSizer application, and turn off the analyzer and liq-
uid sample handler. Then turn on the liquid sample handler first, the 
analyzer second, and restart the Saturn DigiSizer application. If the 
problem persists, contact your local Micomeritics representative.

Cause: A communications problem between the analyzer and liquid sample 
handler has occurred.

Action A: Check the cable connection between the analyzer and the liquid sample 
handler.

Action B: Exit the Saturn DigiSizer application; turn off the analyzer and liquid 
sample handler. Then turn on the liquid sample handler first, the ana-
lyzer second, and restart the Saturn DigiSizer application. If the prob-
lem persists, contact your local Micomeritics representative.
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6060- Invalid laser parameters

6069- Detector: Laser interlock disabled.

6070-  Detector: DAC timeout (type: X)

6071-  Detector: Exposure timeout (status: X, delay: X sec)

6072-  Detector: ADC busy (type: X, status: X)

6073-  Detector: ADC out of range (type: X, LD: X, BT: X)

6074-  Detector: Timeout on waiting for pixel buffer.

6075-  Detector: Pixel buffer X is not ready.

6076-  Detector: Filter move timeout (type: X, status: X)

6077-  Detector: Filter move failed (type: X, status: X)

6078-  Detector: CCD temperature out of range (A/D: X)

6079-  Detector: CCD setpoint out of range (A/D: X)

6080-  Detector: Laser temperature out of range (A/D: X)

6081-  Detector: Laser setpoint out of range (A/D: X)

6082-  Detector: Detector temperature out of range (A/D: X)

6084-  Rotator: Rotation timeout (steps = X, status = X, X)

6085-  Rotator: Output timeout (status = X).

6086- Rotator: Interlock disabled.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: The analyzer’s front panel is not closed properly.

Action: Be sure the front panel is closed completely. If problem persists, con-
tact your local Micromeritics representative.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: The analyzer’s front panel is not closed properly.

Action: Be sure the front panel is closed completely. If problem persists, con-
tact your local Micromeritics representative.
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6087-  Rotator: Position unknown.

6088-  Rotator: Command error (status = X).

6089-  Rotator: Position error (status = X).

6090- LSHU: Error sending message.

6091- LSHU: Error receiving message.

6092- LSHU: Error parsing message (options=X, state=X)

6093- LSHU: Error circulating pump thermal overload.

6094- LSHU: Error 24 Volt line is not available.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: A communications problem between the analyzer and liquid sample 
handler has occurred.

Action A: Check the cable connection between the analyzer and the liquid sample 
handler.

Action B.: Exit the Saturn DigiSizer application; turn off the analyzer and liquid 
sample handler. Then turn on the liquid sample handler first, the ana-
lyzer second, and restart the Saturn DigiSizer application. If the prob-
lem persists, contact your local Micomeritics representative.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.
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6095- MasterTech: Not responding.

6096- MasterTech: Error moving arm (expected X, actual X)

6097- MasterTech: Stirrer on/off error (expected X, actual X)

6098- MasterTech: Stirrer speed error (expected X, actual X)

6099- MasterTech: Pump on/off error (expectedX, actual X)

6100- MasterTech: Pump direction error (expected X, actual X)

6101- MasterTech: Ultrasonic on/off error (expected X, actual X)

6102- MasterTech: Error moving turntable (expected X, actual X)

6103- MasterTech: Error querying

6104-  MasterTech: Error getting status

6105- Detector operation: Error light dose offset out of range (X).

6106- Detector operation: Error beam transmittance offset out of range (X).

6107- Detector operation: Error light dose integrating offset out of range (X)

6108- Detector operation: Error beam transmittance integrating offset out of Range 
(X).

6109- Detector operation: Error light dose offset calibration failed (X,X).

6110- Detector operation: Error light close integrating offset calibration failed (X, X).

Cause: A communications problem between the analyzer and the MasterTech 
has occurred, or the MasterTech has malfunctioned.

Action A: Check the cable connection between the analyzer and the MasterTech.

Action B: Exit the Saturn DigiSizer application, and turn off the analyzer, the liq-
uid sample handler, and the MasterTech. Then turn on the MasterTech 
first, the liquid sample handler second, and the analyzer third. Restart 
the Saturn DigiSizer application. if the problem persists, contact your 
local Micromeritics representative.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.
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6111- Detector operation: Error, unable to calculate beam center (X).

6112- Detector operation: Beam angle adjusted (X).

6113- Detector operation: Error, unable to select optic axis.

6114- Detector operation: Error, unable to locate optic axis (X,X).

Cause: Excessive vibration is preventing repeatable beam center alignment.

Action A: Position the liquid sample handler so that only the soft foam rings sur-
rounding the cell tubing are in contact with the analyzer, creating a 
light, tight seal. Metal-to-metal contact causes excessive vibration of 
the analyzer.

Action B: Minimize external sources of vibration. If problem persists, contact 
your local Micromeritics service representative.

Cause: Realignment of the beam center caused a rotator angle adjustment.

Action: None required.

Cause: Too many CCD pixels near the focused laser beam have been tempo-
rarily marked as defective.

Action: Exit the analysis program and turn off the analyzer. Wait approximately 
one minute; turn on the analyzer and restart the program.

If the problem persists, contact your Micromeritics service representa-
tive.

Cause: Excessive vibration is preventing repeatable beam center alignment.

Action A: Position the liquid sample handler so that only the soft foam rings sur-
rounding the cell tubing are in contact with the analyzer, creating a 
light, tight seal. Metal-to-metal contact causes excessive vibration of 
the analyzer.

Action B: Minimize external sources of vibration. If problem persists, contact 
your local Micromeritics service representative.
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6115- Detector operation: Error finding rotation lower limit switch.

6116- Error, timeout on draining reservoir.

6117- Error, timeout on filling reservoir. Make sure there is liquid present and resume 
the analysis.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause A: Drain tubing may be obstructed

Action A: Ensure that the drain tubing is unobstructed and the outlet end is not 
submerged in the waste liquid. 

Cause B: A drain valve or level sensor malfunction has occurred.

Action B: Access the instrument schematic and enable manual control. Open and 
close the drain valve several times. Then rinse the system. If the prob-
lem persists, contact your local Micromeritics service representative.

Cause A: The analysis or rinse liquid inlet tubing is out of liquid.

Action A: Check the analysis and rinse liquid tubes to ensure that they are both 
submerged and have adequate supplies of liquid.

Cause B: The analysis or rinse pump is unable to prime itself.

Action B: Raise the liquid container above the liquid sample handler and resume 
operation. After the liquid has started to pump, place the container 
back in its normal position.

Cause C: A hardware malfunction has occurred.

Action C: Contact your local Micromeritics service representative.
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6118- Error, fill stabilization failed after X tries.

6119- Error, rinse failed after [n] tries. Current obscuration [n]. Required obscuration 
[n].

6120- Error, ultrasonic probe is out of liquid.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause A: The cell and liquid sample handler are clean, but the beam transmit-
tance has changed since the last background measurement.

Action A: Perform a background analysis.

Cause B: The liquid sample handler and/or sample cell are dirty and cannot be 
cleaned by rinsing.

Action B: Use a surfactant that will effectively remove the contamination and 
perform a rinse, or manually clean the sample cell and the liquid sam-
ple handler.

Cause C: The rinse liquid differs in transmittance from the liquid used in the cur-
rent background measurement.

Action C: Perform as many rinses as is necessary to clean the system. Do not use 
the Autorinse function with a liquid which differs substantially in 
transmittance from the last background analysis liquid. Always per-
form a background measurement with the current analysis liquid 
before analyzing samples.

Cause: Ultrasonic probing was requested when the liquid level was not at least 
primed.

Action: Fill the liquid sample handler with liquid before turning on the probe.
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6121- Error, Maximum number of overrange pixels was exceeded (X, X).

6125- The instrument <serial number> is not calibrated.

6128- Invalid deconvolution results.

6129- Sample (file name) already contains eight tests and cannot be used for an 
analysis.

6130- No data available in file <file name> for reporting.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: You started the application program, but no calibration files were found 
for the attached instrument.

Action: Contact your Administrator and have the calibration files reinstalled.

Cause: The deconvolution was unable to create a valid particle size distribu-
tion from the collected intensity data.

Action A: Make sure enough sample was used in the analysis to provide good 
intensity data.

Action B: Measure a background to ensure that this information is still valid.

Cause: The analysis could not be started because the sample file contains the 
maximum eight tests allowed. The sample file has been removed from 
the schedule and replaced with an empty entry.

Action: Remove the empty entry. If desired, click Insert to create a replace-
ment entry and choose or create a new sample file. Click Start to 
restart the MasterTech schedule.

Cause: You requested that a report be generated on a sample containing no 
particle size data.

Action: Wait for the completion of at least one test, and then try again.
A-32                                                   520-42812-01 (Rev G) - Nov 2018



Saturn DigiSizer II 5205 Confirm Appendix A
6132- Warning, the default sample file does not request a rinse after analysis.

6133- Configured serial number does not match instrument.

6135- Detector Operation: Warning, beam center drive current adjusted from [nn.nn] 
to [nn.nn].

6136- Detector Operation: Error, beam center too large.

6137- Detector Operation: Error, beam center underrange.

Cause: You selected the QuickStart Autodetect mode of analysis, but the 
default sample file does not specify a rinse after analysis. This may 
result in repeated analyses of the same physical sample.

Action: Unless you plan to repeat the analysis on the same sample, cancel the 
QuickStart window. Access Sample defaults from the Options menu 
and specify to rinse after analysis. Then restart the QuickStart mode.

Cause: The instrument serial number specified for this unit during installation 
does not match the serial number recorded in the attached instrument. 

Action: Attach the correct instrument, or run the Setup program and install the 
calibration files for the correct instrument serial number. The instru-
ment serial number is located on the back panel of the analyzer.

Cause: Operating characteristics of the laser have changed since the last focus 
calibration.

Action: A new focus calibration is recommended. The analyzer will continue to 
function properly. Contact your local service representative.

Cause A: There is an obstruction or dirt in the optical path.

Action A: Remove the obstruction or clean the dirty lens or cell. Refer to Clean-
ing the Optics in Chapter 8 for instructions on cleaning the optics.

Cause B: A problem has developed in the laser or detector system.

Action B: Contact your local Micromeritics service representative.
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6138- Detector Operation: Error, beam center overrange.

6139- Detector: Temperature in calibration mode, temperature control disabled.

6140- Detector Operation: Error, temperature not in calibration mode.

6141- Detector Operation: Error, temperature calibration out of range (A/D: nnnn).

Cause: A problem has developed in the laser or detector system.

Action: Contact your local Micromeritics service representative.

Cause: A temperature calibration was performed on your analyzer and a prob-
lem has occurred.

Action: Contact your Micromeritics service representative.
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Unnumbered Messages

These messages display on the instrument schematic as yellow text on a red background in 
the area of their associated component.

Liquid Sample Handler

24Volt Failure
Thermal Overload

Laser

Filter Error: Sensors on
Filter Error: Sensors off

Laser disabled

Laser temperature invalid

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The front panel of the analyzer is open.

Action: Ensure that the front panel is completely closed before beginning an 
operation. If the message remains on the screen after closing the front 
panel, contact your local Micromeritics service representative.

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.
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Laser temperature out of band

Laser thermal overload
Temperature control disabled

Test switch on

Rotation Arm

Rotator thermal overload

Cause: Instrument initialization is in progress.

Action: None required; the message will disappear after initialization is com-
plete. If the message should remain displayed on the screen after 
approximately 10 minutes, contact your local Micromeritics service 
representative.

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.

Cause: A manufacturing test switch was accidentally left turned on.

Action: None required; the message will disappear when the laser is activated.

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.
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Charge-Coupled Device (CCD)

CCD temperature invalid

CCD temperature out of band

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.

Cause: Analyzer initialization is in progress.

Action: None required; the message will disappear after initialization is com-
plete. If the message should remain displayed on the screen after 
approximately 10 minutes, contact your local Micromeritics service 
representative.
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B.  SAMPLE DISPERSION AND CONCENTRATION

Sample dispersion and concentration plays a vital part in obtaining accurate and reliable 
results. This appendix provides a discussion on dispersion techniques and sample concentra-
tion in relation to obtaining an appropriate beam obscuration for your sample.

Sample Dispersion 

Sample materials should be well dispersed in a liquid of known density and viscosity and the 
difference between the powder and liquid densities be accurately known. Viscosity and density 
data for some common liquids are given in Appendix D. Handbook values for other liquids 
are usually sufficiently accurate, so the latter requirement means that only the powder density 
must be determined if it is unknown and if composition information does not permit calcula-
tion from handbook values. For this, one of Micromeritics’ pycnometers is recommended. 

The liquid should be one in which the powder can be completely dispersed (separated into 
unattached particles) for accurate size results to be obtained. Obviously, the liquid should be 
nontoxic, readily available, and one in which the sample is insoluble. Complete insolubility 
may be difficult to achieve in some instances. Solubility problems may be minimized by 
allowing the liquid to stand in contact with the particle material prior to using the liquid for the 
test sample. This cannot completely eliminate problems, however, because particle solubility 
is a function of particle size. Small particles are more soluble than large ones; in a dispersion 
of different sizes, the smallest particles tend to go into solution while precipitation occurs on 
the larger particles. 

There are no established rules or laws by which complete particle dispersion can be assured. 
Only guidelines can be offered. Some powders disperse easily in any of several liquids and 
remain so while others require careful attention to conditions in order to achieve dispersion 
and are prone to reagglomerate if conditions shift a small amount. A few can be dispersed only 
after extended treatments.

Agitation, resulting in the application of strong shear forces, aids dispersion. The more rigor-
ous the agitation — perhaps carried out in a high-speed blender, homogenizer, or an ultrasonic 
device — the better generally is the dispersion. Stirring a suspension while subjecting it to 
ultrasonic dispersion generally achieves the best dispersion because this ensures that all por-
tions of the mix are brought into the zones of greatest energy. For a few friable materials, such 
agitation can result in comminution of the particles for which measurements are desired. This 
is not likely to be the case with solid particles, particularly when the particles are under 50 to 
100 mm in diameter.

Air bubbles cause misleading results if trapped in the liquid during agitation. Care should be 
taken to avoid bubble entrapment, especially when the liquid is highly viscous. The Saturn 
DigiSizer performs bubble elimination routines and checks to verify their effectiveness, but 
the best agitation procedure is one that does not introduce them in the first place.
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Chemical wetting or dispersing agents also generally aid dispersion. A great variety of such 
products are marketed. Appendices C and E list some of the more useful dispersing aids, as 
well as sources for some of these materials. These agents have been found useful for particle 
dispersion in Micromeritics’ Materials Analysis Laboratory but are not the only agents avail-
able. 

Some commercial surfactants are intended for use in specific pH ranges and in particular non-
aqueous solutions. Slight solution composition differences may alter the effectiveness of any 
agent. The chemical supplier should be contacted about this type of problem. Sometimes 
merely shifting the pH of an aqueous dispersion will yield great improvements in the degree of 
dispersion. Metal oxides and metals that are likely to have oxide layers on their surface ordi-
narily are most easily dispersed in mildly alkaline media. Metal powders with any likelihood 
of grease on them should always be degreased prior to a dispersion attempt. Noble metal pow-
ders usually need a wetting agent for good dispersion. Dispersions involving hydrocarbon 
liquids that are immiscible with water are often difficult to make unless the powder is quite 
dry. Sometimes moisture picked up from the air is more than enough to cause difficulties.

Some powders flocculate upon standing a few moments after having been dispersed. Floccula-
tion, of course, prevents accurate particle size analysis, and better dispersion and stabilization 
techniques must be sought.

As a general guide, the best dispersing technique (includes agent and procedure) is the one 
producing consistently the finest distribution of sizes. We make this assertion because of the 
high reproducibility of the DigiSizer when presented identical samples. If the sample prepara-
tion technique is deficient in freeing particles one from another or if, though unlikely, it is 
producing particle fracture, this will be evidenced by an inconsistency of results.

The rheological behavior of high concentrations of fine powder in a liquid gives a good pre-
liminary indication of the suitability of both the liquid medium and the dispersing agent. Some 
powders containing as much as 50 percent liquid act as if they were almost a solid mass, but a 
few tenths of a percent of wetting agent can cause the mass to take on the consistency of soup. 
This reaction is indicative of a very good agent. The effect will not often be so dramatic, but 
working the mass with a spatula will give a good indication of the efficacy of an agent.

A test for the optimum quantity of a dispersing agent is conducted by measuring the sediment 
volume from a slurry of about 5 weight percent concentration. The slurry and agent must be 
mixed and allowed to stand in a sedimentation tube undisturbed by either mechanical vibra-
tions or thermal currents. The minimum sediment volume indicates the best agent 
concentration level. If several dispersing agents are compared at the same time, the minimum 
sediment volume is also a measure of the best dispersing agent.
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Sample Concentration

After you choose a sample file and click Next, a window showing the beam obscuration based 
on your sample’s concentration is displayed.

While observing the beam obscuration and concentration, gradually add your sample to the 
reservoir. Use the following guidelines for your sample concentration:

If your beam obscuration level is too high, the Adjust push buttons on the right side of the dia-
log can be used to add more liquid. If the Autodilute function is being used, concentration 
adjustment will be made automatically.

If your beam obscuration level is too low, simply add more sample. If the reservoir is too full, 
again you can use the Adjust push buttons to adjust the liquid level.

Listed below are some guidelines for sample concentration in relation to attaining an appropri-
ate beam obscuration for various sized particles.

Expected Mean Particle Diameter
(micromerters)

Recommended Beam Obscuration
(%)

Less than 0.1 4

0.1 to 1 5 to 10

1 to 10 10 to 20

10 to 100 20 to 30

100 to 1000 30 to 45
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Small Particles and Multiple Scattering 

Analysis of small particles (<1 micrometer diameter) is subject to errors caused by multiple 
scattering, that is light scattered by one particle striking another particle and being scattered 
again. This effect increases as sample concentration increases, and causes the particle size to 
appear smaller than it is. 

To test for this:

1. Perform an analysis in the recommended beam obscuration range. Run two or more tests 
to ensure the results are repeatable, indicating that the dispersion is stable.

2. Dilute the sample to a lower beam obscuration, for instance 2% below the first beam 
obscuration. This is accomplished by clicking Adjust level to primed and observing the 
reduction in beam obscuration. Repeat as needed until the desired beam obscuration is 
achieved.

3. Perform another analysis of two or more tests and compare the results to the earlier tests. 
If the lower beam obscuration produces a significantly larger mean particle size, then 
significant multiple scattering may have occurred with the original concentration. Repeat 
these steps to determine the obscuration at which there is no significant multiple 
scattering. 

Note that analyzing with beam obscuration of less than 5% is not recommended, since there 
may not be enough scattered light for an accurate measurement. Running a background analy-
sis shortly before introducing sample may improve results from a low beam obscuration 
analysis.

Medium Size Particles

For particles in the range of 1 to 100 micrometers diameter, it is ideal to use a high enough 
sample concentration that the Goodness of Fit Report shows the measured intensities level out 
at smaller scattering angles before decreasing as scattering angle increases. This clearly 
defines the maximum particle size present. This can be important in detecting dispersion prob-
lems indicated by the apparent presence of larger than expected sizes.

Large Particles

For particles greater than 100 micrometers in diameter, relatively few particles are required to 
achieve a given beam obscuration. For this reason using a higher sample concentration can 
improve repeatability by increasing the number of particles, thus improving the sampling sta-
tistics and presenting a more representative sample of the material.
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C.  CHEMICAL AIDS FOR PARTICLE DISPERSION

Data extracted from McCutcheon’s Detergents and Emulsifiers, McCutcheon Division, MC Publishing 
Co., Glen Rock, NJ, 1980.

Name Type Active Ingredient

Aerosol 22 Anionic Tetrasodium N-(1,2-dicarboxyet hyl)-N-
octadecysulfosuccinanate, 35%

Aerosol OT Anionic Dioctyl ester of sodium sulfosuccinic acid, 70%

Atlas G-3300 Anionic Amine salt of alkylaryl sulfonate

Calcium Chloride Cationic CaCl2

Calgon Anionic Sodium hexametaphosphate, unadjusted

Calgon T Anionic Part of sodium replaced by other cations, predominantly zinc

Cobaltous Chloride Cationic CoCl2

Cobalt Citrate Anionic Co3(C6H5O7)2

Daxad 23 Anionic Sodium salts of polymerized substituted benzoid alkyl sulfonic 
acid (alkyl, long chain), 84.5%

Daxad 30 Anionic Sodium salt of polymerized carboxylic acid, 25%

FC-134 Cationic Fluorochemical surfactant

FC-161 Anionic Fluorochemical surfactant

FC-170 Nonionic Fluorochemical surfactant

Igepal CO-530 Nonionic Nonylphenoxypoly (ethyleneoxy) ethanol, 100%

Oleic Acid Anionic CH3(CH2)7CH=CH(CH2)7COOH

Renex 648 Nonionic Ethoxylated nonylphenol, 100%

Sodium Silicate Anionic Na2SiO3

Triton X-100 Nonionic Octyl phenoxy polyethoxy ethanol, 100%

Tamol SN Anionic Sodium salt of condensed naphthalene sulfonic acid, 100%

TSPP Anionic Tetrasodiumpyrophosphate, Na4P2O7

Twitchell Base 8240 Anionic Sodium salt of low molecular weight, sulfonated oil, parafin oil, 
water, and diethylene glycol

Tween 20 Nonionic Polyoxyethylene Sorbitan monolaureate (polysorbate 20), 100%

Zonyl S-13 Anionic Fluoroalkyl phosphate

Zonyl A Nonionic Ethylene oxide-ester condensate
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D.  LIQUID DENSITY AND VISCOSITY DATA

Listed below are density and viscosity of pure liquids and solutions (aqueous, by weight) as 
functions of temperature at atmospheric pressure.  

Liquid or Solution Temperature 
(ºC)

Density
 (g/cm3)

Viscosity 
(mPas)

Ethanol (absolute) 25
30
35

0.7851
0.7808
0.7764

 1.096
 1.003
 0.914

Ethylene Glycol 25
32
40

1.1100
1.1051
1.0995

 16.10
 12.18

9.13

Glycerol (10%) 25
30
35

1.0206
1.0192
1.0178

 1.1530
 1.0240
 0.9150

Glycerol (20%) 25
30
36

1.0452
1.0436
1.0400

 1.5430
 1.3590
 1.1743

Glycerol (40%) 25
30
35

1.0970
1.0948
1.0926

 3.1860
 2.7280
 2.3400

Glycerol (50%) 25
30
35

1.1238
1.1211
1.1182

 5.041
 4.247
 3.540

Hexane (n) 25
30
35

0.6550
0.6504
0.6459

 0.3046
 0.2900
 0.2828

Isopropanol 30
32
35

0.7769
0.7752
0.7728

 1.7800
 1.6800
 1.5400

Sucrose (20%) 20
30
40

1.0810
1.0777
1.0737

 1.945
 1.493
 1.184

Sucrose (30%) 20
30
40

1.1270
1.1232
1.1189

 3.187
 2.373
 1.833

Sucrose (40%) 20
30
40

1.1765
1.1721
1.1676

 6.167
 4.375
 3.241

Sucrose (50%) 20
30
40

1.2296
1.2250
1.2200

 15.43
 10.11

 6.991
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Data extracted from (with interpolation in some cases):

Honig, P., Principles of Sugar Technology, p. 31, Elsevier Publishing Co., New York, 1953.

Swindells, J.F., Snyder, C.F., Hardy, R.C. and Golden, P.E., Viscosities of Sucrose Solutions at 
Various Temperatures: Tables of Recalculated Values, Supplement to N.B.S. Circular 440, 
U.S. Government Printing Office, Washington, 1958.

CRC Handbook of Chemistry and Physics, 59th Edition, The Chemical Rubber Co., 
Cleveland, OH, 1978-79.

The Merck Index, 9th Edition, Merck & Co., Rahway, NJ, 1976.

Liquid or Solution Temperature 
(ºC)

Density
 (g/cm3)

Viscosity 
(mPas)

Water 26
32
38

0.9968
0.9951
0.9930

 0.8737
 0.7679
 0.6814

n-Butanol 25
32
40

0.8058
0.8003
0.7940

 2.59
 2.18
 1.78
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E.  SOURCES OF DISPERSING AIDS

Dispersant Source

Aerosol OT
Aerosol 22

American Cyanamid Company, Process Chemicals Department, One-T 
Cyanamid Plaza, Wayne, NJ 07470

Calcium Chloride Can be purchased at most laboratory supply houses.

Calgon
Calgon T

Calgon Corporation, Water Management Division, Calgon Center, P. O. Box 
1346, Pittsburgh, PA 15230

Cobalt Citrate Shepherd Chemical Company, Cincinnati, OH 45212

Cobaltous Chloride Can be purchased at most laboratory supply houses.

Daxad 23, 30 Hampshire Chemical Corporation, 55 Hayden Avenue, Lexington, MA 
02173

Dispex 40 Allied Colloids, 2301 Wilroy Road, Suffolk, VA 23434

FC-134, -161 and -170 3M Company, Chemical Division, 

St. Paul, MN 55141

Igepal CO-530 GAF Corporation, 1361-T Alps Road, Wayne, NJ 07470

Lomar D Henkel, 300 Brookside Avenue, Ambler, PA 19002

Oleic Acid Can be purchased at most laboratory supply houses.

Renex 648
Tween 20
Atlas  G-3300 

ICI Americas, Inc., Chemical Division, New Concord ville Pike, 
Wilmington, DE 19897

Triton X-100
Tamol SN

Rohm and Haas Company, Independence Mall West, Philadelphia, PA 19105

Sodium Silicate 
“N” Brand

Philadelphia Quartz Company, 1301-T E. Fort Avenue, Baltimore, MD 
21230

Tetrasodium
Pyrophosphate (TSPP)

Can be purchased at most laboratory supply houses.

Zonyl A, S-13  E. I. DuPont de Nemours and Company, Dyes and Chemical Division, 1000-
T Market Street, Wilmington,  DE 19898
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F.  DATA REDUCTION

The volume frequency data corresponding to standard size parameter classes is derived by 
deconvolution. The particle size for each class is derived by multiplying its size parameter 
by the wavelength of light produced by the laser in each instrument. The volume 
frequency data are expressed as a fraction of the total. 

The reference for calculation of various statistics is the ASTM Manual on Presentation of 
Data and Control Chart Analysis, Sixth Edition, by American Society for Testing and 
Materials. Other calculations have references as noted.

In the following calculations, log() always refers to log base 10. ln() refers to natural log.

Scattering Model Generation

Mie and Fraunhofer Calculations

Scattering models are theoretically derived patterns of light scattered by ideal, spherical 
particles of a known refractive index, based on Mie theory. The refractive index of the 
particle relative to the surrounding medium and the ratio of the diameter of the particle to 
the wavelength of the light are the two distinguishing parameters for each pattern. A 
simpler, diffraction-only Fraunhofer theory can also be used; it is independent of 
refractive index. The algorithms used for performing the Mie and Fraunhofer calculations 
as well as description of the theories are found in Absorption and Scattering of Light by 
Small Particles by Bohren and Huffman.

Volume Normalization

The Mie and Fraunhofer calculations give scattered light intensities and extinction 
coefficient for an individual particle. These intensities are normalized by particle volume 
so that all stored patterns are for a unit volume of sample.

Polarization

The calculations provide scattered intensities for light polarized parallel to and 
perpendicular to the polarization of the incident light. These two components are recorded 
separately. At the time the model is used, they are combined based on the polarization of 
the laser in the instrument.

Size Parameters

Models are calculated for a standard set of size parameters, or ratios of particle diameter to 
wavelength. The actual diameters represented must be calculated by multiplying the size 
parameter by the wavelength produced by the laser in each instrument.
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Size Subclasses

Each size class represents a continuum of sizes spanning the class interval. The Mie and 
Fraunhofer algorithms calculate a pattern for a single, discrete size. A representative 
scattering pattern for each class is computed by a weighted average of scattering patterns 
for different sizes spanning the class, called subclasses. The interval between the 
subclasses is 1/4 the interval between size classes. In addition to the five subclasses 
spanning the class interval (including both ends of the interval), the nearest subclass in 
each adjacent class interval is included for a total of seven subclasses combined in each 
class. This provides a fairly smooth transition in size class patterns. The patterns are 
combined using a cosine2 weighting function, with coefficients of 
{0.1464,0.5,0.8536,1.0,0.8536,0.5,0.1464}.

Angle Subclasses

Each angle class represents a continuum of angles spanning the class interval. The Mie 
and Fraunhofer algorithms calculate scattered light intensity for a set of discrete angles. 
An average intensity for each angle class must be computed by averaging over its angle 
interval. Scattering patterns for large particle sizes contain very high frequency changes in 
intensity with angle, requiring averaging over many discrete angles to compute an 
accurate average intensity. Patterns for small particle sizes have much less detail and 
require fewer discrete angles for accurate averaging. 

For averaging, each angle subclass intensity is weighted by its fraction of the total area 
subtended by the angle class, which is proportional to the cosine of the angle.

Scattering Vector

Plotting the scattered intensity data versus the magnitude of the scattering vector q is 
useful for comparing data on scattering independently of the scattered wavelength:

where

N = refractive index of surrounding medium
 = wavelength of light in a vacuum
 = scattering angle

q
4N


----------- 
    


2
--- 
 sin=
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Deconvolution

Deconvolution is the process of determining what distribution of scattering models for 
different size classes provides the best fit to the measured scattered intensity data for a 
sample. The inputs to deconvolution are a set of scattering models for different size classes 
and a set of measured scattered intensity vs. angle data. The output is a volume frequency 
distribution by size class that best fits the measured intensity data. 

The best fit is determined by a weighted, regularized nonnegative least squares method 
which minimizes |Ax - b| where A is a matrix of scattering models and regularization 
constraints, b is the measured intensity pattern, and x is the size distribution resulting from 
the fit. The matrix A and vector b are modified to weight the contribution of error for each 
measured intensity.

After A and b are constructed, the nonnegative least squares fit (NNLS) is performed as 
described in Solving Least Squares Problems, C.L.Lawson and R.J.Hanson, Prentice-
Hall,1974, p.160, with modifications described below.

Angle Classes and Size Classes

Each angle class with measured intensity data is included in the deconvolution. 

For each scattering model at one of the predefined size classes, a minimum amount of 
intensity data for the first lobe of the scattering pattern is required in order to characterize 
adequately the scattering model for that size class. This is expressed as the Minimum 
Fraction of First Lobe Classes.

For a given size class, let M be the index of the angle class where the first minimum in the 
intensity pattern occurs. 

Let N be the first angle class for which significant intensity data was measured, i.e. the 
first angle class with a Signal Fraction greater than or equal to the Minimum Significant 
Signal Fraction.

Then if (M - N) / M is greater than or equal to the Minimum Fraction of First Lobe 
Classes, the class is included. The largest size class satisfying this criterion is the largest 
class to be used in deconvolution, or the Maximum Size Class. The number of classes 
from this class to the smallest size class (inclusive) is the Number of Size Classes.

If the number of measured intensity data points is less than the Number of Size Classes, 
the Minimum Size Class is increased to make the number of intensity data points and the 
Number of Size Classes equal.
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Regularization

The result of the NNLS deconvolution is regularized by adding an additional set of 
constraints to minimize the second derivative of the solution vector (the frequency 
distribution). These constraints are weighted by an overall regularization parameter 
(RegParam = RegParamHigh, RegParamMed, or RegParamLow) based on the user input 
degree of smoothing from the Material Properties dialog. The regularization constraints 
form a tridiagonal submatrix appended to the matrix A as extra rows, with corresponding 
0’s in b. If there are M angle classes and N size classes, for angle class j and size class k:

   

using A k,-1 = A k,M = 0

AM+k,k-1 = Gk for k>0

AM+k,k = -2 x Gk

AM+k,k+1 = Gk for k>N

AM+k,i = 0 for all other i

bM+k = 0

Modifications to NNLS

After A and b are constructed as above, NNLS is performed as described in Lawson and 
Hanson with the following modifications:

Maximum Number of Iterations

A maximum number of iterations are performed before the result is returned.

Check for Repeats

After each iteration, the result is checked against each of the most recent iterations. If it is 
identical to any of them, the process is stopped and the result returned.

Fk  Ak j 1– 2 Ak j Ak j 1++– 2

j
=

Gk RegParam 1
Fk
-----ln=
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Dual Vector 

The dual vector in NNLS steps 2,3,4 is calculated for largest step size rather than for 
steepest descent. After vector w is calculated as in step 2, it is modified:

To shorten computation time by eliminating the addition of size classes that make an 
insignificant contribution, w j is tested against a cutoff value greater than 0:

where

DualThresh= the Dual Vector Threshold and the maximum intensity values 
as defined above.

Nonnegative Tolerance Parameter 

A Nonnegative Tolerance Parameter (referred to as Tau in L&H p.80-81) is used.

Also, this value times the sum of the solution vector is used instead of 0 as the lower limit 
for nonnegative elements in the solution vector (p.161 step 7).

Weighted Residual

The contribution of an individual intensity error to the total error or residual of the least 
squares fit is weighted by the fraction of the total intensity signal due to scattering (as 
opposed to background), and by the magnitude of the intensity:

Weighted Residual = 

wj

wj

Eij Eij 2
-----------------------------------=

cutoff DualThresh MaxModelIntensity
100

MaxIntensity
-----------------------------------=

Wi

ISCATi

ITOTi

----------------
 
 
  2

 ISCATi
  0.7–

=

ESQi
Wi

ISCATi
IFITi

–

IFITi

----------------------------------
 
 
  2

=

100 
ESQi
Wi

-------------------

 
 
 
  0.5
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where

Wi = weighting factor for intensity point i
ISCATi = scattered intensity for point i
ITOTi = total intensity (scattered plus background) for point i
IFITi = model fit intensity for point i
ESQi = error squared for point i
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Input Quantities

Standard Particle Size Classes and Standard Size Parameter Classes

For the predefined size classes:

The diameter interval bounds are spaced geometrically and the average diameter for each 
interval is the geometric mean of the high and low diameters of the interval. The low 
diameter for one interval or class is the high diameter for the next interval or class. For a 
diameter range of 0.1 to 1000.0 and 40 classes per decade:

ClassFact = ratio between adjacent class 
= ratio between adjacent class averages 
= 101/40 = 1.05925372518

The ratio between a class average and either of its class bounds is 

1.059253725181/2 = 1.0292005272

The average diameter array has 172 elements:

AvgDiam[172] =  {0.075,0.079,0.084,0.089,0.094,0.100,...,1000.0,1059.3, 
1122.0,1188.5,1258.9,1333.5,1412.5}

The diameter interval array has 173 elements: 

IntvlDiam[152] = {0.073,0.077,0.082,0.087,0.092,...,1090.2,1154.8,1223.2,
1296.7,1372.5,1453.83}

For a laser of the nominal wavelength, these particle size classes correspond to the size 
parameter classes for which the scattering models are generated and the deconvolution 
performed. Since all lasers will not have the nominal wavelength, a frequency distribution 
based on the standard particle size classes must be interpolated from the deconvolution 
distribution, which is based on the sizes derived from the actual laser wavelength and the 
standard size parameters:

ParticleDiameter = SizeParameter x Wavelength
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High/Low Diameter and Average Diameter

For the standard size classes:

Average Diameter is taken directly from the standard size class Average Diameter array 
AvgDiam[] above.

The High and Low Diameters for class i are:

HighDiami = IntvlDiam[i]
LowDiami  = IntvlDiam[i-1]

For user entered size tables:

The user entries are used as the IntvlDiam array as above, with the HighDiam and 
LowDiam values assigned from it. Note that there is always one less size interval than the 
number of entries in IntvlDiam.

AvgDiami is the geometric mean of HighDiami and LowDiami = 

(HighDiami x LowDiami)1/2
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Standard Sieve Sizes

ASTM E-11 standard sieve sizes and a few common sizes are used.

Sieve Number 
(in.)

Aperture Size
(m)

Sieve Number 
(in.)

Aperture Size
(m)

5 125000 No. 8  2360

4.24 106000 No. 10 2000

4 100000 No. 12 1700

3 1/2 90000 No. 14 1400

3 75000 No. 16 1180

2 1/2 63000 No. 18 1000

2.12 53000 No. 20 850

2 50000 No. 25 710

1 3/4 45000 No. 30 600

1 1/2 37500 No. 35 500

1 1/4 31500 No. 40 425

1.06 26500 No. 45 355

1 25000 No. 50 300

7/8 22400 No. 60 250

3/4 19000 No. 70 212

5/8 16000 No. 80 180

0.530 13200 No. 100 150

1/2 12500 No. 120 125

7/16 11200 No. 140 106

3/8 9500 No. 170 90

5/16 8000 No. 200 75

0.265 6700 No. 230 63

1/4 6300 No. 270 53

No. 3 1/2 5600 No. 325 45

No. 4 4750 No. 400 38

No. 5 4000 No. 450 32

No. 6 3350 No. 500 25

No. 7 2800 No. 635 20
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Graph Particle Size Intervals

The predefined standard particle size classes are always used in computing quantities for 
graphs. For merged or entered data, the extra data are shown at the intervals for which it 
was entered, except for the frequency data for which the predefined classes are extended 
to the range needed to make sure that all the frequency classes are of the same width. 

Interpolation

All interpolation is performed using the Akima semi-spline routine. Refer to BASIC 
Scientific Subroutines Vol. II, by F.R.Ruckdeschel, Copyright 1981 BYTE Publications/
McGraw Hill, p. 305. If the quantity to be used as either axis is a size quantity (diameter), 
the interpolation should be done on a log scale for that axis.

Merged Data

Merged data entries pre-empt compatible collected data;for example if overlap occurs, the 
merged data are reported and the overlapping sizes from the collected data are discarded. 

If sieve size data are entered for the merged data, the aperture size of the smallest sieve 
size used will not in general fall on a standard particle size class boundary. A `pbridge’ 
class must be constructed in this case extending from the minimum sieve aperture size to 
the next lower standard size class boundary. If the resulting class would be less than half 
the width (on the log diameter scale) of a standard size class, it is combined with the next 
lower standard size class which becomes the `bridge’ class. A cumulative coarser value is 
interpolated at the minimum aperture size from the collected data, which becomes the 
cumulative coarser value for the `bridge’ class. The frequency for the `bridge’ class can 
then be calculated from the cumulative coarser curve in the normal way. The `bridge’ class 
is treated as a collected data class for purposes of subsequent scaling and reporting.

If Autoscale percent/fraction of total sample is enabled on the Collected Data/ Merge Data 
dialog, the region of overlap between merge data and collected data is determined, and a 
scale (which is equal to the total frequency of the merged data in the overlap region over 
the total frequency of the collected data in the overlapped region) factor is determined. 
The collected data are then scaled by this factor. Finally, the frequency data over the whole 
range is rescaled to the total fraction accounted for by the merged data. All this is done in 
the Frequency fraction determined by the user (Volume/Area/Length/Number).

If Autoscale percent/fraction of total sample is disabled on the Collected Data/ Merge 
Data dialog, the entered percentiles/fractions for the merged data are used as is and the non 
overlapping portion of the collected data is scaled to be the percent/fraction passing the 
smallest sieve size used.
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Fundamental Quantities

Distribution Type (Volume, Area, Length, Number)

The base distribution data provided by the deconvolution is volume frequency fraction. 
Conversion of the distribution to area, length, or number is as follows for each size class:

or to convert back to Volume percent based on the others, 

These Formulae will automatically normalize the Frequency fractions to 100%. If there 
exists merged or entered data, the user may have chosen not to have this add up to 100%. 
If this is the case, a conversion into the style (Vol/Area/Len/Num) that he has chosen will 
also cause a rescaling to his chosen percentage, A conversion into a different style will 
automatically be rescaled to 100%. This affects the cumulative percentage as well as 
things like median diameter which are based on cumulative coarser. For distribution 
statistics, there is an implicit rescaling to 100%. 

Subsequent calculations based on the frequency distribution do not vary based on 
Distribution Type; therefore the formulas reference FreqFrac without specification of 
Distribution Type. 

AreaFreqFrac
VolFreqFraci / AvgDiami

VolFreqFrack / AvgDiamk
----------------------------------------------------------------------------=

LenFreqFraci

VolFreqFraci / AvgDiami 
2

VolFreqFrack / AvgDiamk 
2


--------------------------------------------------------------------------------=

NumFreqFraci

VolFreqFraci / AvgDiami 
3

VolFreqFrack / AvgDiamk 
3


--------------------------------------------------------------------------------=

VolFreqFraci

AreaFreqFraci / AvgDiami

AreaFreqFrack / AvgDiamk
-------------------------------------------------------------------------------=

VolFreqFraci

LenFreqFraci / AvgDiami 
2

LenFreqFrack / AvgDiamk 
2


--------------------------------------------------------------------------------=

VolFreqFraci

NumFreqFraci / AvgDiami 
3

NumFreqFrack / AvgDiamk 
3


-----------------------------------------------------------------------------------=
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Particle Size (Diameter/Radius)

Any particle size quantity or derived quantity having the same units can be expressed as 
radius or diameter.

Radius = Diameter / 2

Quantities include:

• Mean
• Mode
• Median
• Standard deviation (of the distribution)
• Confidence limits
• Size at User Defined Percentiles
• User Defined Sizes
• High particle size 
• Low particle size
• Average particle size
• Standard deviation for [n] tests of any of the above quantities

Percent/Fraction

Any cumulative quantity, frequency quantity, percentile, or derived quantity having the 
same units can be expressed as percent or fraction.

Pct = 100 x Frac

These include:

• Maximum Out of spec
• User Defined Percentiles 1 to 5
• Percent at User Defined Sizes 1 to 5
• Peak Report Minimum percent to report
• Peak Report Percent of distribution
• Cumulative Coarser/Finer
• Frequency
• Difference from reference
• Out of spec
• Standard deviation for [n] tests of any of the above quantities

Other quantities (Sample concentration, Beam obscuration) are calculated or stored as 
fractions but reported as percent.
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Cumulative Coarser/Finer, Retained/Passed

Any cumulative quantity can be expressed as Coarser or Finer (Retained or Passed on 
Tabular Report by Sieve Size).

For data defined by the standard class sizes (Summary, Tabular Defined by Size Class, 
Graphs):

 for all classes k such that AvgDiamk >

AvgDiami

 for all classes k such that AvgDiamk >

AvgDiami

 for all classes k such that AvgDiamk >

AvgDiami

 for all classes k such that AvgDiamk >

AvgDiami

or, equivalently

CumFracFineri = 1.0 - CumFracCoarseri-1 

CumFracRetaini = CumFracCoarseri-1 

CumFracPassi = 1.0 - CumFracCoarseri-1 

For Tabular Defined by Size Table or by Sieve Sizes:

CumFrac (Coarser or Finer, Retained or Passed) is calculated for the standard size classes 
as defined above. CumFrac is then interpolated from CumFrac vs. Particle Size at each 
Particle Size in the Size Table or Aperture Size in the Sieve Table.

CumFracCoarseri FreqFrack=

CumFracFineri FreqFrack=

CumFracRetaini FreqFrack=

CumFracPassi FreqFrack=
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Frequency

Frequency is always calculated for a class. It is always the difference in the 
CumFracCoarser at the upper bound and the lower bound of the class. If this is a standard 
class, it is calculated as follows

FreqFraci = CumFracCoarseri-1 - CumFracCoarseri

If it is not a standard class, The value of CumFracCoarser is interpolated at the two 
endpoints. 

User-Entered Percentile Size

If the UserPctn is larger then the total percentage accounted for by any merged or user 
entered data, then “ ***** ” is printed.

UserPctDiamn = Diameter interpolated from HighDiami vs. CumFracCoarseri at 
UserPctn

User-Entered Size Percent

UserDiamFracn = CumFracCoarser interpolated from CumFracCoarseri vs. 
HighDiami at UserDiamn

Peak Report Quantities

DiffFreqFraci = FreqFraci / log(HighDiami / LowDiami )

Starting at the small particle size end of the frequency distribution,

1. Scan DiffFreqFraci for a local maximum, i.e. DiffFreqFrack > DiffFreqFrack+1  and 
DiffFreqFrack > DiffFreqFrack-1 

AvgDiamk is the mode of the candidate peak.

2. If an unresolved peak remains from step 3 of the preceeding peak, the LowDiam from 
that unresolved peak is the LowDiam for this candidate peak. Otherwise, scan 
DiffFreqFraci from class k toward smaller particle sizes to find a local minimum, 

i.e. DiffFreqFracm  = 0  

or  DiffFreqFracm < DiffFreqFracm+1  and  DiffFreqFracm < DiffFreqFracm-1 

If DiffFreqFracm < (DiffFreqFrack* Minimum Peak Valley Decrease),LowDiamm is 
the LowDiam of the candidate peak. Otherwise, this is an unresolved peak and will 
be added to the previous peak.
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3. Scan DiffFreqFraci from class k toward larger particle sizes to find a local minimum, 

i.e.  DiffFreqFracn  = 0  

or  DiffFreqFracn < DiffFreqFracn+1  and  DiffFreqFracn < DiffFreqFracn-1 

If DiffFreqFracn < (DiffFreqFrack* Minimum Peak Valley Decrease), HighDiamn is 
the HighDiam of the candidate peak. Otherwise, this is an unresolved peak and will 
be added to the next peak. Record the LowDiam for this unresolved peak for use on 
the next peak and repeat from step 1.

4. Sum values of FreqFraci from i=m to i=n, but include only half of the FreqFrac 
values for end classes m and n. This is to split the frequency data between two 
adjacent peaks. 

If this is an unresolved peak as determined in step 2, add the sum to the Fraction of 
Distribution for the preceding peak and set the preceding peak’s HighDiam to n. 

Otherwise, if the sum is greater than or equal to the Minimum Fraction to Report, the 
candidate peak is qualified and the sum is the Fraction of Distribution. Other peak 
quantities are calculated using the same formulas as for the entire distribution, except 
only the range from class m to class n is used.

Otherwise, the candidate peak is disqualified.

5. In either case, peak identification repeats from step 1, starting with class n. When the 
end of the distribution is reached by scanning in either step 1 or step 3, peak 
identification is complete.

NOTES: 

In step 1 if the end of the distribution is reached on an increasing frequency slope, i.e. 
DiffFreqFrack > DiffFreqFrack-1, then class k is treated as the mode of a candidate peak 
and as the high size end of the candidate peak.

If the beginning or end of the distribution is reached while scanning for a local minimum 
in step 2 or step 3, the beginning or ending class is treated as the local minimum.

For calculating Standard Deviation for N Tests, peaks from the various tests are simply 
matched by their order, i.e. Peak 1 from Test 1 is matched with Peak 1 from Test 2, etc.. If 
all tests do not have the same number of peaks, Standard Deviation for N Tests is reported 
as “N/A.” If the peak numbers are not the same, and the user chose average of n tests. A 
single row is filled in with all N/A (including the peak number). 
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Size Statistics

Standard Deviation of Quantity for N Tests

For Quantity, substitute the variable name for which the standard deviation is being 
determined. The subscript k refers to the test number.

If NumTests <= 1, StdDevTestQuantity = 0. Else:

Mode

For a mode calculation, the definition of the standard classes is extended over the range of 
input for all the data; frequencies are calculated for these classes. It is this frequency data 
that are used in determining the peak quantities so that all the classes are of the same 
width.

ModeDiam = AvgDiami such that DiffFreqFraci is the maximum DiffFreqFrac

Median

MedianDiam = Diameter interpolated from HighDiam vs. CumFracCoarser at 
CumFracCoarser = .5. If the calculation is being done on a peak, the interpolation point is 
at CumFracCoarser = (CumFracCoarserm + CumFracCoarsern)/2.

MeanTestQuantity
Quantityk

NumTests
---------------------------------=

StdDevTestQuantity
Quantityk MeanTestQuantity– 2

NumTests 1–
-----------------------------------------------------------------------------------------------------=
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Arithmetic Calculations

Standard Deviation (of the distribution):

Standard Deviation (of the distribution):

Coefficient of Variation:

Skewness:

Kurtosis:

+x 

where x is the user-selected number.

–x 

where x is the user-selected number.

MeanDiam
FreqFraci AvgDiami

FreqFraci
-----------------------------------------------------------------=

StdDevDiam
FreqFraci (AvgDiami MeanDiam 2–

FreqFraci
-------------------------------------------------------------------------------------------------------=

CoefVar StdDevDiam
MeanDiam

----------------------------------=

Skew
FreqFraci (AvgDiami MeanDiam 3 / FreqFraci–

FreqFraci (AvgDiami MeanDiam 2 / FreqFraci– 
3/2

---------------------------------------------------------------------------------------------------------------------------------------------------------=

Kurt
FreqFraci (AvgDiami MeanDiam 4 / FreqFraci–
FreqFraci (AvgDiami MeanDiam 2 / FreqFraci– 

2
----------------------------------------------------------------------------------------------------------------------------------------------------- 3–=

PlusNSig MeanDiam x StdDevDiam+=

MinusNSig MeanDiam x StdDevDiam–=
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Geometric Calculations

Mean:

GeoMeanDiam = 10  

Standard Deviation (of the distribution):

Standard Deviation of Log (size):

Skewness of Log (size):

Kurtosis of Log (size):

+x:

where x is user-selected number.

–x:

where x is user-selected number.

FreqFraci  AvgDiami log
F reqFraci

-----------------------------------------------------------------------------

GeoStdDevDiam 10
StdDevLogDiam

=

StdDevLogDiam
FreqFraci AvgDiami  GeoMeanDiam log–log 2

FreqFraci
---------------------------------------------------------------------------------------------------------------------------------------------=

SkewLog
FreqFraci AvgDiami  GeoMeanDiam log–log 3 / FreqFraci

FreqFraci AvgDiami  GeoMeanDiam log–log 2 / FreqFraci 
3/2

-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

KurtLog
FreqFraci AvgDiami  GeoMeanDiam log–log 4 / FreqFraci
FreqFraci AvgDiami  GeoMeanDiam log–log 2 / FreqFraci 

2
------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 3–=

PlusNSigLog 10
GeoMeanDiam  x log(GeoStdDevDiam+ log

=

MinusNSigLog 10
GeoMeanDiam   x–  log(GeoStdDevDiam log

=
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Material Formulae

Relative refractive index

Relative refractive index is the complex quotient of the complex Particle refractive index 
and the real Analysis Liquid refractive index:

Sample Concentration

This is calculated exclusively for the collected and deconvoluted data.

BeamObscuration is obtained from collected data.

BeamLengthm = 5000
ExtCoefi = extinction coefficient for size class i, available from scattering model

Specific Surface Area

This is calculated exclusively for the collected and deconvoluted data.

ParticleDensity is obtained from the Material Properties.

RelRefIdx Re  ParticleRefIdx Re 
LiquidRefIdx

---------------------------------------------------=

RelRefIdx Im  ParticleRefIdx Im 
LiquidRefIdx

---------------------------------------------------=

ConcFrac BeamObscuration log

 
3
2
--- BeamLengthm 

ExtCoefiVolFreqFraci / AvgDiami
VolFreqFraci

-------------------------------------------------------------------------------------------------–

-------------------------------------------------------------------------------------------------------------------------------------------------------------=

SurfArea

6 
VolFreqFraci / AvgDiami 

VolFreqFraci
---------------------------------------------------------------------------

Particle Density
--------------------------------------------------------------------------------------=
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Specification/Reference Quantities

Out of Spec

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution.

CoarseSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Coarse Specification distribution interpolated if the bins are of different size. This is 

always the average of all the tests in that sample file1.

FineSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Fine Specification distribution interpolated if the bins are of different size. This is always 
the average of all the tests in that sample file*.

If { SampCumFracCoarseri-1 > CoarseSpecCumFracCoarseri-1}

OutSpecFracCoarseri = SampCumFracCoarseri-1 - CoarseSpecCumFracCoarseri-1 

Else if { SampCumFracCoarseri-1 < FineSpecCumFracCoarseri-1 }

OutSpecFracCoarseri = SampCumFracCoarseri-1  - FineSpecCumFracCoarseri-1 

Else  OutSpecFracCoarseri = 0

or 

OutSpecFracFineri = -OutSpecFracCoarseri-1 

OutSpecFracRetaini = OutSpecFracCoarseri-1 

OutSpecFracPassi = -OutSpecFracCoarseri-1 

Difference from Reference

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution

RefSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Reference Specification distribution interpolated if the bins are of different size. This is 
always the average of all the tests in that sample file*.

DiffRefCoarseri = SampCumFraci - RefCumFraci

1Always using the average of the tests in reference files is done so that printing out reports on a file will not 
affect its use as a reference.
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or

DiffRefFineri = -DiffRefCoarseri-1 

DiffRefRetaini = DiffRefCoarseri-1 

DiffRefPassi = -DiffRefCoarseri-1 

Maximum Out of Spec

MaxOutSpecFrac = maximum (abs value (OutSpecFraci ) )

Pass/Fail by Specification

If MaxOutSpecFrac = 0

PassFail = “PASSED by Specification”

ElsePassFail = “FAILED by Specification”
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SPC Report Variables

Regression Chart Variables

The line of best fit for the Regression Chart is calculated by the usual Least Squares 
method. Refer to BASIC Scientific Subroutines Vol. II, by F.R.Ruckdeschel, Copyright 
1981 BYTE Publications/McGraw Hill, p. 16. If there is only a single point, or all N points 
have the same x-value, there can be no line of best fit in the standard form.

The coefficient of Correlation for this line is also calculated in the usual way. Refer to 
Mathematical Handbook for Scientists and Engineers, by Granino A Korn, and Theresa 
M. Korn, Copyright 1961, 1968 McGraw Hill, Sec 18.4.

Xave
xi

N
------------=

Yave
yi

N
------------=

Slope
Sum xi XAve–  yi YAve– 

xi XAve– 2
--------------------------------------------------------------------------=

x

xi XAve– 2
N

----------------------------------------=

y

yi YAve– 2
N

----------------------------------------=

Cov x y 
xi XAve–  yi YAve– 

N
---------------------------------------------------------------------=

CorrelationCoef Cov x y 
xy

------------------------=
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Control Chart Variables

Mean
yi

N
------------=

StdDev
y Mean– 2
N 1–

--------------------------------------=

CoefVaar StdDev
Mean

-------------------=

PlusNSig Mean n StdDev+=

MinusNSig Mean n StdDev–=
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G.  FORMAT OF EXPORTED DATA

This appendix gives the format for sample files exported in ASCII text. All character 
strings are delimited with quotation marks; columns are separated with a comma and 
white space.

The following types of data can be exported:

• Particle Size
• Intensity

Particle Size Data

Record
Number Information Conveyed Form

1 File status
1 = complete
2 = analyzing
4 = entered
8 = no analysis

integer

2 Sample identification quoted string
(40 characters)

Merged Data (if present in sample file)

1 Blank line

2 Merged data indicator “Merged Data”

3 Distribution type
0 = volume
1 = area
2 = number
3 = mass

integer

4 Number of points integer

5 Particle size, cumulative fraction/percent
(units as per the data presentation settings, 
repeated for each point)

floating point,
floating point

Collected Data

1 Blank line

2 Test data identifier “Test n:” where n = 
test number
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Intensity Data

Record
Number Information Conveyed Form

3 Distribution type
0 = volume
1 = area
2 = number
3 = mass

integer

4 Number of points integer

5 Particle size, cumulative fraction/percent
(units as per the data presentation settings, repeated for 
each point)

floating point,
floating point

Records 1 through 5 repeated for every test in sample file. 
Test data identifier is changed accordingly.

Record
Number Information Conveyed Form

Intensity Data 

1 Blank line

2 Test data identifier “Test n:” where n = 
test number

3 Beam obscuration floating point

4 Polarization floating point

5 Laser wavelength floating point

6 Number of points integer

7 Bounding angle class, intensity
(repeated for each point)

floating point,
floating point

8 Bounding angle class floating point

Records 1 through 8 repeated for every test in sample file. 
Test data identifier is changed accordingly.
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Record
Number Information Conveyed Form

Background Data

1 Background data identifier “Background:”

2 Number of points integer

3 Bounding angle class, intensity
(repeated for each point)

floating point,
floating point

4 Bounding angle class floating point

Records 1 through 4 repeated for every test in sample file. 
Background data identifier is changed accordingly.
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H.  BACKGROUND QUALITY

The results from a background measurement show intensity versus angle when no sample 
is present in the system to scatter light. When all of the sample has been rinsed from the 
system and the cell is clean (as indicated by Curve A) in the illustration shown below), the 
background data will show the lowest possible light intensity levels, decreasing by about 
10 orders of magnitude from a maximum at 0.0025 degrees to a minimum near 48 degrees. 
The intensity will normally rise between 36 degrees and 44 degrees. Sharp steps at the 
boundaries between beam angles (e.g. at approximately four degrees) and other fine 
details are evident in the intensity curve. This is because unscattered, stray light is being 
measured, which varies discontinuously with incident beam angle.

When the system is inadequately rinsed or the cell is dirty, higher intensities are seen 
especially at larger angles (as indicated by Curve B). The data also appear to be smoother, 
showing less sharp detail. This is because contaminants are present and scattering light in 
a smooth, continuous fashion. These contaminants may be (1) particles (or bubbles) 
suspended in the liquid, (2) particles adhered to the inside of the cell, or (3) smudges, 
fingerprints, dust, etc. on the outside of the cell, on the detector lens, or on the collimator 
lens.
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To aid in recognition of a dirty system, the previous background data are shown overlaid 
with each new set at the end of the background measurement. If the current background 
curve is higher than the previous, some contamination may exist. Note that some small 
fluctuations in intensity at large angles can occur due to slight variations in the dissolved 
oxygen content, or variations in the amount of surfactant in the liquid.

For your convenience and as a reference for a good background, a sample file containing 
background and sample data from the instrument calibration and checkout is included with 
your instrument calibration files. This file is named MRMxxx.SMP (where xxx = 
instrument serial number) and is located in the \5205\Data directory. This file shows what 
a background looked like when the instrument was new and clean, and provides a valuable 
point of reference. You may wish to select this file for overlay on the current background 
report.

If a contaminated background is indicated, perform 1 to 3 rinse cycles to remove any 
remaining suspended particles; then remeasure the background. If background data do not 
return to the minimum level, (1) check the analysis liquid for contaminants, or (2) try 
preparing a fresh batch of analysis liquid. Excess dissolved oxygen or bacterial growth 
may cause problems in liquid that has been allowed to stand for more than a few days. If 
the problem persists, drain the system and remove and clean the cell following the 
instructions provided in Chapter 9. Reinstall the cell and repeat the background 
measurement.

If frequent cell cleaning is necessary it may be that the system is not being thoroughly 
rinsed, or that samples are being improperly dispersed. Excessive sample adherence to the 
cell is an indication of inadequate dispersion.
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I.  MASTERTECH INSTALLATION

This appendix describes how to install the MasterTech 052 autosampler. The MasterTech 052 
Autosampler allows you to queue up to 18 samples and transfer them to the Saturn DigiSizer 
analyzer automatically for analysis. After installation, its operation should be verified to make 
sure that it is operating properly before actual analyses are attempted.

Removing Packing Material from the Unit

Carefully remove the MasterTech and its components from the shipping carton. Remove all 
packing material and verify that all items listed on the packing list are included. 

Equipment Damage or Loss During Shipment

If equipment is damaged or lost in transit, make note of the damage or loss on the freight bill. 
The freight carrier, not Micromeritics, is responsible for all damage or loss occurring during 
shipment. If you discover damage or loss of equipment during shipment, report the condition 
to the carrier immediately.

Equipment Return

Micromeritics strives to ensure that all items arrive safely and in working order. Occasionally, 
due to circumstances beyond our control, a customer may receive equipment which is not in 
working order. When equipment has been damaged (either during shipment or in use) and you 
wish to return the equipment to Micromeritics for repair or replacement, follow the steps 
below:

1. Pack the MasterTech in its original shipping carton if possible. If the original carton is 
unavailable, for a nominal fee Micromeritics can provide another carton for your use.

2. Tag or otherwise identify the defective equipment, noting the defect and, if possible, the 
circumstances under which the defect occurred.

3. Reference the sales order or purchase order number for the MasterTech, and provide the 
date the it was received.

4. Notify the Micromeritics Service Department of the defect and request shipping 
instructions. The Service Department will assign a Returned Materials Authorization 
(RMA) number. Write the RMA number on the outside of the carton.
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Installing the MasterTech

Place the MasterTech on a tabletop and proceed with the following instructions.

Selecting the Voltage

The MasterTech leaves the factory set for 120 VAC and with the line fuse removed. The cor-
rect setting of the universal power entrance must be checked and the appropriate fuse installed 
before the MasterTech can be operated. The MasterTech is designed to operate with either 100, 
120, 220, or 240 VAC at 50 or 60 Hz. Voltage selection and fusing are made at the power con-
nector which is located on the rear panel of the unit.

1. Make sure the power cord is disconnected from the MasterTech.

2. Using a pointed object, remove the fuse block and cover assembly from the power 
connector at the rear of the MasterTech.

3. Pull the voltage selector card straight out of the power connector housing.

The power cord should be disconnected from the MasterTech before removing the 
cover from the power input connector. Failure to disconnect the power cord could 
result in electrical shock.

Voltage Selector Card
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4. Orient the voltage selector card so that the desired voltage is indicated at the bottom. 
Orient the indicator pin so that it points upward as shown in the following illustration.

5. Insert the voltage selector card into the power connector housing with the edge containing 
the desired voltage first and with the printed side facing the power ON/OFF switch.

6. Fuse the input power line according to local safety practices. The input power connector 
can be used with either a single-fuse arrangement or a double-fuse arrangement, as shown 
in the following illustration.

a. Observe the position of the fuse block, using the previous figure for reference. If the 
single-fuse arrangement is desired, position the fuse block so that the side with the 
single-fuse slot and the jumper bar is away from the cover.  

If the double-fuse arrangement is desired, position the fuse block so that the side with 
the double-fuse slots is away from the cover.

Pin

Voltage

Fuse Block

Fuse

Retaining Screw

Cover

Jumper Bar

Fuse Block

Fuse Block

Fuse

Cover

Fuses

Double-Fuse Arrangement Single-Fuse Arrangement

The power cord should be disconnected from the MasterTech when installing or 
replacing fuses. Failure to do so could result in electrical shock.
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b. If the fuse block is positioned properly for the fusing desired, proceed to Step c.  

If the fuse block is not positioned properly for the fusing desired:

1) Remove the fuse block retaining screw.
2) Lift the fuse block from the cover.
3) Rotate the fuse block.
4) Mount the fuse block to the cover.
5) Replace the retaining screw.

c. Insert appropriate fuse(s) for the input power source. Refer to the chart below for the 
appropriate fuse rating.

7. Insert fuse block and cover assembly into input power connector (as shown in the 
following illustration) and snap it into place. Once the fuse block and cover assembly are 
in place, the position of the indicator pin shows the input power selected.

The fuses used in the MasterTech must be identical in type and rating to that specified. 
Use of other fuses could result in electrical shock and/or damage to the MasterTech.

Power Source Fuse

100-120 VAC 3AG, 2.00 Amp Slow-Blow

200-240 VAC 5x20 mm, 1.25 Amp Slow Blow (Type T)
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Turning on the MasterTech

1. Make sure the proper operating voltage and fuse are selected and in place.

2. Plug the power cord into an appropriate power outlet.

3. Place the POWER ON/OFF switch in the ON ( | ) position. The +5 and +24 LEDs on the 
rear panel and some of the LEDs in the front panel switches should illuminate.

4. Press the ARM AUTO/LOAD switch on the front panel of the MasterTech. The arm 
should rise to the LOAD position, which is used for removal and replacement of the tray.

The ultrasonic probe should not be turned on at this point. Observe the indicator on 
the ULTRASONIC PROBE AUTO/ON switch on the front panel of the MasterTech. If the 
ON indicator is illuminated, press the switch to turn off the probe; the AUTO indicator 
should illuminate.

Ultrasonic Probe 
Auto/On Switch

Arm Auto/Load 
Switch
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Installing the Ultrasonic Probe

1. Place the POWER switch on the rear panel of the MasterTech in the OFF (O) position.

2. Attach the probe cable to the connector labeled Ultrasonic Probe.

3. Ensure that the probe tip is attached to the probe; if not, attach it before proceeding. A 1/4-
in. probe tip is supplied with the MasterTech; a 1/8-in. tip is also available (refer to 
Ordering Information).

4. Insert the cylinder into the arm, positioning it so that the longer slots slide over the 
protrusions inside the arm.

5. Insert the probe into the cylinder.

Make sure that power is not being supplied to the unit before starting this procedure.

Probe Cable
Ultrasonic Probe

Probe Tip

Cylinder

Cylinder Slots (one on each side)

Arm

Position the shorter slots of the cylinder over the protrusions if you are using the 1/8-
in. probe.
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Installing the Beaker Tray

1. Place the POWER switch in the ON position.

2. Make sure the arm of the MasterTech is in the LOAD (uppermost) position; the LOAD 
LED will be illuminated. If the LED is not illuminated, press the ARM AUTO/LOAD 
switch.

3. Hold the tray firmly by the outside edge. Notice that the bottom of the tray has small slots 
positioned radially outward from the inside edge. Place the tray on the MasterTech so that 
the arm passes through the center opening of the tray.

4. Make sure the drive pin is lined up into a radial slot on the bottom of the tray. The position 
of the tray does not matter at this point.

Beaker Tray

Slot

Drive Pin
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Installing Sample Transfer Tubing

This section contains one set of instructions for installing the sample transfer tubing in a 
MasterTech with serial number 500 or below, and one set of instructitons for a MasterTech 
with serial number 501 or above. Follow the instructions for your unit.

MasterTech with Serial Number 500 or Below

The MasterTech accessories kit contains two pieces of flexible tubing. One piece of tubing is 
for installation inside the MasterTech arm. The other piece of tubing is installed inside the liq-
uid sample handler, allowing for connection to the MasterTech.

1. Ensure that the MasterTech POWER switch is in the ON position.

2. Make sure the arm is in the LOAD (uppermost) position; the LOAD LED is illuminated. If 
the LED is not illuminated, press the ARM AUTO/LOAD switch.

3. Press the end of one segment of flexible tubing over the sample transfer tube until there is 
at least 1/2-in. overlap.

4. Unlatch the pump housing and unscrew the plastic knob on the rear of the pump. 

5. Thread the tubing through the pump as shown above and attach it to the rigid tubing 
labeled L (left) or R (right). Choose the side that will be adjacent to the liquid sample 
handler; for example, choose the left (L) rigid tubing if the MasterTech is to be placed to 
the right of the liquid sampler handler.

6. Close and latch the housing. Tighten the plastic knob on the rear of the pump sufficiently 
to prevent tubing slippage but not enough to restrict flow through the tubing.

Sample Transfer tube

Flexible Tubing

Arm

Rigid Tubing

Pump

Pump Housing Latch

Plastic knob

Pump Housing
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MasterTech with Serial Number 501 or Above

1. Make sure that the arm is in the Load (uppermost) position. When the arm is in the Load 
position, the Load LED is illuminated. If the LED is not illuminated, press the ARM 
AUTO/LOAD switch.

2. Unscrew the two thrumbscrews from the cover of the pump housing, then remove the 
cover.

3. A 21-in. segment of flexible tubing is shipped with the MasterTech. Remove the cover 
from one of the steel tubes labeled L (Left) or R (Right). Choose the steel tube labeled 
with the side of the MasterTech from which you want the fluid to be discharged. Then 
attach one end of the flexible tubing to the steel tube.

Load position

A                                                        B

A                                                                B
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4.  Loop the tubing around the pump rollers in a clockwise direction, using one hand to hold 
the two ends of the tubing loop in the two grooves at the base of the pump.

5. Insert the key between the pump rollers near the left side of the pump base, with the key 
blade between the tubing and the plate on the top of the rollers. 

6. Turn the key clockwise so the tubing presses into the groove until the key is stopped by the 
peg in the right side of the pump body.
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7. Slide the key out, then place the cover over the pump, wiggling it slightly to align it with 
the pump body and press it into place. Then insert and tighten the two thumbscrews only 
tight enough to secure the cover.

8. Attach the other end of the flexible tubing to the Sample Transfer tube on the front of the 
MasterTech as shown below.

9. With the instrument schematic displayed, enable Manual Mode. Right-click the 
MasterTech Pump icon and select Turn On.

10. The pump should begin operating. If the pump does not start or is sluggish, pull on the 
long end of the tubing to create tension and pull excess tubing out of the pump, no more 

                                                                            A                                                                   B  
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than 1/4-in. should be required. (Loosen the thumbscrews if necessary.) When the pump is 
operating freely, hand-tighten the two thumbscrews, then turn the pump off.

11. Press the ARM AUTO/LOAD switch to place the arm in the AUTO position.
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Connecting to Liquid Sample Handler

The following steps are common to both liquid sample handlers. After performing these steps, 
advance to the section applicable to the liquid sample handler you have connected to your 
analyzer.

1. Select Unit [n] > Drain > DigiSizer to remove any liquid that may be in the liquid sample 
handler.

2. Turn off the liquid sampler and the analyzer.

3. Remove the retaining screws on the right side of the liquid sample handler, then loosen the 
captive thumb screw on the rear panel.

4. Lift off the cover and set aside.

Standard Liquid Sample Handler

1. Locate the analysis liquid inlet tubing on the inside of the liquid sample handler. 

2. The analysis tubing has a connector approximately two inches from the inlet fitting; 
remove this connector.

3. Using the T-connector supplied in the MasterTech accessories kit, reconnect the tubing 
using the two larger ends of the T-connector.

Remove this connector

Analysis Liquid tubing

T-connector
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4. Insert the remaining piece of flexible tubing through the hole provided on the base of the 
sample handler.

5. Guide the tubing through the hole in the front chassis (just below the rinse pump) and 
connect it to the remaining barbed fitting of the T-connector.

6. Install the other end of the flexible tubing onto the sample transfer tubing connector on the  
side chosen in Step 5 of Installing Sample Transfer Tubing. 

7. Replace the cover of the liquid sample handler. Replace the retaining screws on the right 
side of the unit and retighten the thumb screw on the rear panel.

MasterTech Flexible tubing

Barbed connector

Make sure the side to which you connect the flexible tubing coincides with the one 
chosen in the arm of the MasterTech.
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Low-Volume Liquid Sample Handler

1. Locate the T-fitting of the stainless steel tubing of the drain manifold.

2. Use the 7/16- and the 1/2-in. wrenches provided in the accessories kit for this step. Hold 
the T-fitting secure with the 7/16-in. wrench, then use the 1/2-in. wrench to loosen and 
remove the topmost nut.

3. Remove the stainless steel plug from the nut. Be sure to store the plug in a secure location. 
If the MasterTech is disconnected, this plug will need to be reinstalled in the liquid sample 
handler.

4. Insert the stainless steel connector into the nut (the barbed end should be on the outside).

5. Reattach the nut to the T-fitting; tighten finger-tight. Then, using the two wrenches as 
shown above, tighten the nut 1/4 turn.

6. Insert one end of the flexible tubing (provided in the accessories kit) through the hole 
provided on the base of the sample handler.

T-fitting
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7. Guide the tubing through the hole in the front chassis and connect it to the barbed fitting of 
the T-connector. 

8. Install the other end of the flexible tubing onto the sample transfer tubing connector on the  
side chosen in Step 5 of Installing Sample Transfer Tubing. 

9. Replace the cover of the liquid sample handler. Replace the retaining screws on the right 
side of the unit and retighten the thumb screw on the rear panel.

Tubing connected to fitting

Make sure the side to which you connect the flexible tubing coincides with the one 
chosen in the arm of the MasterTech.
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Connecting Cables

1. Place the MasterTech to the appropriate side (the side designated when installing the 
sample transfer tubing) of the liquid sample handler.

2. Make sure the power switches on the ultrasonic probe (if installed), analyzer, liquid 
sample handler, and MasterTech are in the OFF positions.

3. Insert one end of the serial cable into the connector labeled RS-232 Spare on the rear 
panel of the Liquid sample handler.

4. Insert the other end of the cable into the connector labeled RS232 on the back of the 
MasterTech. 

Verifying Operation

To verify operation, manually move each subsystem using the manual control option of the 
Saturn DigiSizer analysis program.

1. Turn on the Saturn DigiSizer system components in the following order:

a. Ultrasonic probe (if installed)

b. MasterTech autosampler; allow MasterTech to initialize before turning on the liquid 
sample handler

c. Liquid sample handler

d. Saturn DigiSizer

2. Start the Saturn DigiSizer software; initialization may take a few minutes.

3. Fill a beaker with approximately 80 mL of water.

4. Place the beaker in the number 1 position of the tray.

5. To test the ultrasonic probe, remove it from the holder and insert the tip of the probe well 
into the water.

NEVER operate the ultrasonic probe without having the tip immersed into a liquid. 
Doing so may harm the probe and/or the driving electronics. 

DO NOT let the tip of the probe come in contact with a glass beaker. Doing so may 
shatter the beaker.
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6. While holding the probe tip underwater, press the ultrasonic probe AUTO/ON switch. You 
will hear a high-pitched sound, indicating that the probe is working properly.

7. Press the ultrasonic probe AUTO/ON switch again to turn off the probe.

8. Place the probe back into the holder.

9. Select Unit [n] > Enable Manual Control. If the instrument schematic is not displayed, 
select Show Instrument Schematic.

10. Ensure that the Arm AUTO/LOAD switch on the front panel of the MasterTech is in the 
AUTO position.

11. Select Unit [n] > Initialize MasterTech.

A message is displayed indicating that initialization is in progress. The tray on the Master-
Tech rotates in a counterclockwise direction for one beaker position; the arm lowers to the 
Rinse position and returns.

The tray then continues to rotate until position 1 is reached. The beaker inserted in the tray 
in Step 4 should now be directly under the arm of the MasterTech. Make sure the beaker 
contains approximately 80 mL of water.

12. On the instrument schematic, select the symbol representing the MasterTech arm.

DO NOT press the ultrasonic probe AUTO/ON switch unless the probe and its cable 
are properly connected to the MasterTech. Doing so may harm the driving electronics.

MasterTech 
portion of the 
instrument 
schematic

When manual mode is enabled, components on the instrument schematic have 
shortcut menus displaying the options available for that component. Select the 
component, then click the right mouse button to access its menu. 
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In each instruction for this step, first access the pop-up menu:

a. Select Move Arm Down two times.

b. Select Ultrasonic On; you will hear a high-pitched sound, indicating that the probe is 
operational. 

c. Select Ultrasonic Off to turn off the probe.

d. Select Stirrer On; the stirrer begins to operate.

e. Select Stirrer Speed Fast.

f. Select Move Arm Up.

g. Select Stirrer Off.

h. Select Move Arm Up.

i. Select Move To Beaker and enter the beaker position; note that the display is updated 
to reflect the position of the beaker tray. The picture on the screen will reflect whether 
or not a beaker is present.

13. Place the MasterTech pump switch on the front panel in the AUTO position, then select 
the MasterTech pump on the schematic. In each instruction in this step, first access the 
shortcut menu:

a. Select On; the MasterTech pump should begin operating (you will hear a whirring 
sound and the pump will begin to operate).

b. Check the direction of the flow of the MasterTech pump:

Select Flow Direction Load; allows suspension to flow from the MasterTech to the 
Saturn DigiSizer system for analysis.

Select Flow Direction Rinse; allows suspension to move from the Saturn DigiSizer 
system to the MasterTech. This direction is used to rinse the sample from the stirrer and 
transfer tube on the MasterTech.

c. Select Off to turn the pump off.

MasterTech Arm

MasterTech Pump Beaker Position
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14. Rinse and prime the tubing of the MasterTech:

a. Place an empty beaker in position 2 of the MasterTech tray.

b. Select Unit [n] > Rinse > MasterTech then DigiSizer.

c. Specify 2 as the beaker position, then click OK.

This concludes verification of operation of the MasterTech. If everything performed as 
described above, the system should be fully operational. If you encounter any problems, refer 
to the troubleshooting section of the operator’s manual.
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J.   LIQUID SAMPLE HANDLER INSTALLATION

This appendix describes how to install liquid sample handlers in the event you wish to use 
both types available, the standard one or the low-volume one. These instructions are written 
with the assumption that a liquid sample handler is currently attached to the DigiSizer.

Disconnecting the Current Liquid Sample Handler

The following steps are common to both liquid sample handlers.

1. Select Unit [n] > Drain > DigiSizer to remove any liquid that may be in the liquid sample 
handler.

2. Turn off the liquid sample handler and the analyzer.

3. Open the front panel of the analyzer.

4. Loosen all three screws on the cover of the sample cell compartment; remove the cover 
and set aside.

5. Disconnect the sample transfer tubing from the upper and lower connectors of the sample 
cell holder.

Sample cell compartment

Upper connector

Sample cell holder

Lower connector
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6. Grasp the liquid sample handler and slowly pull it away from the DigiSizer; store in an 
appropriate location.

Installing the Liquid Sample Handler

The Liquid Sample Handler is available in two configurations: 

• Standard unit: includes a reservoir that holds 500 to 600 mL of dispersed sample. This 
model is best suited for samples containing coarse particles, or for those of high density. 

• Low-Volume unit: includes a reservoir that holds 100 to 120 mL of dispersed sample. 
This model is best suited for analyses where the sample quantity or dispersion liquid is 
limited, or where the dispersion liquid may be hazardous or difficult to dispose.

The liquid sample handler transfers the sample to the analyzer for analysis. Precut tubing is 
provided for this purpose; if you are installing the:

• Standard unit, the tubing is 1.27-cm (1/2-in.) diameter (2 pieces)
• Low-volume unit, the tubing is 0.79-cm (5/16-in.) diameter (1 piece)

Both configurations are installed similarly; differences are noted.

1. Place the liquid sample handler in position next to the analyzer.

2. Remove the two plugs from the ports on the side of the sample handler.

• If you are installing the Low-volume unit, the tubing on the upper port is installed; 
remove the plug from the end of the tubing.

3. Install the tubing onto the connectors provided on the left side of the liquid sample 
handler. One piece of tubing is approximately 2 inches longer than the other; install this 
piece on the upper connector and the shorter one on the lower connector.

Longer piece on upper port.

This piece of tubing is 
already installed if you have 
the Low-volume unit.

Shorter piece on lower port.
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• If you are installing the Low-volume unit, the tubing on the upper port is installed; 
install the tubing supplied with the unit on the lower port.

4. Slide the liquid sample handler toward the analyzer, guiding the tubing through the ports 
on the right side of the analyzer.

Do not allow the analyzer and liquid sample handler to touch; metal-to-metal contact may 
cause vibrations and, thus, inaccurate data.

5. Open the front panel of the analyzer (if not still open).

6. Attach the sample transfer tubing to the sample cell holder as shown below.

7. Attach the RS232 communications cable as follows:

a. Connect one end of the cable to the port labeled RS232 From Saturn Analyzer on the 
rear panel of the liquid sample handling unit.

b. Connect the other end of the cable to the port labeled Sample Handling Unit RS232 
on the rear panel of the analyzer.

Upper Tubing port

Saturn DigiSizer Liquid Sample Handler

Lower Tubing port

Upper connector

Sample cell holder

Lower connector
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8. Plug the liquid sample handler’s power cord into an appropriate power source. The liquid 
sample handler is equipped with universal power input; therefore, voltage selection is 
unnecessary.
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INDEX

A
Accelerator keys

See  Shortcut keys
Add archive location command, 7-3
Add Log Entry push button, 4-9
Adjust liquid level, 5-8
Administrator, 2-1
Adsorptive properties file

listing statistics, 3-34
printing contents, 3-31

All file status, 2-16
Analyses

cancelling, 5-9
Analyses, performing

MasterTech Automatic method, 3-27, 5-15
MasterTech Schedule method, 3-29, 5-18
QuickStart method, 3-25, 5-10
Sample Analysis method, 3-22, 5-4

Analysis Conditions dialog, 4-11
Analysis conditions file, 4-11

creating, 3-4
listing file statistics, 4-50
listing statistics, 3-34
printing contents, 3-31, 4-47

Analysis liquid
adding to list, 4-18
adding to list (Background dialog), 5-22
changing, 3-20
density and viscosity values, D-1
different from rinse liquid, 5-45

Analysis program
exiting, 4-54
logging in, 2-11, 4-53
logging out, 4-53
using, 2-11

Analysis push button, 6-7
Analyst, 2-1

creating a sample information file, 3-11
opening sample information file, 4-39
sample information file, 4-4

Analyzer
cleaning, 8-4
description, 1-5
front panel, 2-1
preparing for idle periods, 2-10
rear panel, 2-2
specifications, 1-9
turning on and off, 2-9

Analyzing file status, 2-16
Angle classes, F-3
Application

See  Analysis program
Arm

MasterTech, 5-38
rotation, 5-37
switch, MasterTech, 2-7

ASCII format, G-1
Autodilute, 5-5
Autorinse, 4-14, 5-26
Autoscale, 4-31
Autoscale options, 6-10
Axis

coordinates, viewing, 6-28
properties, editing, 6-26
range, 6-10

Axis Properties dialog, 6-26

B
Background

current, date and time, 6-5
determining acceptable, H-1
generating report, 3-41, 6-5
measuring, 3-18, 5-22

Background command
Reports menu, 6-5
Unit menu, 5-22

Background liquid
See Analysis liquid

Background Measurement dialog, 5-22
Background Options dialog, 4-31
Background report

example of, 6-36
Background Report dialog, 6-5
Beaker tray, MasterTech

aligning, 5-31
installing, I-7

Beam angle, 4-13
Beam obscuration

guidelines, 5-7, B-3
high, 5-8, 5-13
low, 5-8, 5-13

Board ID dialog, 5-44
Bookmarks tab, 2-20
Browse push button, 2-14, 4-23
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C
Calculations, F-1
Calibration dates, 5-44
Cancel dialog, MasterTech, 5-17
Cancel push button, 2-14, 5-9
Cancelling analysis, 5-9
Cascade windows, 2-19
Cautions

detector lens, 8-5
Cautions, defined, 1-3
CCD, 1-5, 5-38
Cell

See Sample cell
Center line, 6-15
Check boxes, 2-14
Circulate before data collection, 4-12
Close All command, 4-46
Close command, 4-45
Close Reports command, 6-4
Coefficient of variation, 6-16
Collected data, F-19
Collimator lens

cleaning, 8-7
Combined report

editing, 4-26
example of, 6-29

Company logo, displaying, 6-9, 6-13, 6-17
Complete file status, 2-16
Concentration

See Sample
Confidence interval, 6-16
Connectors, front and rear panels, 2-1
Continue push button, 5-28
Continuous scan, 5-36
Control Chart command, 6-13
Control Chart Graph

dialog, 6-14
Control Chart options dialog, 6-13
Control Chart report

generating, 3-45, 6-13
selecting statistics, 6-16

Control Chart Sample Selection dialog, 6-15
Control Chart Summary Statistics dialog, 6-16
Controls, front and rear panel, 2-1
Cross hair, axis, 6-28
Cross-references, 2-23
Cumulative Fraction Table report

editing, 4-27
Curve Properties dialog, 6-25
Curve thickness, changing, 6-22

D
Data

collected, F-19
deconvoluted, F-19
entered, 4-36
exported format, G-1
external, 4-41
merged, 4-41, F-10
plotting type, 4-29
points, labeling, 6-10
reduction, F-1
smoothing, 4-19
truncating, 4-19

Data presentation command, 7-6
Date format, changing, 2-16
Date Range push button, 2-16
Dates push button, 4-39
Deconvolution, F-3, F-4

data, F-19
Default Style dialog, 6-22
Defaults

report fonts, 6-22
Degas conditions file

listing statistics, 3-34
printing contents, 3-31

Density and viscosity values, D-1
Detector, 1-9
Detector Display dialog, 5-36
Detector Expose dialog, 5-36
Detector lens, 1-9

cleaning, 8-5
Developer, 2-1

creating a sample information file, 3-13
creating file templates, 3-1
importing files, 4-51
opening sample information file, 4-40
sample information file, 4-8

Dialog boxes, about, 2-13
Difference from Reference report

choosing file for, 4-22
selecting, 4-29

DigiSizer Rinse dialog, 5-26
Directories, 2-15, 6-3

adding, 7-3
Dispersant

sources, E-1
Dispersion

methods, B-1
types, C-1

Drain command, 5-31
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E
Enable Manual Control command, 5-32
Entered data, 4-36
Entered file status, 2-16
Error messages, A-1

2200 series, A-1
2300 series, A-2
2400 series, A-5
2500 series, A-12
4200 series, A-16
numbered, A-5
unnumbered, A-35

Exit command, 4-54
Exiting the analysis program, 4-54
Export command, 4-52
Exporting sample files, 3-38
Exporting sample information files, 4-52
External data, 4-41
External Data dialog, 4-41

F
File

selecting, 2-15
status, 2-16, 4-38, 4-47

File menu, 4-1
Close All command, 4-46
Close command, 4-45
description, 4-1
Exit command, 4-54
Export command, 4-52
Import command, 4-51
List command, 4-50
Log in command, 4-53
Log out command, 4-53
Print command, 4-47
Save All command, 4-45
Save as command, 4-43
Save As Template command, 4-45
Save command, 4-43

Filter
air, replacing, 8-10
laser, 5-35

Find command, 2-24
Flow rate, 4-12

background measurement, 5-23
Fraunhofer theory, F-1
Front panel

DigiSizer, 2-1
Liquid sample handler, 2-4
MasterTech, 2-6

Function keys
 See Shortcut keys

Fuse
replacing, 8-11
replacing, MasterTech, I-4

Fuse type
MasterTech, I-4

G
Goodness of Fit report, 4-32

example of, 6-37
Graph

copying as metafile, 6-27
editing in sample file, 4-29
editing onscreen, 6-25
legend, editing, 6-26
push button, 6-14

Graph Overlay Samples dialog, 4-23
Graphic, showing in report title, 4-22, 6-9, 6-13, 6-17

H
Help menu, 2-19
Histogram, 4-29, 6-22, 6-26

I
Import command, 4-51
Importing files, 4-51
Index, online, 2-23
Indicators, front and rear panels, 2-1
Inorganic material, 1-5
Installation

MasterTech 052, I-1
Instrument log, 5-42

viewing from operational window, 5-4, 5-10
Instrument schematic

description of components, 5-32
manual control, 5-32
showing, 5-40
viewing from operational window, 5-4, 5-10

Intensity control switch, MasterTech, 2-6
Interpolation, F-10

L
Label data, 6-10
Labels, sample file

editing, 7-4
Laser, 1-9, 5-35

filter, 5-35
polarization, F-1

Legend Properties dialog, 6-26
Lens, 1-9
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Lens, collimator
See Collimator lens

Lens, detector
See Detector lens

Light scattering, 1-5
Limit lines, 6-15
Linear supply breaker, 2-3
Links, 2-22
Liquid

See Analysis liquid
Liquid level, 5-11

adjusting, 5-8, 5-13
Liquid sample handler

front panel, 2-4
installing, J-2
rear panel, 2-5
types of, 1-6

List command, 4-50
List, generating, 3-34, 4-50
Load from MasterTech command, 5-25
Log in command, 4-53
Log out command, 4-53
Log Probability report, 4-33
Log Report Settings dialog, 5-42
Logging into application, 2-11
Logging into the analysis program, 4-53
Logging out of the analysis program, 4-53
LSHU

See Liquid sample handler
LSHU configuration options dialog, 5-45

M
Manual control, 5-32

accessing pop-up menus, 5-32
MasterTech

connecting cables, I-17
connecting to DigiSizer, I-17
description, 1-7
front panel, 2-6
fuse type, I-4
initializing, 5-31
installing beaker tray, I-7
installing sample transfer tubing, I-8
installing ultrasonic probe, I-6
rear panel, 2-8
turning on, I-5
verifying operation, I-17
voltage, selecting, I-2

MasterTech Automatic command, 5-15
MasterTech Automatic Mode dialog, 5-15
MasterTech Load dialog, 5-25
MasterTech Operation Cancel dialog, 5-17
MasterTech Rinse dialog, 5-28

MasterTech Schedule command, 5-18
MasterTech Schedule dialog, 5-18
MasterTech Schedule Insert dialog, 5-18, 5-19
MasterTech Then DigiSizer Rinse dialog, 5-29
MasterTech Treatment dialog, 4-14
Material

See Sample material
Material Properties dialog, 4-16
Material properties file, 4-16

creating, 3-7
listing file statistics, 4-50
printing contents, 4-47

Menu bar, 2-18
Menu structure, 2-18
Merged data, 4-41, F-10
Metafile, copying graphs as, 6-27
Mie theory, F-1
Models

generating, 4-18
Monitor resolution, 1-11

N
Next push button, 2-14
No analysis file status, 2-16
Notes, defined, 1-3
Number of tests, 5-5

O
Online manual

cross references, 2-23
index, 2-23
printing options, 2-25
using, 2-20
See also Operator’s manual

Open Report command, 6-4
Operator’s manual

conventions, 1-3
online, 2-20

Options menu, 7-1
Add archive location command, 7-3
Data presentation command, 7-6
Service Test Mode, 7-7

Options push button, 4-18
Order x-axis by, 6-14
Organic material, 1-5
Out of Specification report

selecting, 4-29
specifying files for boundaries, 4-23

Overlay Settings dialog, 4-30
Overlays

for all tests in same file, 4-30
for multiple samples, 4-30
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generating, 3-48
specifying, 4-23
two graphs in same file, 4-30

P
Parameter file, 4-4, 4-42

Analysis conditions, 4-11
creating, 3-4, 4-3
creating templates, 3-2
importing, 4-51
listing file statistics, 3-34, 4-50
Material properties, 4-16
printing contents, 3-31, 4-47
Report options, 4-21

Particle
diameter, B-3

Particle Size Table report
editing, 4-27

Password, 2-11
changing, 4-53
entering incorrect, 2-11
logging in, 4-53

Peak
valley depth, 4-24

Peak Detection Settings dialog, 4-24
Peaks, Summary report, 4-35
Polarization, F-1
Power

turning on and off, 2-9
Power indicator will not illuminate, 8-11
Prev push button, 2-14
Print command, 4-47
Printing

file contents, 3-31, 4-47
Prompts, sample information, 7-4
PSD History Options dialog, 6-17
PSD History report

generating, 3-47, 6-17
Pump

analysis liquid, 5-34
circulating, 5-33
MasterTech, 5-38
rinse, 5-33
turning on and off, 5-33

Pump Speed Setting dialog, 5-33
Pump switch, MasterTech, 2-7
Push button, 2-13

Analysis, 6-7
Browse, 2-14
Cancel, 2-14
Continue, 5-28
Date Range, 2-16
Graph, 6-14

Next, 2-14
Prev, 2-14
Replace, 2-15
Resume, 2-15
Save as default, 6-12
Suspend, 2-15

Q
QuickStart

Autodetect each new sample, 5-14
prompt for files, 5-12

QuickStart command, 5-10
QuickStart dialog, 5-10

R
Radio buttons, 2-13
Rear panel

DigiSizer, 2-2
Liquid sample handler, 2-5
MasterTech, 2-8

Recalculate archived SPC results, 6-15
Reference Angle dialog, 5-37
Refractive index, 4-19
Regression report

generating, 3-44, 6-9
Regression Report command, 6-9
Regression Report Options dialog, 6-9
Regression Report Sample Selection dialog, 6-11
Regularization, F-4
Replace push button, 2-15
Report

opening, 6-4
selecting, 2-17

Report options dialog, 4-21
Report options file, 4-21

defining, 3-9
listing file statistics, 4-50
listing statistics, 3-34
printing contents, 3-31, 4-47

Reports
calculations, F-1
closing, 6-4
Combined, editing, 4-26
displaying company logo in title, 4-22
examples of, 6-28
generating, 3-39, 6-2
graphs, editing in sample file, 4-29
graphs, editing onscreen, 6-25
header, 6-19
legend, editing, 6-26
Log probability, 4-33
onscreen, short-cut menus for, 6-23
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saving in other formats, 6-22
selecting fonts, 6-22
SPC, 6-6
Summary, editing, 4-33
tabular, editing in sample file, 4-27
Tabular, editing onscreen, 6-23
title, 4-22
Tool bar, 6-20
zoom feature, 6-27

Reports menu, 6-1
Background command, 6-5
Close Reports command, 6-4
Control Chart command, 6-13
Open report command, 6-4
PSD history command, 6-17
Regression Report command, 6-9
SPC Report Options command, 6-6
Start Report command, 6-2

Reservoir, 5-34
cleaning, 8-8

Results, showing, 5-41
Resume push button, 2-15
Revert, 4-5
Rinse after analysis, 4-13
Rinse command, 5-26
Rinse operation, performing

DigiSizer, 3-15
DigiSizer and MasterTech, 3-17
MasterTech, 3-16

Rosin Rammler report, 4-32
Rotation Move dialog, 5-37
RS232 connections, J-3

S
Sample

dispersion, B-1
resuspension, 5-16
transfer tubing, installing, I-8

Sample Analysis command, 5-4
Sample cell

cleaning, 8-4
removing, 5-31

Sample concentration, B-3
adjusting, 5-8, 5-13
calculations, F-19
large particles, B-4
medium-sized particles, B-4
monitoring automatically, 5-5
small particles, B-4

Sample dispersion, B-1
Sample handler

 See Liquid sample handler, 1-6
Sample information file, 2-15, 4-4

Analyst, 4-4
creating, 4-3
creating a template for, 3-1
creating, Analyst, 3-11
creating, Developer, 3-13
Developer, 4-8
exporting, 3-38, 4-52
importing, 4-51
listing file statistics, 3-34, 4-50
number of tests allowed, 5-5
opening, 4-38
printing contents, 3-31, 4-47
revert to previous version, 4-5
versions, 4-5

Sample Log report, 4-35
Sample material

adding to list, 4-17
large particles, B-4
medium-sized particles, B-4
small particles, B-4

Sample Options dialog, 6-7
Sample push button

SPC calculations, 6-7
Sample template, 4-41
Sample tube file

listing statistics, 3-34
printing contents, 3-31

Samples push button
Control Chart report, 6-15
PSD History report, 6-18
Regression report, 6-11, 6-18

Saturn DigiSizer system
See System

Save All command, 4-45
Save as command, 4-43
Save as Default push button, 6-12
Save As Template command, 4-45
Save command, 4-43
Scattering Model Advanced Options dialog, 4-18
Schematic

See Instrument schematic
Select Dates dialog, 2-16, 4-39
Selecting

files, 2-15
reports, 2-17

Sensor, liquid level, 5-34
Sequence number, 7-3
Service Test Mode command, 7-7
Shortcut keys

for Select Dates dialog, 2-16
instrument schematic in manual control, 5-33
list of, 2-12
using, 2-12

Shortcut menu, 2-11
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Show Instrument Log command, 5-42
Show Instrument Schematic command, 5-40
Show Results command, 5-41
Show Status command, 5-41
Sieve size, F-9

specifying defaults, 7-6
Sieve Table dialog, 7-6
Signal fraction, minimum, 4-19
Size classes, F-3
Smoothing, specifying, 4-19
Software

using, 2-11
SPC Analysis Options dialog, 6-7
SPC Calculations dialog, 6-6
SPC Percentile Options dialog, 6-8
SPC Report Options command, 6-6
SPC reports, 3-42

generating, 3-42
selecting options for, 6-6
See also Control chart reports
See also Regression report

SPC Size Options dialog, 6-8
Specifications, 1-9
Spreadsheet, saving data for, 6-22
Standard Class Size Table report, 4-27
Standard Sieve Table report, 4-27
Start Report command, 6-2
Start Report dialog box, 6-2
Status list, 6-3, 6-11
Status window, showing, 5-41
Summary Peaks dialog, 4-35
Summary Percentiles dialog, 4-34
Summary report

editing, 4-33
example of, 6-38

Summary Sizes dialog, 4-34
Summary Statistics button, 6-16
Suspend push button, 2-15
System

draining, 5-31
preparing for idle periods, 2-10
turning on and off, 2-9

T
Table of Contents, online, 2-22
Tabular report, 6-10

editing, 4-27
examples, 6-30

Template, 4-45
creating, 3-1
listing statistics, 4-50
printing contents, 3-31, 4-47

Text, copy graph data as, 6-27

Thumbnails tab, 2-25
Tile windows, 2-19
Title Properties dialog, 6-27
Tool bar, reports window, 6-20
Troubleshooting, 8-1
Truncate data, 4-19
Truncate table at distribution limits, 4-28
Tubing

MasterTech, I-8

U
Ultrasonic Intensity Setting dialog, 5-35
Ultrasonic probe

installing, MasterTech, I-6
Ultrasonic Probe switch, MasterTech, 2-6
Unit Configuration command, 5-44
Unit IP Setup dialog, 5-45
Unit Menu, 5-1
Unit menu

Background command, 5-22
Drain command, 5-31
Enable Manual Control command, 5-32
Load from MasterTech command, 5-25
MasterTech Automatic command, 5-15
MasterTech Schedule command, 5-18
QuickStart command, 5-10
Rinse command, 5-26
Sample Analysis command, 5-4
Show Instrument Log command, 5-42
Show Instrument Schematic command, 5-40
Show Results command, 5-41
Show Status command, 5-41
Unit Configuration command, 5-44

Update file list, 7-5
User parameters, 4-9

V
Valve, closing and opening, 5-33
Verifying operation, MasterTech, I-17
Versions of sample information file, 4-5
View, 5-4, 5-10
Viscosity and density values, D-1
Voltage

requirements, MasterTech, 1-12
requirements, sample handler, 1-10
selecting for MasterTech, I-2

W
Warnings, defined, 1-3
Waste valve, 5-34
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Windows
menu, 2-19

X
X-axis, 6-10

Y
Y-axis, 6-10

Z
Zoom feature, 6-27
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